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This manual is published by Caliper Life Sciences, Inc., a PerkinEImer company,
68 Elm Street, Hopkinton, MA 01748 USA. Copyright 2011 - 2012, Caliper Life
Sciences, Inc. All rights reserved. Reproduction by any means or in any form of
this manual or the products it describes is prohibited.

Caliper Life Sciences, Inc., LabChip, and the LabChip logo are registered
trademarks of Caliper Life Sciences, Inc. The Caliper logo is a trademark of Caliper
Life Sciences, Inc. Microsoft, Windows, and Windows NT are either registered
trademarks or trademarks of Microsoft Corporation in the United States and/or
other countries. All other trademarks and registered trademarks are the property of
their respective holders.

The information in this manual may contain typographical errors or technical
inaccuracies and is subject to change without notice. Modifications may also be
made to the product described in this manual at any time.

Proper Equipment Operation

WARNINGS

AN LN

. To reduce the risk of electric shock, do not remove the cover. No user
serviceable parts inside. Refer to qualified service personnel if help is
required.

»  Use this product only in the manner described in this manual. If the equipment
is used in a manner not specified by the manufacturer, the protection provided
by the equipment may be impaired.

AVERTISSEMENTS

VA

*  Pour réduire le risque de choc électrique, ne pas retirer le couvercle. Ce
produit ne contient aucune piece pouvant étre réparée par I'utilisateur. Au
besoin, confier I'appareil a un réparateur qualifié.

*  Ce produit ne doit étre utilisé que comme décrit dans ce manuel. Si cet
appareil est utilisé d’une maniére autre que celle spécifiée par le fabricant, la
protection fournie par I'appareil peut étre entravée.

Contact Us
If you have a question about a product that is not answered in this manual or online
Help, or if you need assistance with this product, contact the Caliper Technical
Support Center from 8:00 A.M. to 8:00 P.M., Eastern Time, Monday through Friday:
Phone: (508) 435-9761;
(877) LabChip for LabChip products only
Fax: (508) 435-0950
Email: technical.support@caliperLS.com
Internet: www.caliperLS.com
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For support in Europe contact Caliper Life Sciences LTD, Runcorn, UK +44-1928-
711448 or fax +44-1928-791228. For more information contact your local Caliper
representative.

Before you call, have the following information available:

*  Product serial number

+  Software version (found by choosing About from the main Help menu)

» If applicable, the error number shown in the software, or in the log file.

Product Service and Customer Support Plans

Caliper offers a full range of services to ensure your success. From our original
factory warranty through a comprehensive line of customer support plans, Caliper
offers you Field Service Engineers and in-house Specialists who are dedicated to
supporting your hardware, software, and application development needs.

Call: (508) 435-9761

(877) LabChip for LabChip products only
Fax: (508) 435-0950
Email: technical.support@caliperLS.com

Our programs can include such useful services as:
*  Preventive maintenance

» Diagnostic servicing performed on-site by Caliper field service engineers or
remotely via Technical Support

« Validation performed on-site by Caliper field service engineers
+ Extended use of the Caliper Technical Support Center

»  Software updates

. Parts, labor, and travel expense coverage

*  Other customized services upon request

Training For Your Product

Contact the Caliper Center for Training and Development for information about the
availability of training courses for your product:

Call: (508) 497-2634

Fax: (508) 435-3439

FCC
This device complies with part 15 of the FCC (United States Federal
Communications Commission) Rules. Operation is subject to the following two
conditions:
. This device may not cause harmful interference, and
« This device must accept any interference received, including interference that

may cause undesired operation.

CE
This device complies with all CE rules and requirements.
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NOTE
|

-

Changes or modifications to this equipment not expressly approved by the party
responsible for compliance could void the user’s authority to operate the

equipment.

REMARQUE

-

Tout changement ou modification apporté a cet instrument non expressément
approuvé par I’entité responsable de la conformité peut annuler 'autorisation
d’opérer 'appareil accordée a l'utilisateur.

Table of Symbols

Table 1 contains symbols that identify particularly important information and alert
you to the presence of hazards. These symbols may appear in this manual and/or
on the product it describes.

Table 1. Important Symbols

Symbol
Symbole

Description
Description

O

DANGER: An imminently hazardous situation, which, if not
avoided, will result in death or serious injury.

DANGER: Situation présentant un danger imminent qui, s'il n’est
pas éliminé, peut entrainer des blessures graves, voire la mort.

VAN

WARNING: Caution, risk of danger. Refer to the User’s
documentation.

AVERTISSEMENT: Attention, danger potentiel. Se reporter a la
documentation de l'utilisateur.

S—

NOTE: A cautionary statement; an operating tip or maintenance
suggestion; may result in instrument damage if not followed.
REMARQUE: Enoncé indiquant une précaution a prendre, un
conseil de fonctionnement ou une suggestion d’entretien; son
non-respect peut provoquer des dommages a I'instrument.

Hazardous voltage; risk of shock injury.
Tension dangereuse; risque de blessure par électrocution.

Crush hazard. Risk of body parts, hair, jewelry, or clothing getting
caught in a moving part.

Danger d’écrasement. Faire attention que les parties corporelles,
les cheveux, les bijoux ou les vétements ne soient pas pris dans
une piéce mobile.

Risk of puncture injury.
Risque de blessure par piqdre.

> BB

Risk of exposure to biohazards.
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Table 1. Important Symbols (Continued)

Description
Description

Risk of eye injury; wear safety glasses.
Risque de Iésion oculaire; porter des lunettes de sécurité.

Risk of fire.
Risque d’incendie.

Risk of poison.
Risque d’empoisonnement.

Risk of explosion.
Risque d’explosion.

Hazardous fumes.
Emanations dangereuses.

Laser light; avoid exposure. Risk of eye injury.

Rayonnement laser; éviter toute exposition. Risque de Iésion
oculaire.

Lifting hazard. May result in injury.
Levage dangereux. Peut entrainer des blessures.

Protective ground symbol.
Symbole de terre de protection.

Ground symbol.
Symbole de terre.

Fuse.
Fusible.

Alternating current.
Courant alternatif.

— e BB

On (supply).
Marche (alimentation).
H’) Off (supply).
\ Arrét (alimentation).
( E CE compliance mark.
Marque de conformité CE.
Signifies that the unit has passed safety tests for grounding,
power line transience, and current leakage.

Signifie que I'appareil a réussi les tests de sécurité pour la mise
a la terre, le courant transitoire de ligne d’alimentation et la perte
de courant.

Input.
Entrée.

b
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Table 1. Important Symbols (Continued)

Symbol Description
Symbole Description
Output.
G’ Sortie.
Equipment Yellow Caution, risk of danger
labels are color |Red Stop
coded: Blue Mandatory action
Les étiquettes |Green Safe condition or information
de I'appareil Jaune Attention, danger potentiel
sont codées Rouge Arréter
couleur: Bleu Intervention obligatoire
Vert Condition sdre ou informations de sécurité
& Helpful hints, additional information
Conseils utiles, informations supplémentaires
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Instrument Safety

The following safety information about the LabChip XT/XTe is
included in this documentation. Read and review all safety
information before operating the LabChip XT/XTe.

* Required Training

* “Chemical Safety” on page 8
» “Laser Safety” on page 9

» “Electrical Safety” on page 10

Required Training
Ensure that all personnel involved with the operation of the
instrument have:
* Received instruction in general safety practices for laboratories.
* Received instruction in specific safety practices for the

instrument.
« Read and understood all related MSDSs.
WARNING

VA

Use this product only in the manner described in this manual. If the
equipment is used in a manner not specified by the manufacturer,
the protection provided by the equipment may be impaired.
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Chemical Safety

WARNING

ADAAL A

Some chemicals used with the LabChip XT/XTe are potentially
hazardous and can cause illness.

* Read and understand the material safety data sheet (MSDS)
provided by the chemical manufacturer before you store,
handle, or work with any chemical or hazardous material.

* Minimize contact with and inhalation of chemicals and chemical
wastes. Wear appropriate personal protective equipment when
handling chemicals (e.g., safety glasses, gloves, or clothing).
For additional safety guidelines consult the MSDS.

* Do not leave chemical containers open. Use only with adequate
ventilation, including a fume hood, if necessary.

* Check regularly for chemical leaks or spills. If a leak or spill
occurs, follow the chemical manufacturer’s cleanup procedures
as recommended on the MSDS.

» Dispose of waste in accordance with good laboratory practices
and local, state/provincial, or national environmental and health
regulations.

» After emptying waste containers, seal them appropriately.

* Comply with all local, state/provincial, or national laws and
regulations related to chemical storage, handling, and disposal.

V2.1
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Laser Safety
WARNING

AL

The Red Barcode LED is a Laser Class 1M device - safe under
reasonably foreseeable conditions of operation with the naked
eye. Looking directly into the source of radiation by employing
optics within the beam such as a magnifying glass, telescope or
microscope can be potentially hazardous.

Caliper LabChip XT/XTe Instruments contain Class 3R
Excitation laser diodes. The LabChip XT/XTe is classified as a
Class 1M device because the lasers are appropriately enclosed
(embedded) and indicated with Warning labels.

Use of controls or adjustments or performance of procedures
other than those specified herein may result in hazardous
radiation exposure.

This instrument is not intended to be serviced at the customer
site.

NEVER remove instrument covers while the laser is powered.
The laser block assembly is marked with the label shown below:

CAUTION

CLAS53R LASER RADIATION WHEN
OPEN AND INTERLOCK 5 DEFEATED

AVOID DIRECT EYE EXPOSURE

LAGE. PN T3

CAUTION

Class 1M Laser Product
Viewing the LED barcode scanning output with
certain optical instruments such as eye loupes,
magnifiers and microscopes within a distance of

100mm may pose an eye hazard.

Barcode LED (Red): 625nm wavelength, 4.5 mW maximum
continuous (CW) in box

Excitation Laser (Green): 532nm (visible green) laser source, 5 mW
maximum continuous (CW)

Complies with FDA performance standards for laser products
except for deviations pursuant to Laser Notice No. 50, dated
6/24/2007 & IEC/EN60825-1:2007

V2.1
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Electrical Safety

The LabChip XT/XTe is powered by a UL/CSA/VDE/CE approved
100-240 VAC, 50/60 Hz input, 24 VDC output external power
supply. Users should observe the following:

WARNING

VA

Do not open the instrument enclosure. There are no user
serviceable parts inside.

The wall outlet or the power cable connector on the back of the
instrument should be accessible after the system's installation to
allow personnel to safely disconnect power from the system.

The computer supplied with the LabChip XT/XTe instrument has
internal lithium batteries. Batteries should not be incinerated.

WARNING

AAA

Danger of explosion if battery is incorrectly replaced. Replace only
with the same or equivalent type recommended by the
manufacturer's instructions.

Power Cord Selection

The LabChip XT/XTe is powered by the same power supply for 100,
120, and 230VAC operation. Use the correct power supply cord for
the region where the instrument will be installed as described
below.

United States and Canada

When using the LabChip XT/XTe instrument in the United States or
Canada, use the North American power supply cord shipped with
the instrument. The cord is intended to be plugged into a standard
NEMA 5-15R receptacle in the wall. If the power cord needs to be
replaced, contact Caliper for a replacement cord.

International

All power supply cords must be approved by an acceptable,
accredited agency responsible for evaluation in the country where
the power cords and system will be used. Power cords for
international use must have an IEC 60320-1, C7 female connector
to be compatible with the power supply. For additional information,
contact your local Caliper representative.

V2.1
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Fuses

The LabChip XT/XTe instrument does not contain any user
replaceable fuses. Contact Caliper Technical Support (see “Contact
Us” on page 2) if blown fuses are suspected.
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Introduction

The LabChip XTe fractionation system performs fast, automated
nucleic acid fractionation accurately and reproducibly. The resulting
sample is tightly sized and is delivered in a sequencing-compatible
buffer. The XTe improves laboratory efficiency and provides sizing
that is difficult to obtain using manual methods. Data is displayed
digitally and non-fractionated sample can be recollected and used
at another time.

The LabChip XTe software can be used to run standard Caliper
methods to perform extractions and to view the analyzed data after
the run.

The LabChip XT Instrument has all the functionalities of the XTe
with added features for sample tracking and data analysis. The
quantitation feature allows for each sample’s total input
concentration to be determined. Additionally, the estimated
concentration of the extraction region is automatically calculated
using Smear analysis. Sample Names can be imported and data
can be automatically exported for LIMs compatibility.

The LabChip XT software includes additional features for data
analysis, sample tracking, data filtering, and data export to reports
or LIMS. The following additional extraction modes are also
available in the LabChip XT software: Fluorescence, Peak Max,
Smear Max, Skip Extraction, and Separation Only. A 21 CFR Part
11 Security option is available for the LabChip XT software.
Features that are only available in the LabChip XT software are
identified in this manual.

Chip and Reagent Kits, which include the required reagents and
consumables, are available to run specific assays on the LabChip
XT/XTe. Contact Caliper to order Assay Kits.

This manual includes general instructions for using the LabChip XT
and XTe hardware and software. It includes general procedures for
operating the system, analyzing the data, using software security to
comply with 21 CFR Part 11 requirements, instrument maintenance,
and hardware and software troubleshooting.
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Assay User Guides

Assay User Guides provide information about the assay.
Instructions for preparing the chip and the sample are included in
the LabChip XT Assay User Guide for the specific assay that you
are running. Detailed information about the assay, including
Specifications, Safety Warnings, Preparation Procedures, Expected
Results, Troubleshooting, LabChip Kit Essential Practices, and
Reordering Information is also located in the LabChip XT Assay
User Guide for the assay.

Assay Quick Guides

Assay Quick Guides are included with each Assay Kit and include
instructions for preparing the chip to run an assay.

The current version of the Assay User Guides and Assay Quick
Guides can be accessed on the Caliper web site at:
http://www.caliperls.com/support/reference-library/data-
sheets/labchip_systems_data_sheets.htm.
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Principles of Operation

The LabChip XT/XTe assays are based on traditional gel
electrophoresis principles that have been transferred to a chip
format. The chip format dramatically reduces separation time and
provides automated sizing and quantitation information in a digital
format. The additional collection well on the chip allows a specified
range of nucleic acid sizes to be separated from the rest of the
sample.

Fractionation is the separation of a small range of DNA strand
lengths from a sample of DNA containing a broad mixture of DNA
strands. The LabChip XT/XTe uses a microfluidic chip to separate
the DNA strands by length in a gel contained in the chip. The
sample is directed into a waste well on the chip until the specified
size range is detected. The desired portion of the sample is then
diverted into a collection well on the chip. At the end of the
extraction, the run can be paused automatically and the extracted
sample can be removed from the collection well. Multiple
extractions can be performed during the same run to collect
multiple sizes from the same sample. Options are also available to
skip specific sizes or regions. The run can stop automatically when
all extractions are complete or the run can continue to the end of
the supported range and the remainder of the sample is diverted
into the waste well.

Figure 1. LabChip XT Chip

When the channels in the chip are filled with sieving gel and buffer,
the chip functions as an integrated electrical circuit. The circuit is
driven by the electrodes in the lid that contact the chip's electrodes
when the lid is closed.

The polymer filling the channels in the chip is designed to sieve
DNA fragments by size as they are driven through the chip
channels by electrophoresis, similar to using agarose or
polyacrylamide gels.
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Principles of Operation (Continued)

The sample is loaded into the sample well on the chip. A fluorescent
dye is added to, or already contained in the waste well at the
opposite end of the separation channel. The sample then moves
electrophoretically into the separation channel. The dye migrates in
the opposite direction toward the sample well. As the DNA
fragments move down the separation channel, they separate by
size and bind with the dye. The dye increases in fluorescence when
bound to the DNA in the separation channel. The complex then
moves past the laser, which excites the fluorescent dye bound to
the DNA. The software plots fluorescence intensity versus time and
produces electropherograms for each sample (see Figure 2).
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Figure 2. Electropherogram

The data can also be viewed in a gel-like format on the Gel Tab to
achieve the appearance of a slab gel. (The colors of the gel can be
changed.)
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Figure 3. Gel View
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Principles of Operation (Continued)

Quantitating the concentration and accurately sizing each fragment
are achieved by comparing against a sizing ladder. An internal
standard or “marker” is added to each sample to adjust for channel
to channel variations. The internal standard of known concentration
is mixed with the sample to aid in quantitation and sizing. The
marker lies slightly outside the assay range so it does not interfere
with analysis.

The LabChip XT/XTe can use either a virtual software ladder or a
ladder that runs in one channel of the chip at the same time as the
samples for real-time sizing of the separated nucleic acids.

The following ladder options are available in the LabChip XT/XTe
software:

* Avirtual Caliper software ladder

* A Caliper ladder included in the reagent kit

* A customer-supplied ladder (LabChip XT only)
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Operation

This section includes general instructions for using the LabChip XT
or XTe hardware and software to run an assay.

For assay-specific information, see the LabChip XT Assay User
Guide for the specific assay that you are running. The current
version of the Assay User Guides can be accessed on the Caliper
web site at:
http://www.caliperls.com/support/reference-library/data-
sheets/labchip_systems_data_sheets.htm.

To run a chip in the LabChip XT or XTe:

1

2
3
4

(3}

8
9

Open the LabChip XT or XTe software (see page 24).
Create a Run File (see page 24).
If necessary, clean the electrodes (see page 221).

Prepare the chip for the method as directed in the LabChip XT
Assay Quick Guide or Assay User Guide.

Run the chip (see page 33).
Monitor the run (see page 35).

If Extract and Pause is selected for any channels, remove the
extracted material from the collection well when the run pauses
and then continue the run (see page 35).

To manually pause a run, see page 37.

To stop a run before it ends, see page 38.

This section also includes the following procedures:

Creating a new method (See page 39)
Saving data files (See page 40)
Saving workspace files (See page 42) (LabChip XT only)
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Opening the LabChip XT or XTe Software

To open the LabChip XT or XTe software:

1

Double-click on the LabChip XT or XTe icon on the Windows
desktop.

If 21 CFR Part 11 Security is installed, the Login Window opens.

a Type avalid LabChip XT user name and password into the
text boxes and click the OK button. (For instructions on
creating LabChip XT user names, see “Adding New Users”
on page 80.)

The LabChip XT/XTe Main Window opens. Do not use any other
software applications while running the LabChip XT/XTe
software.

If the run file has not been created, see “Creating a Run File” on
page 24. If the run file exists, see “Running a Chip” on page 33.
To analyze data from a previous run, see “Data Analysis” on
page 43.

Creating a Run File

Before running a chip, you should create a Run File. The Run File
specifies the extraction or separation settings for the samples on
the chip. Specifying the settings in a run file enables you to import
the desired settings into the Start Fractionation Window after the
chip has been prepared to minimize the time between preparing the
chip and starting the run.

To create a run file:

1

On the LabChip XT/XTe Main Window, select Tools — Run File
Editor. The Run File Editor Window opens.

Select the Method to run from the Fractionation Method drop
down list.

Select the options on the Run File Editor window:

» Select the Extraction Parameters on the Setup Tab
* Check the Buffer Utilization

+ Enter the User Info

» Specify the Ladder Settings

» Select the Output File Locations

» Select the Auto Export Settings (LabChip XT only)
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Select the Extraction Parameters on the Setup Tab

The Setup tab displays the selected options for the run. The icon for
each channel indicates the Operation mode and the Extraction
mode.

To change the settings for a channel:

1
2

Click the Setup Tab in the Run File Editor Window.

For each channel, select the desired Operation for the channel
by clicking the down arrow next to the channel icon:

* Disabled

e Ladder

¢ eXtract and Stop

* eXtract and Continue

+ eXcLuDe Region (LabChip XT only)
+ Separation (LabChip XT only)

* eXtract and Pause

» Skip Extraction (LabChip XT only)
*  Flush Sample

For descriptions of each option, see “Setup Tab” on page 188.

For each channel where eXtract and Stop, eXtract and
Continue, eXcLuDe Region, eXtract and Pause, or Skip
Extraction is selected, go to step 4 to select the desired
extraction mode.

Select the desired Mode:

» Size - The extraction is specified by the size of the
fragments.

» Trigger - The extraction is specified by searching for the
specified trigger in the search region.

If the Mode is Size, select the desired Extraction Region. Either:
+ Click and drag the slider to the desired range.

* Type the desired values in the Extraction Region text
boxes.

» Type the size (in BP) of the fragments to be collected in the
Size text box and type the desired percent of size before
and after to collect in the Percent (%) text box. Collection
will start at the specified size minus the percent and will stop
at the specified size plus the percent.
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Select the Extraction Parameters on the Setup Tab (Continued)

6 If the desired extraction region is larger than the assay
Maximum Extraction Width, select the Auto MultiStep Cut
check box and enter the desired extraction region in the text
boxes. (Click the Review Setup button to see the actual steps
that will be executed.)

7 If the Mode is Trigger, select the desired extraction mode:

* Fluorescence - The extraction trigger point is the point
where the RFU exceeds the specified Threshold. (LabChip
XT only)

+ Peak Start - The extraction trigger point is the point where
the signal slope meets or exceeds the specified Threshold
value.

* Peak Max - The signal slope within the search region must
exceed the specified slope threshold (RFU/min) to arm this
trigger. The extraction is triggered when the signal has
switched to a negative slope which meets or exceeds the
specified threshold in magnitude. If the end of the search
region is reached after the trigger has been armed but
before the negative slope threshold has been achieved, the
extraction will trigger at the end of the search region.
(LabChip XT only)

+ Collect On Click - Collection is triggered by the user. The
target region displays in green on the graph. Click on the
word CLICK in the Run Setup section on the left side of the
LabChip XT/XTe Main Window to open the Fractionation
Pending window. The target region continues to update until
the extraction is triggered. Click the Start Now button when
the green region is over the region to be extracted. When
manual mode is selected in the width setting, click on the
word STOP in the Run Setup section to end the collection or
exclusion. Note that for some width settings, the target
region may extend beyond the last visible data point on the
graph. In this case, the highlighted region ends at the last
visible data point and the dialog box indicates the time when
the target region ends. When manual mode is selected in the
width setting, click on the word STOP in the Run Setup
section to end the collection or exclusion.
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Select the Extraction Parameters on the Setup Tab (Continued)

Smear Max - The signal must exceed the Threshold value
(RFU) within the search region to arm this trigger. The
extraction triggers at the point when the signal decreases
after averaging over three consecutive data points. If the
trigger is armed but the signal decrease has not been
detected by the end of the search region, the extraction
triggers at this endpoint. (LabChip XT only)

(See “Setup Tab” on page 188 for details on each option.)

If Fluorescence, Peak Start, Peak Max, Collect on Click, or
Smear Max is selected, select the desired Collection Width:

Percent (%) - Specifies the Collection Width as a percent of
the size at which the extraction is triggered. The extracted
range is centered at the trigger point, and the collection
width is from (size - %) to (size + %).

BP - Specifies the number of base pairs (BP) to collect,
starting at the specified trigger point. For Smear Max or
Peak Max, the collection is centered on the peak or smear
maximum.

If the extraction size is too large or exceeds the assay range
limit, the extraction size is automatically adjusted to a valid
range. For example, if the collection width is set to 400 BP
triggered by Smear Max starting at 100 BP, then the
extraction of 100 to 500 would be too large (beyond 20%
which is the assay limit of XT DNA 750 assay) Theextraction
range will be automatically adjusted and limited to 100 to
150. For Collect on Click, the Fractionation Pending dialog
will show that the collection is limited to 150 BP to meet the
assay limit constraint.

Manual - For Peak Start, Collect on Click, and
Fluorescence, the collection begins at the trigger point and
ends when the user clicks STOP in the Run Setup. For Peak
Max and Smear Max, collection begins at the specified
percent before the trigger point (size - %) and ends when the
user clicks STOP. If the user has not stopped the extraction
when the end of the search region has been reached, the
extraction ends there automatically.

If the start point of the collection width has already passed the
switch point when the trigger point is detected, collection begins
immediately and continues for the entire collection width.

Fluorescence, Peak Max, and Smear Max are not supported in
the LabChip XTe software.
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Select the Extraction Parameters on the Setup Tab (Continued)

9

10

11

12

Specify the desired name for each channel:

* Type the desired name for each channel in the Sample
Name text box.

* Click the Import Names button at the bottom of the window
and select the Sample Name File that contains the desired
names. (LabChip XT only.)

To add another step to a channel, click the New button. The
Step text box displays the step number of the new step. Repeat
steps 2 through 8 to select the settings for the current step.

* To add a new step between existing steps, go to the step
before the desired location for the new step and click the
New button. For example, to insert a step between steps 2
and 3, go to step 2 and click New. The new step is numbered
step 3 and the step that was step 3 is now numbered step 4.

If desired, use the Copy and Paste buttons to copy settings
between channels. The Copy function selects the source
channel, not the actual settings. If the settings of the copied
channel are edited before clicking Paste, the edited settings are
pasted.

When the settings on the Setup tab are correct, go to “Check the
Buffer Utilization” on page 29.
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Check the Buffer Utilization

Before the run, verify that the buffer will not run out during the run.
The buffer cannot be refreshed. The Buffer capacity is an
estimation. The run can be started even if the run is over the buffer
limit, but be aware that if the buffer capacity runs out, the current
will drop and the DNA will not continue to migrate into the collection
well. Exceeding the buffer capacity will cause undesired results.

1

Check the buffer icons on the Setup Tab and verify all the icons
are green, indicating the buffer is sufficient for the run. If the
icons are not green, click the Buffer Utilization Tab. to view the
estimated extraction time and buffer limit.

Using the estimated extraction time, select extraction
parameters on the Setup Tab that either complete the extraction
before the buffer time limit is exceeded or select the manual
collection width and end the collection before the buffer runs
out.

Enter the User Info

1
2

Click the User Info Tab in the Run File Editor Window.

Type the operator's name and a comment, if desired. If the 21
CFR Part 11 Security option is installed in the LabChip XT
software, the current logged in user name is automatically
displayed.

Specify the Ladder Settings

Custom Ladder settings are only supported in the LabChip XT
software. To change the ladder settings:

1
2

Click the Sizing Table Tab in the Run File Editor Window.

To use the default Caliper ladder, select the Method Ladder
option.

To use a custom ladder by specifying the sizes of the peaks in
the ladder, select the Custom Ladder option and type the
ladder peak sizes into the Size column of the ladder table.

To reset the ladder table back to the settings saved in the
method file, click the Copy Table from Method button.
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Select the Output File Locations

1 Click the Output Tab in the Run File Editor Window.

2 To change the Data Path, click the Browse (...) button and
select the desired location for the data files. Clicking the Default
button restores the default data path.

NOTE

-

Data files should be saved to a local folder on the computer's hard
drive. Saving data files to a network drive may cause loss of data if
the network connection is slow or interrupted.

3

If desired, select the Create Daily Sub-Directory check box to
create a new sub-directory for data files each day.

If the 21 CFR Part 11 option is installed and you want to save a
copy of the data files to a folder outside of the CDR or if the 21
CFR Part 11 option is not installed and you want to save a
second copy of the data files:

a Select the Copy To check box.

b Click the Browse (...) button. The Browse for Folder Window
opens.

¢ Navigate to the folder where you want to save the exported
copies of the data files.

d Click the OK button to choose the selected folder. The path
displays in the Copy To text box on the Output Tab.

In the File Prefix text box, type the desired prefix for all data
files. (The File Name Example text box displays the selected
format for the data files.)

To add the Computer Name, Project Name, Chip ID (LabChip
XT only), Date, and/or Time to the data file name, select or
clear the desired check boxes or type the desired project name.

To automatically export data tables, graphs, or gels in the
LabChip XT software, select the Automatic Export check box,
click the Settings button, and then select the desired Auto
Export settings (see page 31). Auto Export is not supported in
the LabChip XTe software.

See “Save the Run File” on page 32.
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Select the Auto Export Settings

The Auto Export settings in the LabChip XT software specify which
views to automatically export at the end of each run and specifies
the format for each view. Click the Settings button located after the
Automatic Export check box in the Output Tab on the Run File
Editor Window to open the Export Window. Auto Export is not
supported in the LabChip XTe software.

To select the desired views to export:

1

Select the check boxes next to the views to export. Selecting
Export All selects all check boxes.

For each selected view, to change the location for the files, click
the Browse (...) button and select the desired location.

If Raw Data is selected, click the AIA Format check box to
export in Chromatography Data Interchange Format or clear the
check box to export in .CSV format. If .CSV is selected:

+ Select Include Size Data to align the data to the channel’'s
ladder (for one file per channel) or to the first channel (for a
single data file) and include the size data in the exported
data.

+ Select Export Single Table to export the data for all
channels in the chip to one .CSV file. If not selected, the
data from each channel is exported to a separate .CSV file.

If Gel is selected:

a Select either Single File to include gels for all channels in
the run in the same image file, or select Separate Files to
export each gel to a separate image file.

b If desired, change the height, in pixels, of the exported gel
graphics in the Height text box.

If either Electropherogram or Gel is selected, choose the
desired format for the image files.

Click OK to save the Export settings. The specified files will be
exported at the end of the run.
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Save the Run File

After the desired settings are entered in the Run File Editor
Window, save the Run File so it can be imported into the Start
Fractionation Window.

To save the run file:

1

Click the Save button at the bottom of the Run File Editor
Window. The Export Fractionation Setup to XML File window
opens.

Navigate to the desired location to save the run file (*.xml). You
should save the run file in the default location if it will be used to
run chips.

Type the desired name for the run file in the File Name text box.
Click the Save button to save the run file.

Click the Close button on the Run File Editor window to close
the window or modify the settings to create another run file.

V2.1

LabChip XT/XTe User Manual Caliper Life Sciences, Inc.



Operation 33

Running a Chip

Before starting a run, make sure the desired run settings have been
selected in the Run File Editor Window and saved as a run file (see
page 24).

To start a run to read a chip:

1 Prepare and Load the Chip
2 Select the Run File

3 Start the Run

4 Monitor the Run

Prepare and Load the Chip

1 Prepare the chip as directed in the LabChip XT Assay Quick
Guide or Assay User Guide.

WARNING

AAA L\ A

Some chemicals or samples used with the LabChip XT/XTe are
potentially hazardous and can cause illness. Follow the precautions
in “Chemical Safety” on page 8 and the precautions in the Assay
User Guide.

2 Lift the latch on the front of the instrument to open the lid.

3 Place the prepared chip in the instrument with the notched
corner of the chip aligned with the notch in the chip locator.

4 Close the lid.

5 See “Select the Run File” on page 34.
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Select the Run File

Start the Run

After the chip is prepared, open the run file that contains the
settings for the run:

1

6

On the LabChip XT/XTe Main Window, move the cursor over the
image of the LabChip XT instrument to display the Run button.
Click the Run button or select Instrument — Start Run to open
the Start Fractionation Window.

Click the Import Setup button at the bottom of the window. The
Import Fractionation Setup from XML File window opens.

Click the name of the run file that contains the settings for the
run.

Click the Open button to display the saved settings in the Start
Fractionation Window.

Edit the settings if required. If desired, click the Export Setup
button to save the modified settings to a run file.

When the settings are correct, go to Start the Run.

Click the Start button in the Start Fractionation Window to start
the run. A new workspace opens to display the data.

See “Monitor the Run” on page 35 for information about viewing
data during the run.
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Monitor the Run

The following occurs after a run is started:

1

The Run button on the LabChip XT/XTe main window changes
to Pause/Stop.

The software performs a Connectivity Test to verify that correct
voltage and current is achieved in both separation and collection
modes.

If all four channels are enabled, performs a Current Leakage
Test to verify there is no current leaking between the channels.
All four channels are tested at full current, then each channel is
switched off one at a time and the currents are tested.

Data collection begins. Data is saved to a file with the name
shown above the chip diagram.

The Graph View displays the electropherograms of the channels
being read.

If any channels are set to Collect on Click, watch the data and
click on the word CLICK in the Run Setup section when the
green collection area shown on the graph is near the desired
point. The Fractionation Pending window opens. Click Start Now
when the green collection region is over the desired area.

[ y
s Fractionaton Pending on Channel 2 aaal

Colloction of Groen reglon will begin when Siart How is pressed!

& f wed 3

During the run, each extracted region is highlighted in the Graph
View and in the Gel View. The color of the highlight indicates the
type of region:

* Red - Normal extraction region
*  Yellow - Exclusion region

* Green - Target region for Collect on Click. Changes to red
during collection.

* Gray - Skip extraction region

* Red changes to Purple - Buffer capacity exceeded during
the extraction
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Monitor the Run (Continued)

8

10

11

12

13

14

15

The highlighted regions correspond to Smears created
automatically by the software. The smears are included in the
Smear Analysis Tab on the Method Window after the run is
complete.

If any channels are set to eXtract and Pause, the run
automatically pauses after the extraction is complete, the Run
Paused window displays, and any channels that have
completed the extraction display COLLECT in the Run Settings.

While the run is paused, remove the sample from the collection
well, replace the chip in the instrument, close the lid, and
resume the run by clicking the Resume button on the Run
Paused window. See the Assay Guide and Run File Guide for
important information about using Extract and Pause.

While the run is paused, you can also edit or stop the run.

To select a single channel as data is acquired or after the run is
finished, click a channel in the Chip View or List View (LabChip
XT only), a sample name in the Channel Table View, or a lane in
the Gel View.

To manually pause a run in progress, see “Pause a Run” on
page 37.

To stop the run before it is complete, see “Stop a Run” on
page 38.

When the assay is complete, Run Successful displays in the
Status line. For information on data analysis, see “Data
Analysis” on page 43.

If desired, remove the chip.

To save the Workspace in the LabChip XT software:

1

Select File — Save Workspace. The Save Workspace File As
Window opens with the data file name as the default name of
the workspace.

If desired, change the location and/or the name of the
workspace file and click the Save button. (Workspace files have
an .xtw file extension.) The workspace file should be saved in
the default location, which is the same directory that contains
the data file. The data file is automatically saved at the end of
the run. To view or re-analyze the data, see “Data Analysis” on
page 43.
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Pause a Run

The run in progress can be manually paused to remove material
from the collection wells or to edit certain extraction parameters.
While the run is paused, the voltage for each channel is set to zero,
the lasers are turned off, and the samples stop moving through the
channels. The run will automatically pause if the lid is opened
during the run, but using the software Pause feature ensures that all
of the extracted material has entered the collection well before the
run is paused.

To manually pause a run in progress:

1 Move the cursor over the instrument icon on the upper left side
of the LabChip XT/XTe Main Window. The Pause/Stop button
displays as shown in Figure 4.

Figure 4. Pause/Stop Button

2 Click the Pause/Stop button. The Modify Run Settings Window
opens, the voltage in each channel is set to zero, and the lasers
turn off.

3 While the run is paused, the settings on the Setup Tab and User
Info Tab can be edited. On the Setup Tab, the Operation mode
for a channel cannot be changed, only the Search Region,
Extraction Region, and Extraction Mode can be edited. It is the
operator’s responsibility to select valid settings while the run is
paused.

4 |[f the lid is opened while the run is paused, the chip can be
removed and the material can be collected from the appropriate
Collection wells. The channels in which the extraction is
complete display COLLECT in the Run Setup area on the
LabChip XT/XTe Main Window. When the lid is closed, any
channels that have finished all of the extractions display DONE.
Channels that have not completed display information about the
next step.

5 To stop a run while the run is paused, see “Stop a Run” on
page 38.
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Stop a Run

If you need to stop the run before it is complete, click the
Pause/Stop button. After a run is stopped, it cannot be restarted
and the channel cannot be reused.

The Modify Run Settings Window opens, the voltage in each
channel is set to zero, and the lasers turn off. Click the Stop Run
button.

A message box confirms that you want to stop the run in progress.

Stop Run A |

Do you want to stop the run cunently in progress?

/
e ) No

Click Yes to stop the run. The Run Status line displays Run
stopped by user.

Ruin Statis n

Chip Info

Chep 1D ND1G0001-00-0:2
Expiration Diate: Jun 6. 2011
Fwailsble Channels: 4

Tyoe:  XT DMA 750

Fun Stabes:  Fun stopped by user.

The data that has been collected up to the time the run was stopped
displays in the LabChip XT/XTe Main Window. Save the workspace
(see page 42) if desired in the LabChip XT software. In the LabChip
XTe software, the data file is saved automatically.
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Create a New Method

The LabChip XT software enables you to create a new method by
opening and editing an existing method and then saving the method
with a new name. Only the pre-defined Caliper method files are
available in the LabChip XTe software.

To create a new method:

1

On the LabChip XT/XTe Main Window, select Tools — Method
Editor. The Select Method To Edit window opens.

Select the name of the Method file that you want to edit and
click the OK button. The Method Window opens and displays
the settings for the open method.

Modify the settings as necessary for the new method. (See
Modifying Analysis Parameters or Reanalyzing a Data File for
information on setting or changing analysis parameters.)

Click the Save Method button at the bottom of the Method
window, specify the desired name for the new method file, and
click the Save button.

NOTE

-

All method files must be saved in the C:\Program Files\Caliper Life
Sciences\LabChip XT\Assay folder. Only the methods saved in this
folder are available in the Fractionation Method list in the Start
Fractionation Window and the Run File Editor Window.
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Saving Data Files

While running a method, the raw data received from the instrument
is automatically saved to the data file (.xtd for LabChip XT, or .xte
for LabChip XTe). If a run is stopped before it is complete, the data
that has already been collected for the run is saved in the data file.
The name of the data file is specified in the Output Tab on the Start
Fractionation Window.

The analysis settings for a chip are saved at the end of the data file.
If analysis settings are changed in the Method Window in the
LabChip XT software and the data file is saved, the new settings
are added to the end of the data file, but the previous settings are
not overwritten. This enables a chip to be restored to previous
analysis settings using the Restore Chip button in the Method
window in the LabChip XT software. Changing analysis settings is
not supported in the LabChip XTe software.

If the 21 CFR Part 11 option is installed with the LabChip XT
software, data files are saved in the Centralized Data Repository
(CDR). The CDR is a secure folder that can only be accessed by
the LabChip XT software. The location of the CDR is specified in
the CDR Utility Window.

Updated analysis settings are saved when the chip data file is
saved. To save the data file, either:

» select Workspace > Save Chip on the Menu Bar,

* right-click on the chip name in the Chip View and select Save
Chip, or

* select File > Save Workspace or File > Save Workspace As
on the Menu Bar. See Saving Workspace Files for more
information. (LabChip XT software only.)

If the 21 CFR Part 11 option is installed with the LabChip XT
software and Require Signature on File Update is selected in the
Set Policies tab on the User Administration Window, the user must
have signature rights to save an updated data file.

To save the data file when the 21 CFR Part 11 option is installed
and Require Signature on File Update is selected:

1 The Perform Signature Window opens when you save a data
file.

2 Select the name of the user who is signing the data file in the
Username drop-down list.

3 Type a Comment that meets the requirements of the
compliance policies.
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Saving Data Files (Continued)

4 If desired or required by compliance policies, select the
Approval State of the data file.

5 If desired or required by compliance policies, select the Lock
check box to lock the data file and prevent any changes until the
data file is unlocked. To lock a data file, the Approval State must
be either Accepted or Rejected.

6 Type the User Password for the signing user.

7 Click the Sign button. The Signature Performed window
confirms that the signature has been performed.

8 Click the OK button. The signature is recorded in the data file.

NOTE
|

-

Changing the analysis settings in the LabChip XT software and
saving the chip data file does not change the raw data from the run.
Only the display of the data is changed.

If you change the analysis settings in the LabChip XT software
without saving the new settings, and then try to close the
workspace, exit the software, or acquire new data, you are
prompted to save the changes. Selecting Yes opens the Save
Workspace File As Window.
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Saving Workspace Files

When viewing chip data in the LabChip XT/XTe main window, you
view the selected data files in a Workspace. When a new run starts,
a new blank workspace opens, which contains the data file for the
chip in the run. After the run is complete, saving the workspace in
the LabChip XT software saves the data file with the current
analysis settings. (See Saving Data Files for more information on
the contents of the data files.) The LabChip XTe software does not
support saving workspace files.

The Data Files are not saved in the Workspace file. In the LabChip
XT software, the saved workspace file contains links to the revision
of the data file that was last open in the collection. If a Workspace
file is moved to another folder or computer, the data files must be
moved with the Workspace file. The data files must be in the same
location relative to the Workspace file as they were, otherwise you
are prompted to find the missing data files when you open the
Workspace file. It is a good practice to save the workspace files in
the same location as the data files that are included in the
workspace.

Saving a Workspace file in the LabChip XT software automatically
saves any changes to the data files that are open in the workspace,
and saves the settings for each collection in the workspace.

If the 21 CFR Part 11 option is installed, saving Workspace files
does not require permission to save data files unless the data files
in the workspace have been modified.
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Data Analysis

After a run is complete, use the LabChip XT or XTe software to view
and analyze the chip data. The LabChip XT and XTe software can
open multiple data files in the same workspace to compare the data
from different chips. In the LabChip XT software, analysis settings
can be changed for single channels, entire chips, or all chips in the
workspace.

This section contains the following information:

* How the Software Analyzes DNA Data

* Organizing, Retrieving, and Backing Up Data Files

* Opening a New Workspace (LabChip XT only)

* Opening a Data File

* Adding a Collection to a Workspace (LabChip XT only)

+ Using Expected Fragments (LabChip XT only)

* Modifying Analysis Parameters (LabChip XT only)

* Reverting to a Specific Data File Revision (LabChip XT only)

» Changing the View of the Results

* Copying Information

* Reanalyzing a Data File (LabChip XT only)

* Printing Workspace Information

* Exporting Data (LabChip XT only)
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How the Software Analyzes DNA Data

The LabChip XT and XTe DNA Assay Analysis calculates the size
of nucleic acid fragments during the run to provide accurate
extraction of the desired fragment sizes. Three options are
available for calculating the fragment sizes:

» using the default Caliper Sizing Ladder while running up to four
samples in the chip,

» using the default Caliper ladder while running one ladder and up
to three samples in the chip, or

* using a custom ladder while running up to four samples in the
chip (LabChip XT only).

In its simplest form, the sizing is performed with only the sizing
ladder. A generic ladder is provided by Caliper as part of the
fractionation method designed for the chip and size range. The
ladder times of the sizing ladder are used to map migration time to
size. The collection start time and collection end times are
determined at the start of the run and do not change as the run
progresses. It is essential for each sample to include a lower
marker. The ladder and sample markers are aligned, resulting in an
adjustment of the sample migration times relative to the ladder. The
collection times are corrected using the aligned sample migration
times after the sample lower marker passes the detector.

To improve sizing accuracy, a ladder can run in one of the channels
and the channel can be designated as the real time ladder. The real
time ladder runs parallel to the samples. The ladder peaks that are
smaller than the extraction region pass the detector before the
collection time. The software uses the sizing lookups from the sizing
ladder to estimate the times for sizes larger than the collection
region. Often the sample DNA of the desired size reaches the
switch point before a real time ladder peak of greater size has
passed the detector. In this scenario, the DNA size is calculated
from previously observed real time ladder peaks of smaller sizes
and the sizing ladder points of greater size.

After the run is complete, additional data analysis can be performed
in the LabChip XT software to filter the data, change peak find
settings, or change the view of the data in the software. See the
procedures in this section for details.
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Organizing, Retrieving, and Backing Up Data

Files

As you work in the LabChip XT or XTe software, it's a good practice
to organize the files generated by the software.

Create a folder in which to save the data files or use the default
\Data folder. If desired, each person can save data files to their
own subfolder to organize the data files.

Save Workspace files in the LabChip XT software in the same
directory as the data files to prevent missing data files in the
workspaces.

Review the files periodically, even if only one person uses the
software. If you are not using the 21 CFR Part 11 option, archive
files you are no longer using but want to save to a backup disk,
and discard unneeded files. If you are using the 21 CFR Part 11
option, see “Software Security” on page 78 for backup options.
Verify there is enough free space on the hard drive to save new
chip data files.

Each user in the laboratory can specify a particular data file
name prefix to easily differentiate data files.

A new folder can be created each day to store the data from all
runs. To automatically create the folders, select the Create
Daily Sub-Directory check box on the Output Tab in the Start
Fractionation Window.

Opening a New Workspace

A workspace displays data from one or more chip data files from the
same type of assay. Each workspace can contain one or more
Collections to display the data. In the LabChip XTe software, open a
data file to automatically open a new workspace.

To open a new workspace:

1

On the menu bar, select File > New Workspace. If changes
have been made to an open workspace, you are prompted to
save any unsaved changes. A blank workspace opens in the
LabChip XT/XTe Main Window.

To view data, see:

Opening a Data File

Adding a Collection to a Workspace
Using Expected Fragments
Modifying Analysis Parameters
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Opening a Data File

Open a data file to view the data, to compare the data to other data
files in the same workspace, or to change analysis settings and
view the reanalyzed data. Data files generated by the LabChip XT
software have an .xtd file extension. Data files generated by the
LabChip XTe software have an .xte file extension.

To open a data file:

1

Open a new workspace (see page 45) or a workspace that
already contains compatible data files. (In the LabChip XTe
software, the workspace opens automatically when the data file
is imported.)

On the menu bar, select File > Import Data File. If the 21 CFR
Part 11 option is not installed, the Select a Data File Window
opens. If the 21 CFR Part 11 option is installed, the CDR
Manager Window opens.

Select the name of the data file to open and click the Open
button. The selected data file is imported into the open
workspace. Use Ctrl+click or Shift+click to select multiple files.

If desired, right-click on the Chip Name in the Chip View (see
Chip View or List View) and select Rename Chip to change the
name of the chip in the display. (If the Rename File to Match
check box is selected, the data file is also renamed to the same
name as the chip. The data file cannot be renamed if the 21
CFR Security option is installed.)

Select the desired channels to view in each collection in the
workspace. (The LabChip XTe software does not support
multiple collections in one workspace.)

See “Modifying Analysis Parameters” on page 53 for information
about changing analysis parameters in the LabChip XT
software.
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Adding a Collection to a Workspace

Collections are used to specify the channels selected for view in
each chip data file, the layout of the views in the Collection tab, and
the display properties for each view in each collection. Only the
LabChip XT software supports multiple collections in a workspace.

To add a new collection to an open workspace:

1

On the menu bar, select Collection > New Collection. The
New Collection Window opens.

Select the desired option for creating the new collection:

* Template - Opens a new collection with the same settings
as a saved collection template file.

* Blank Collection - Opens a new template using the default
collection settings.

* Current Collection - Opens a new template based on the
current settings in the currently open collection.

If no chips are open in the collection, choose the desired Assay
Type for the collection: DNA. Only data files from the selected
assay type can be imported into the workspace.

If desired, type a new name for the collection in the Name text
box.

Click the OK button to open the new collection.
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Using Expected Fragments

You can track expected DNA fragments (EFs) for the samples in a
DNA assay in the LabChip XT software. The LabChip XTe software
does not support defining Expected Fragments.

Entering EFs in the Method Window

Only supported in LabChip XT software.

1

10
1"

Select Analysis - Analysis Settings on the Menu Bar. The
Method Window opens.

Click on the Expected Fragments Tab.
Click in the bottom (empty) row in the table.

In the column labeled Size, enter the size of the expected
fragment in bp.

In the Window (%) column, if desired, change the tolerance
value to allow for variations in the expected fragment size. This
value is specified as a percent of the expected size for that
fragment. The default is 10% for DNA.

Note: If there are multiple peaks in the tolerance range, the
largest peak is labeled as the expected peak, even if it is not the
exact size specified. To change the peak identified as an
expected peak, see “Forcing Expected Peaks” on page 50.

A default color is automatically assigned. To change the color,
click on the color block in the Color column and select the
desired color in the Color window.

If desired, change the name shown in the Name column.

If desired, change the Property Displayed in the Channel
Table. This setting specifies the property that will be displayed
in the Expected Peak column for each expected peak listed in
the Channel Table View.

To apply the expected peak only to specific channels, double-
click in the Apply to Channels column. The Select Channels
window opens. Click to select the channels that you want to
apply the expected peaks to, and then click the OK button.

To apply the EFs to the active chip, click the Apply button.

To apply the EFs to all chips in the workspace, click the Apply
Global button.

V2.1

LabChip XT/XTe User Manual Caliper Life Sciences, Inc.



Data Analysis 49

Exporting EFs

Importing EFs

Only supported in LabChip XT software.

1

After the EFs are entered in the Expected Fragments Tab, click
the Export button at the bottom of the window. The Export
Expected Fragments Window opens.

Navigate to the desired location for the file, type the desired
name for the file in the File Name text box, and then click the
Save button. A .GEP file is created to save the expected peak
settings.

Only supported in LabChip XT software.

After an Expected Peak file (*.GEP) has been exported, you can
import the settings into another chip or workspace.

1

With the chip open in a workspace, in the Expected Fragments
Tab, click the Import button at the bottom of the window. The
Import Expected Fragments Table window opens.

Navigate to the location of the file, select the name of the file to
import, and then click the Open button. The expected peak
settings are imported into the tab.

To apply the EFs to the active chip, click the Apply button.

To apply the EFs to all chips in the workspace, click the Apply
Global button.
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Forcing Expected Peaks

Only supported in LabChip XT software.

If there are multiple peaks in the tolerance range, the largest peak
is labeled as the expected peak, even if it is not the exact size
specified. If a different nearby peak should have been selected as
the expected peak, you can specify which peak is labeled the
expected peak.

1 Inthe Graph View, right-click on the peak that should be labeled
as the expected peak.

2 On the shortcut menu, select Force Expected Fragment and
then select the desired fragment from the menu.

To clear a forced peak and revert to the default expected peak,
right-click on the forced expected peak and select Clear Forced
EP.

Viewing the EFs in the Graph View

Expected Fragments are identified in the electropherogram in the
LabChip XT software by solid triangles over the peaks. The
triangles are the same color as specified in the Expected
Fragments Tab.

To display the expected peak indicators in the Graph view:

1 Click the Properties tab on the right side of the Graph view to
open the Graph View Properties.

2 To view the size of all expected peaks, select Expected
Fragments in one of the Annotation list boxes.
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Figure 5. Expected Fragments in Graph View
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Viewing the EFs in the Gel View

Expected Fragments are indicated in the Gel View by colored lines
in the LabChip XT software. The color of the line matches the color
specified in the Expected Fragments Tab.

To display the expected peaks in the Gel View:

1 Click the Properties tab on the right side of the Gel View to
open the Gel View Properties.

2 Select the Show EPs and Smears check box.

To display the legend that identifies the colors and sizes of the
expected peaks and smears:

1 Click the Properties tab on the right side of the Gel View to
open the Gel View Properties.

2 Select the Show EP/Smear Legend check box.
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Figure 6. Expected Peaks Legend
Viewing the EFs in the Channel Table

A column is added to the Channel Table in the LabChip XT software
for each Expected Peak entered in the Expected Fragments Tab.
The column displays the property selected in the Property
Displayed in Channel Table list in the Method Window.
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Viewing the EFs in the Peak Table

Expected Fragments are identified in the Peak Table in the
LabChip XT software with the peak name displayed in the Type

column.

Calpes_04.31.25 S ample 2
Calpes_04-31-25 Sample 2
8 Calper_04-31:25 Sample 2
N Caiper_04-31-25 5 anple 2
Cabper_04-31-26 Sample 2
Cabper_04-31:25 5 aimple 2
| Caliper 04-31-25 Sample 2
Calpes_04:31:25 Sample 2

EF200
EF300)
EF400
EFS00

Figure 7. DNA Assay Peak Table
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Modifying Analysis Parameters

Some analysis parameters can be changed in the software to
modify the data evaluation for sample analysis. The following
procedures are included in this section:

Changing the Peak Find Parameters
Adding a Peak

Excluding a Peak

Merging Two Peaks

Changing the Time Window for Analysis
Aligning or Unaligning the Marker Peaks

These settings can be changed after the run is complete or when
reanalyzing a previously saved data file.

NOTE: Only expert users should change analysis settings while the
run is in progress, since changes can affect extractions.
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Changing the Peak Find Parameters

After data filtering, the peak find algorithm locates the peaks and
calculates the local peak baselines. The algorithm begins by finding
all the peaks above the noise threshold to determine the baseline,
after which any peaks below the noise threshold are rejected. A
local baseline is calculated for each peak to allow for baseline drift.

The following Peak Find parameters can be changed in the LabChip
XT software:

* Min Peak Height

* Min Peak Width

» Slope Threshold

* Inflection Threshold

e Start Time
* End Time
* Filter Width

+ Baseline Plateau

The LabChip XTe software does not support changing analysis
parameters.

To change the Peak Find parameters for all channels:

1 Select Analysis 2> Analysis Settings to open the Method
Window, and then click the Peak Find Tab.

2 Change the parameters as necessary at the top of the window
under Chip Peak Find Settings.

3 Click the OK button to save the setting, reanalyze the data, and
close the window.
Click the Apply button to apply the changes and reanalyze the
data, but keep the Method window open.
Click the Apply Global button the apply the settings to all chips
in the workspace and reanalyze the data, but keep the Method
window open.

To change peak find settings for individual channels:

1 Select Analysis > Analysis Settings to open the Method
Window, and then click the Peak Find Tab.

2 In the Channel drop-down list, select the channel number that
you want to change the settings for.
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Adding a Peak

3

Change the settings at the bottom of the window under Channel
Peak Find Settings to change the settings for the selected
channel.

Click the OK button to save the setting, reanalyze the data, and
close the window.

Click the Apply button to apply the changes and reanalyze the
data, but keep the Method window open.

You can manually add a peak in a region where a peak has not
been identified in the LabChip XT software.

1

3

In the Graph View, right-click near the top of the area where the
peak is to be added. The area must be outside any previously
identified peak and the cursor must be an up arrow.

Select Add Manual Peak from the shortcut menu. A new peak
of type MP is created.

If necessary, adjust the Peak Baseline.

Excluding a Peak

You can exclude any peak or fragment from being used in the
analysis.

To exclude a peak:

1
2

OR

In the Peak Table View, right-click on the peak to be excluded.

Select Exclude Peak from the shortcut menu. The Type for the
peak changes to X (excluded), and the value is not used in the
analysis.

Right-click on an Excluded Peak in the peak table and select
Include Peak to include the peak in the data analysis.

In the Graph View, right-click near the top of the peak to be
excluded.

Select Exclude Peak from the shortcut menu. The Type for the
peak changes to X (excluded), and the value is not used in the
analysis.

Right-click on an Excluded Peak in the Graph view and select
Include Peak to include the peak in the data analysis.
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Merging Two Peaks

If the analysis has defined two separate peaks, the two distinct
adjacent peaks can now be merged into one peak in the LabChip
XT or XTe software. This will include the area of both peaks in the
total concentration and percent purity calculations.

To merge two adjacent peaks:

1

Exclude one of the peaks from the analysis, following the
procedure “Excluding a Peak” on page 55.

Verify that Show Peak Baselines is selected in the Graph View
Properties.

Click and drag the baseline of the remaining peak to include the
area under the excluded peak.

Changing the Time Window for Analysis

The Start Time and End Time parameters in the Peak Find tab
define the time window within which peaks are found. These
settings can only be changed in the LabChip XT software.

To change the Start Time and End Time parameters for all channels
in the open assay:

1

Select Analysis 2> Analysis Settings to open the Method
Window, and then click the Peak Find Tab.

Change the Start Time and End Time parameters as
necessary.

Click the OK button to save the setting, reanalyze the data, and
close the window.

OR

Click the Apply button to apply the changes and reanalyze the
data, but keep the Method window open.
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Aligning or Unaligning the Marker Peaks

To perform data analysis for DNA assays, the LabChip XT software
aligns marker peaks included in the sample channels with markers
from the ladder. (LabChip XT only.)

+ To view the raw data without analysis, choose Analysis — Turn
Off Analysis. (LabChip XT only.)

* Tore-enable analysis, choose Analysis — Turn On Analysis.
(LabChip XT only.)

The default setting for this function is enabled. Turning off the
analysis displays the data without aligning the markers in the
channels and without displaying peak labels or smears.
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Figure 8. Data Before and After Analysis

Lower Marker Peaks for DNA Assays

For each DNA sample, the lower marker peak is assigned first and
then the data is aligned so that the channel markers match the
ladder markers in time, allowing the size and concentration of the
sample peaks to be determined.

For DNA assays, the peak in a sample channel that meets the lower
marker criteria specified in the method file is assigned to be the
lower marker and is then offset to match the lower marker in the
ladder. The Sample Lower Marker is aligned to the ladder marker by
resampling the channel data in a linear stretch or compression
using a point-to-point fit.

If there are unexpected peaks in the ladder analysis or the markers
have been set incorrectly, you can manually exclude peaks or set a
peak to be used as a lower marker.
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Aligning or Unaligning the Marker Peaks (Continued)

NOTES
|

-

* Excluding a peak or manually setting a peak to be an lower
marker for a DNA assay can cause errors with analysis.

* You can move the boundary between the Peak Table and the
Graph view up or down to increase or decrease the size of the
Peak Table, making it possible to see all of the results at once.

Right-clicking in the Peak Table View (LabChip XT only) of a
channel opens a shortcut menu with the following commands:
* Include Peak (only for peak type “?”)

* Exclude Peak

* Force Lower Marker

* Add Expected Peak

NOTE
|

-

You can also right-click on a peak in the Graph View to view the
same menu.
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Reverting to a Specific Data File Revision

Each time a LabChip XT data file is changed, a new version of the
data file is created and saved. The LabChip XT software enables
you to revert to a previous version of a data file. This option is not
supported in the LabChip XTe software.

To revert to a previous data file version:

1

On the LabChip XT/XTe Main Window, select Analysis >
Analysis Settings on the main menu. The Method Window
opens.

Click the Restore Chip button at the bottom of the window. The
Restore Chip Settings to Version window opens.

Select the data file version that you want to restore to.

Click the OK button. The Method Window displays the settings
for the selected data file version.

Click the OK button to display the data file with the selected
settings.
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Changing the View of the Results

The views in the LabChip XT/XTe Main Window can be customized
to display data according to the preferences of the user. These
options do not change the raw data but provide different means of
displaying the data.

To change the view in the main window, see:

+  “Viewing Gels” on page 60

*  “Viewing Zero Baselines ” on page 61

*  “Adjust Pane Widths” on page 61

* “Show or Hide Views” on page 62

*  “Zoom In and Zoom Out” on page 62

*  “Viewing Graphs in the Overlay Electropherograms Tab” on
page 63

*  “Viewing Graphs in the Electropherograms Tab” on page 64

*  “Viewing Multiple Properties in the Channel Table View” on
page 65

Viewing Gels

To compare the gels generated by the instrument, view the gels in
the Gel View.
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Figure 9. Gel Tab

The color, width, and contrast of the gels can be changed using the
Gel View Properties.
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To rearrange gels, click on the column header (channel name) and
drag the channel to the desired location. To hide a channel, select
the channel and then click the (X) button on the column header, or
right-click on the channel in the Chip View or List View and select

Remove Channel.

Viewing Zero Baselines

All electropherograms produced with the instrument show some
amount of background fluorescence. By default, the LabChip XT
and XTe software enables the Zero Baseline function (see

page 258). In the LabChip XT software, to remove the zeroing,
select Analysis - Analysis Settings to open the Method Window,
click the Peak Find Tab, and select the None check box under
Baseline Algorithm.

Adjust Pane Widths

The LabChip XT/XTe Main Window displays several different views
of the data files open in the workspace. You can change the height
and width of the views to make the views smaller or larger.

To adjust panes:

1 Place the cursor over the edge of the pane that you want to
adjust. The cursor changes to a line with arrows on each end.

2 Click and drag up, down, left, or right. The pane is resized after
you release the mouse button. The layout setting is saved as
part of the collection.

3 Inthe LabChip XT software, to save the settings, save the
workspace. To create new collections in the LabChip XT
software with the same settings, the collection can be saved as
a collection template (see “Collection Menu” on page 105).

V2.1 LabChip XT/XTe User Manual Caliper Life Sciences, Inc.



Data Analysis 62

Show or Hide Views

The views displayed in the LabChip XT Main Window can be hidden
to maximize other views in the main window. The Layout of the
LabChip XTe Main Window cannot be changed.

To hide a view:

1 Select Collection > Layout on the LabChip XT Main window.
The Layout Options Window opens.

2 Click on the location that is selected for the view to clear the
selection. The view is hidden.

3 If alocation (Left, Right, or Bottom) does not contain any views,
the pane closes and the remaining panes enlarge to fill the
space.

Note: The Gel View is always displayed and cannot be hidden.
To display a hidden view:

1 Select Collection > Layout on the LabChip XT Main window.
The Layout Options Window opens.

2 Click on the desired location for the hidden view (Left, Right, or
Bottom). If multiple views are displayed in the same location,
use the tabs at the top of the location to switch between views.

Zoom In and Zoom Out

You can zoom in and out on data displayed in the Gel View and the
Graph View. The Graph View and the Gel view both zoom to the
same levels when either view is zoomed in. If Synchronized Zoom
is selected, all graphs zoom to the same level.

To zoom in:

* Click and drag to enclose the region of interest. When you
release the mouse button, the selected area enlarges to fill the
view. In the Gel view, all lanes in the collection zoom to the
same level.

* You can continue zooming in until you reach the maximum
magnification (the graph will not zoom in any closer).
To zoom out:

* Right-click in the Graph view or Gel view and select Unzoom to
go to the previous zoom setting or select Unzoom All to zoom
out to the default view.

For more information, see Viewing Graphs in the Overlay
Electropherograms Tab.
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Viewing Graphs in the Overlay Electropherograms Tab

If the Overlay Electropherograms Tab is not open, select Collection

- Layout on the LabChip XT/XTe Main Window, select the location

where you want to display the Overlay Electropherograms tab, and

click the Apply button. The Overlay Electropherograms tab opens.
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Figure 10. Overlay Electropherograms Tab with Multiple
Graphs

Data from multiple channels can be overlaid in the same graph for
visual comparison. Each peak graph is shown in a different color
and line style with a legend at the top of the window.

To add samples to the Overlay Electropherograms Tab, Ctrl +
click on the sample that you want to add in the Chip View, List
View, Gel View, Channel Table View, or Peak Table View. Selected
channels are identified by: dashed outlines around the selected gel
lanes in the Gel view, black outlines around the selected wells in the
Chip view, and light blue text in the List view.

To remove a specific sample from the graph, Ctrl + click on the
sample that you want to remove in the Chip View, List View, Gel
View, Channel Table View, or Peak Table View.

Note: The list view is not displayed in the LabChip XTe software.
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Viewing Graphs in the Electropherograms Tab

If the Electropherograms Tab is not open, select Collection ->
Layout on the LabChip XT/XTe Main Window, select the location
where you want to display the Electropherograms tab, and click the
Apply button. The Electropherograms tab opens.
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Figure 1. Electropherograms Tab with Multiple Graphs

Data from multiple channels can be displayed in the same tab for
visual comparison. A separate graph for each channel in the
collection is displayed in the Electropherograms tab. The data file
name and channel name display at the top of each graph.

To only display the channels selected in the Gel View or
Channel Table View, select the Graph Selected Gels Only check
box in the Graph View Properties.

To move the graphs in the tab, in the Gel View click and drag the
channel to the desired position.

To change the number of graphs displayed in the tab, select the
desired Maximum Graphs per Page value in the Graph View
Properties.

To view the point coordinates and size at the position of the
cursor, hold down <CTRL> or <Shift> and move the cursor over the
graph.

To view the point coordinates and slope of a point on the trace,
hold down <ALT> + <CTRL> and move the cursor over the trace.
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Viewing Multiple Properties in the Channel Table View

Properties for Expected Peaks and Smears display in the Channel
Table View. When entering the settings in the Expected Fragments
Tab or the Smear Analysis Tab on the Method Window, the property
to display in the Channel Table is specified in the Property
Displayed in Channel Table column.

To display multiple properties for the same Expected Peak or
Smear in the Channel Table:

1

In the Expected Fragments tab, or the Smear Analysis tab, enter
the properties for the expected peak or smear, selecting one of
the desired properties in the Property Displayed in Channel
Table column.

Click in the next row and type the same name as an existing EP
or smear in the Name field of the table. The row will
automatically update with the same entries as the original row.
The only field that can be changed is the Property Displayed in
Channel Table column.

Change the Property to the desired selection.
Repeat until all desired properties have been added to the table.

Click the Apply button to display the new columns in the
Channel Table. Duplicate properties in the table will be removed
when the settings are applied to the chip.
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Copying Information

Some of the right-click pop-up menus offer the following choices for
copying information from the LabChip XT/XTe software for use with
other applications, depending on the selection:

*  Copy Gel
* Copy Lane
+ Copy

» Copy Rows to Clipboard
*  Copy Column to Clipboard

Choosing any of these commands places a copy of the selected
item on the computer's clipboard. You can then paste the item into a
word processing, graphics, or other program.

Choosing Copy Gel copies all of the channels displayed in the Gel
View with the labels as part of the graphic. To copy a gel, right-click
in the Gel View and choose Copy Gel.

Choosing Copy Lane copies the selected channel in the Gel View
with the labels as part of the graphic. To copy a gel, right-click in the
Gel View and choose Copy Lane.

Right-clicking in the Electropherograms Tab and selecting Copy
places a graphic of all the channels displayed in the
Electropherograms tab on the clipboard.

Right-clicking in the Overlay Electropherograms Tab and selecting
Copy places a graphic of the entire Overlay Electropherograms tab
on the clipboard.

Copying rows from the Channel Table View places selected
channels on the clipboard. To copy a row or multiple rows, select
the desired rows in the table, right-click on one of the selected rows,
and select Copy Rows to Clipboard.

Copying columns from the Channel Table View is only available for
certain columns in the table. To copy a column, select a single cell
in the column, right-click on the cell, and select Copy Column to
Clipboard.
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Reanalyzing a Data File

Occasionally you may need to open and view or reanalyze a data
file that was run and saved previously. The raw data values are
saved in the chip data file, along with the original analysis settings
that were chosen for the run and any changed analysis settings.
This enables you to reanalyze the data with new settings or to view
previously saved settings.

The following analysis parameters can be changed:

Chip peak find settings and channel peak find settings (see
“Changing the Peak Find Parameters” on page 54)

Add a Peak (see “Adding a Peak” on page 55)

Exclude peaks from analysis (see “Excluding a Peak” on
page 55)

Reassign lower markers (see “Lower Marker Peaks for DNA
Assays” on page 57)

Alignment or no alignment with ladder peaks (see “Aligning or
Unaligning the Marker Peaks” on page 57)

To reanalyze a data file:

1
2
3

Open the workspace that contains the chip data (see page 45).
Change the analysis parameters (see list above) as needed.

When you click the Apply, Apply Global, or OK buttons in the
Method Window, the data is automatically re-analyzed and the
updated information is displayed.

To view previous analysis settings, click the Restore Chip
button at the bottom of the Method window and select the
version to view.
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Printing Workspace Information

Choosing File & Print opens the Print Window to select the
information to print from the open workspace. The selected
information can be printed to a printer or to a PDF file. If the
workspace contains multiple collections, information from the active
(selected) collection is printed.

The header of each printout contains the workspace name, the
collection name, and the page number. The Footer of each printout
contains the LabChip XT/XTe software version, the date that the
workspace was modified, and the print date.

The following information can be printed for the open workspace:
* Print All

+ Gel

* Electropherogram

* Overlay Electropherogram

* Channel Table

* Peak Table (LabChip XT only)

* Run Report (LabChip XT only)

See below for descriptions of each option.
Print All

This option prints the results of the method in all of the available
formats. The page layout depends on the options selected in Print
Settings.
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Gel

Choosing this option prints a gel image with the lanes marked by
the channel name.

i
Hgd

Figure 12. Printed Gel

Electropherogram

Choosing this option prints an individual electropherogram of each
of the selected channels, with one graph on each page.

1 T e B e P

Figure 13. Printed Electropherogram
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Overlay Electropherogram

Choosing this option prints one graph with the electropherograms
for all of the selected channels overlaid onto a single graph.

B — e

Figure 14. Printed Overlay Electropherogram
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Channel Table

Choosing this option prints the columns displayed in the Channel
Table View. To change the columns that are printed or the order of
the columns, change the columns in the Channel Table View.

» Selecting the Add Border check box prints the table with a
border around each cell in the table.

» Selecting both the Channel Table and the Peak Table prints
each channel on a separate page with the Channel Table row at
the top of the page and the Peak Table for the channel below it.

e it e -

Figure 15. Printed Channel Table
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Peak Table

(LabChip XT only) Choosing this option prints the columns
displayed in the Peak Table View. To change the columns that are
printed or the order of the columns, change the columns in the Peak
Table View.

Selecting the Exclude Marker check box removes all markers
from the printout.

Selecting the Add Border check box prints the table with a
border around each cell in the table.

Selecting the Add Channel Name as Header check box prints a
channel header (chip name and channel name) before the
peaks in each channel.

Selecting the Per Page or Per Channel option for the Column
Header specifies whether the Peak Table column headers are
printed only at the top of each page (default), or if the headers
are also printed at the beginning of each new channel table.

Selecting both the Channel Table and the Peak Table prints
each channel on a separate page with the Channel Table row at
the top of the page and the Peak Table for the channel below it.
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Figure 16. Printed Peak Table
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Run Report

(LabChip XT only) Choosing this option prints a one page summary
of the run, which includes the gel for each channel, the
Electropherogram for each channel, Run Information, and the
columns displayed in the Channel Table View. To change the
columns that are printed or the order of the columns, change the
columns in the Channel Table View.

» Selecting the Add Border check box prints the table with a
border around each cell in the table.

Figure 17. Printed Run Report
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Exporting Data

Data from a Peak Table, Channel Table, Gel, or Graph can be
exported automatically and/or manually in the LabChip XT software.
Options selected for automatic export do not affect manual export
options, and vice versa.

* To automatically export data during the run, select the desired
settings in the Start Fractionation Window as described in
“Select the Auto Export Settings” on page 31.

* To manually export data, see “Exporting Data Manually” on
page 77.

The LabChip XTe software does not support exporting analyzed
data.

Peak Tables, Channel Tables, and Raw Data are exported to .CSV
files, which can be imported into a spreadsheet program such as
Microsoft Excel.

Gel and Graph data is exported to the selected image format.

This section shows export examples for the following:
* Peak Table

+ Raw Data

+ Gel

Peak Table

ASCII text file that contains the data in all columns in the Peak
Table. Figure 18 is an example of part of an exported Peak Table
file (data truncated for this example):

A B C D 5 F G H
1 |Chip Name Sample Name Size [BP] Conc. (ngful} % Purity Expected Type Molarity (nmol/l)
2 |Caliper_04-31-25  Sizing Ladder 1 30 LM 45454.5
3 |Caliper_04-31-25  Sizing Ladder 25 20 L 1212.12
4 |Caliper_04-31-25  Sizing Ladder 50 20 L 606.06
5 |Caliper_04-31-25  Sizing Ladder 100 20 L 303.03
6 |Caliper_04-31-25  Sizing Ladder 150 20 L 202.02
7 |Caliper_04-31-25  Sizing Ladder 200 20 L 151.515
8 |Caliper_04-31-25  Sizing Ladder 300 20 L 101.01
9 |Caliper_04-31-25  Sizing Ladder 400 20 L 75.7575
10 Caliper_04-31-25  Sizing Ladder 500 20 L 60.606
11 |Caliper_04-31-25  Sizing Ladder 700 20 L 43.29
12 Caliper_04-31-25  Sizing Ladder 8350 20 L 35.65058824
12 [Caliner N4-31-25 Sizing ladder 1000 0 I 3n.203

Figure 18. Exported Peak Table

Peaks that are excluded are not exported and are missing in the
exported file. For example, if peaks 3, 5, and 7 are excluded when
the data is exported, peaks 3, 5, and 7 are not included in the .csv
file.
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Raw Data

ASCII text file that contains the signal data from the run as one file
per channel or multiple channels in the same file. Note that data
that is exported has been smoothed using the polynomial filter.

In addition to exporting time and value information, you can choose
to export Size information. This information is determined based on
aligned data and is used to correlate the peaks across different runs
or from one row to another.

When Include Size Data is not checked and only time and values
are exported, the state of the analysis function (peaks aligned or
not aligned with the ladder data) determines whether or not data
that is exported is or is not aligned. The same is true for the Zero
Baseline function: if enabled, data that is exported is also zeroed to
the baseline.

Below is an example of part of a raw data file exported from a DNA
assay (header not included and data truncated in this example):

A B c D E 7 G

1 [Time ! Size [BP]  SizingLadder Sample3 Sampled4 Sample2

2 o -46.75 -213.87 -315.7 -391.02 -266.53
3 1 -46.66 -226.54 -341.78 -407.71 -293.88
4 2 -46.58 -194.32 -347.49 -424.85 -275.85
5 3 -46.5 -112.26 -273.78 -363 -182.68
6 ! -46.41 -27.27 -142.69 -223.59 -63.08
7 5 -46.33 10.92 -28.77 -78.93 9
8 6 -46.24 0.73 10.89 -3.29 6.91
9 7 -46.16 -6.9 -7.28 -4.52 -17.47
10 8 -46.08 -1.23 -9.58 -17.07 -4.954
11 9 -45.99 -2.52 -6.36 -14.41 -6.73

Figure 19. Exported Raw Data

Raw data can also be exported in a Chromatography Data
Interchange Format (formerly AIA format), which is used by some
graphical analysis software tools. The Include Size Data and Export
Single Table options are not available with Chromatography Data
Interchange Format.
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Gel

Exports the selected gel(s) in the selected image format. Options
are available to export the entire collection or only the selected
gels. Gels can be exported into the same image file or into separate
files for each gel.

Figure 20 shows multiple selected gels exported to the same image
file.
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Figure 20. Exported Gel
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Exporting Data Manually

If the workspace contains multiple collections, the data exported is
from the active/selected collection. Exporting data is not supported
in the LabChip XTe software.

1
2
3

Open the file that you want to export the data from.
Select File —» Export. The Export Window opens.

Select the check boxes next to the views to export. Selecting
Export All selects all check boxes.

For each selected view, to change the location for the files, click
the Browse (...) button and select the desired location.

If Raw Data is selected, choose the desired export options:

» Select AIA Format to export in Chromatography Data
Interchange Format, used by some graphical analysis
software. The Include Size Data and Export Single Table
options are not available with AIA Format.

+ Select Include Size Data to align the data to the channel's
ladder (for one file per channel) or to the first channel (for a
single data file) and include the size data in the exported
data.

+ Select Export Single Table to export the data for all
channels in the chip to one .CSV file. If not selected, the
data from each channel is exported to a separate .CSV file.

If Electropherogram is selected, select either Entire
Collection to export a graph for each channel in the collection
or select Selected Channels to export a graph for each
selected channel.

If Gel is selected, choose the desired export options:

+ Select Entire Collection to export all of the channels in the
collection or select Selected Channels to export only the
channels that are selected in the Gel view.

+ Select Single File to include gels for all channels in the
same image file, or select Separate Files to export each gel
to a separate image file.

+ If desired, change the height of the exported graphic in the
Height text box.

If either Electropherogram or Gel is selected, choose the
desired format for the image files.

Click OK to export the data to the specified location.
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Software Security

A 21 CFR Part 11 Compliance option is available for the LabChip
XT software. This option ensures that methods, output data,
analysis settings, event data, and backup data files are not
available for editing or tampering. Data is stored in a secure folder
on the local computer. To create and maintain the Audit Log and
LabChip XT user accounts, Microsoft SQL Server 2005 Express is
provided with the LabChip XT 21 CFR Part 11 option.
The following procedures are included in this section:
* “Locking and Unlocking the Software” on page 79
*  “Managing User Accounts” on page 80

— “Adding New Users” on page 80

— “Changing User Information” on page 81

— “Changing User Information” on page 81

— “Printing User Information” on page 82

— “Activating and Deactivating User Accounts” on page 82

— “Changing Access Rights” on page 83

— “Printing Access Rights” on page 84

— “Setting Policies for User Accounts” on page 84

— “Printing User Policies” on page 85
» “Electronic Signatures” on page 86
+  “Automatically Exporting Copies of Data Files” on page 87
«  “Audit Trail” on page 88

— “Viewing the Audit Trail” on page 89

— “Exporting the Audit Trail” on page 89
* “Central Data Repository (CDR)” on page 90

— “CDR Security Suggestions” on page 90

— “Creating New Data Folders” on page 91

— “Moving Data Files into Folders” on page 91

— “Deleting Data Folders” on page 91

— “Hiding Data Files in the CDR Manager Window” on
page 92

— “Showing Hidden Data Files in the CDR Manager
Window” on page 92

*  “Remote CDR Server Backup” on page 93
— “Setting Up the Remote CDR Server” on page 93
— “Backing Up Data Files to the Remote CDR” on page 95
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— “Restoring Data Files from the Remote CDR” on page 96
*  “Manually Backing Up and Restoring the CFR Files” on page 97
— “Backing Up CFR Files” on page 97
“‘Restoring CFR Files” on page 99

Locking and Unlocking the Software

The LabChip XT software with the CFR option installed allows you
to lock the LabChip XT software. This prevents unauthorized users
from accessing the software while you are away from the computer.
After the software is locked, only the logged in user or a LabChip
XT Administrator can unlock the software.

To lock the LabChip XT software:

1 On the LabChip XT/XTe Main Window, click Security — Lock
Application. The Unlock Application Window opens on top of
the LabChip XT Main Window and displays the Username of the
current user.

Lah'Chlp XT Untl:lck ﬁ.nplumn
LabChep XT has been locked. Only ‘adminestrator’ or an
Admirestrator can uniock thes appkcation.

Pazsword | |

OK

Figure 21. Unlock Application Window
To unlock the LabChip XT software:

1 On the Unlock Application Window, type the user password for
the logged in user in the Password text box and click the OK
button.

2 If the password for the current user is not available, type a
LabChip XT Administrator username and password in the
Unlock Application Window and click the OK button. The
Administrator is logged into the LabChip XT software.

3 To change the user to a non-administrator user, close and
restart the LabChip XT software and then log in as the desired
user.
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Managing User Accounts

Access to the LabChip XT software is controlled by user names
when the 21 CFR Part 11 Security option is installed. Each user
must sign into the LabChip XT software. The user’s Access Level
controls which options are available for each user name.

The following procedures are included in this section:

* “Adding New Users” on page 80

* “Changing User Information” on page 81

*  “Printing User Information” on page 82

» “Activating and Deactivating User Accounts” on page 82

* “Changing Access Rights” on page 83

*  “Printing Access Rights” on page 84

» “Setting Policies for User Accounts” on page 84

*  “Printing User Policies” on page 85

Adding New Users

Each person who uses the LabChip XT software should have a
unique LabChip XT user account.

To add a new user:

1 On the LabChip XT/XTe Main Window, select Security — User
and System Administration. The User Administration Window
opens.

Click the Create User button.
Type the desired Username.
Type the First, Middle, and Last Name for user.

Type the user’s Position if desired.

o g A WO DN

Select the Access Level for the user. The Access Level
controls which rights the user has. The following access levels
are available:

* Restricted User
* Operator

» Supervisor

* Administrator

+ Service

7 Type the desired User Password*.
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Adding New Users (Continued)

8 Type the User Password again.

9 Select whether the user can perform a signature.

10 Select whether the user can Accept/Reject/Lock data files.

11 Select whether the user can Unlock data Files.

12 Click the Save button.

* Passwords must be at least 5 characters long and must contain at
least one uppercase letter and at least one number.

Changing User Information

After a user account is created in the LabChip XT software, the user
details can be edited.

To change the user information:

1 On the LabChip XT/XTe Main Window, select Security — User
and System Administration. The User Administration Window
opens.

2 Click the Edit Users button.

3 Select the user to edit from the User drop-down list.

4 Change the User Information as necessary:

First Name

Middle Name

Last Name

Position

Access Level

User Can Perform Signature
Accept/Reject/Lock data files
Unlock data file

User Password

5 Click the Save button to save the updated user information.
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Printing User Information

After editing a user account in the LabChip XT software, the user
details can be printed for record-keeping purposes.

To print the user information:

1 On the LabChip XT/XTe Main Window, select Security — User
and System Administration. The User Administration Window
opens.

2 Click the Show User Info button.

3 To print the information for a single user, select the user name in
the Select User to Display list box.

4 To print the information for all users, select the Print All Users
check box.

5 To preview the printout, click the Print Preview button.

6 To print the selected information, click the Print button.
Activating and Deactivating User Accounts

If a user name is not going to be used, the user account can be
deactivated in the LabChip XT software. The user name is not
removed from the system, but cannot be used to log into the
LabChip XT software. User names cannot be deleted. A deactivated
user name can be activated to continue to be used.

1 On the LabChip XT/XTe Main Window, select Security — User
and System Administration. The User Administration Window
opens.

2 Click the De/Activate User button.
3 Select the Username in the Select User drop-down list.
4 Click the Deactivate button.

To reactivate a user name, select the deactivated user and click the
Activate button to return the user to active status. The user name
can now log into the LabChip XT software.

V2.1 LabChip XT/XTe User Manual Caliper Life Sciences, Inc.



Software Security 83

Changing Access Rights

The rights assigned to each Access Level control the actions that a
user is allowed to perform in the LabChip XT software. The rights
apply to any user name assigned to the access level. Rights cannot
be assigned to an individual user name. The Define Access tab is
not available while an assay is running.

To change the rights for an Access Level:

1

On the LabChip XT/XTe Main Window, select Security — User
and System Administration. The User Administration Window
opens.

Click the Define Access button.

Enable or Disable the desired rights for each Access Level:

User Administration - Allows users to create, edit, activate
and deactivate users, or to change policies.

Run Method - Allows users to run methods and save the
new data files that are created by the run. Users are not
permitted to save changes to existing data files.

Save Existing Data File - Allows users to save changes to
existing data files.

Save Workspace - Allows users to save new and existing
workspaces. If Save Existing Data Files is not selected,
users can only save workspaces where the data files have
not changed.

Hide/Show in CDR - Allows users to hide and show data
files in the CDR.

Manage CDR Folders - Allows users to create, rename, and
delete folders in the CDR Manager window.This permission
is not required for automatically creating daily subdirectories
or to move data files in the CDR.

Perform Validation - Allows users to perform 1Q
(Installation Qualifications) and OQ (Operation
Qualifications).

Print/Export Analysis Results - Allows users to print or
export analysis results.

Audit Trail Access - Allows users to view the Audit Trail in
the Audit Trail Window.

Method Editor - Allows users to edit and save methods.

Click the Save button.

V2.1

LabChip XT/XTe User Manual Caliper Life Sciences, Inc.



Software Security 84

Printing Access Rights

After changing the user rights in the LabChip XT software, the
access rights can be printed for record-keeping purposes.

To print the access rights:

1

2
3
4

On the LabChip XT/XTe Main Window, select Security — User
and System Administration. The User Administration Window
opens.

Click the Define Access button.
To preview the printout, click the Print Preview button.

To print the access rights, click the Print button.

Setting Policies for User Accounts

User Account Policies specify properties such as password options
and whether to require a signature when updating data files in the
LabChip XT software.

1

On the LabChip XT/XTe Main Window, select Security — User
and System Administration. The User Administration Window
opens.

Click the Set Policies button.

Set the options as desired:

* Password Expires After - The number of days until each
password expires. Range is 1 to 1000 days.

*  Number of Retired Passwords to Remember - User
cannot reuse the specified number of old passwords. Range
is from 0 to 5.

*  Minimum Password Length - The minimum length of each
password. Range is from 5 to 30 characters.

+ Maximum Login Attempts - The maximum number of times
the user can attempt to log in before being locked out of the
LabChip XT software. Range is from 3 to 20. This option can
be disabled to allow unlimited retries without locking the user
out.

* Minutes to Automatic Lock - The number of minutes that
the software is inactive until the LabChip XT software locks
automatically. Range is from 5 to 4320 minutes (3 days). To
disable this option, clear the check box. To unlock the
software, see “Locking and Unlocking the Software” on
page 79.
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Setting Policies for User Accounts (Continued)

* Require Signature on File Update - If selected, an
electronic signature is required to save modified data files.
Signatures can be performed by any user who has the
Perform Signature option selected in the User Administration
Window.

4 Click the Save button.
Printing User Policies

After changing the LabChip XT user policies, the user policies can
be printed for record-keeping purposes.

To print the user policies:

1 On the LabChip XT/XTe Main Window, select Security — User
and System Administration. The User Administration Window
opens.

2 Click the Set Policies button.
3 To preview the printout, click the Print Preview button.

4 To print the selected information, click the Print button.
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Electronic Signatures

Based on a company’s procedural requirements, creating and
saving LabChip XT data files may require a superior’s signature. If
so, a user with signature permissions must enter a valid username,
password, and comment to explain the purpose of the signature.
The authorized user also has the option to mark the file as
Accepted or Rejected and to Lock the data file to prevent changes.
The data file can be signed, approved, and locked any time, except
while the assay is running.

Electronic signatures are not supported for LabChip XTe.

NOTE
|

-

To change user signature permissions, see “Changing User
Information” on page 81.

To electronically sign a data file:

1 On the LabChip XT/XTe Main Window, click Security —
Perform Signature. The Perform Signature Window opens on
top of the LabChip XT Main Window.

2 Select the username of the user that is signing the data file in
the Username drop-down list.

3 Type a comment describing the reason for the signature in the
Enter Comment text box.

4 If desired, select Accepted or Rejected as the Approval State.

5 |If desired, select the Lock check box to lock the data file and
prevent any changes. Unreviewed data files cannot be locked.

6 Type the User Password for the signing user in the User
Password text box.

7 Click the Sign button. The Signature Performed window opens
to confirm the signature was performed.

8 Click the OK button in the Signature Performed window. The
Perform Signature window closes. Signature information is
embedded in the data file and the signature is logged in the
Audit Trail.

V2.1

LabChip XT/XTe User Manual Caliper Life Sciences, Inc.



Software Security 87

Automatically Exporting Copies of Data Files

The LabChip XT software provides the option of automatically
exporting a copy of the data file (.xtd) to a folder outside the CDR
when the 21 CFR Part 11 Security option is installed. The data file is
copied to the specified folder after the run is complete.

To automatically export a copy of each data file:

1

On the Output Tab on the Run File Editor Window, select the
Copy To check box.

Click the Browse (...) button. The Browse for Folder Window
opens.

Navigate to the folder where you want to save the exported
copies of the data files.

Click the OK button to choose the selected folder. The path
displays in the Copy To text box on the Output Tab.

To continue setting the assay options in the Run File Editor
Window, see “Select the Output File Locations” on page 30.

Reverting to a Specific Data File Revision

Each time a LabChip XT data file is changed, a new version of the
data file is created and saved. The LabChip XT software enables
you to revert to a previous version of a data file.

To revert to a previous LabChip XT data file version:

1

On the LabChip XT/XTe Main Window, select Analysis >
Analysis Settings on the main menu. The Method Window
opens.

Click the Restore Chip button at the bottom of the window. The
Restore Chip Settings to Version window opens.

Select the data file version that you want to restore to.

Click the OK button. The Method Window displays the settings
for the selected data file version.

Click the OK button to display the data file with the selected
settings.
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Audit Trail

LabChip XT software uses secured, computer-generated, time-
stamped audit trails to independently record the date and time of
operator entries and actions that create, modify, or delete electronic
records. The audit trails can be printed for documentation purposes.
The audit trail documents can be made available for agency review
and copying.

The audit trail is a log of all of the following events that have
occurred in the LabChip XT software:

* Administration and user management (create/ edit / deactivate
user, policy settings, access level modifications, login and lock
events)

» Data file run events (run started, run finished, run stopped, run
aborted)

» Data file signing events

» Data file hide/show events

* Instrument error events

» Data file version changes

+ |Qevents

* Application errors related to main database failures

In Windows XP, the “Computer User Role” records the Windows
role of the user logged in to the LabChip XT software.

In Windows 7, the “Computer User Role” records either User or
Administrator, depending on how the LabChip XT software is
started. If the LabChip XT software is started by right-clicking on the
icon and selecting Run as Administrator, the Computer User Role is
Administrator. If the software is started by double-clicking on the
icon, the Computer User Role is User. The Computer User Role
reflects the privilege that was used to start the LabChip XT
software.

This section includes the following Audit Trail procedures:
*  “Viewing the Audit Trail” on page 89
+  “Exporting the Audit Trail” on page 89
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Viewing the Audit Trail
To view LabChip XT events in the Audit Trail Log:

1

7

On the LabChip XT/XTe Main Window, select Security — Audit
Trail Log. The Audit Trail Window opens.

Select the desired data range:
« Select whether to view most recent entries, entries between
specific dates, or the entire database.

e Select the number of entries or dates to search if Entire
Database is not selected.

To view only events performed by a specific user, select a user
name.

To view events for a specific data file, select the name of the
data file.

To search only specific types of events select the desired Event
Category in the Event Category drop-down list. Default shows
all events.

To change the columns that are displayed, click the green arrow
button next to Event Category and select or hide the desired
columns.

Click the Search button to search the database.

Exporting the Audit Trail

The LabChip XT events displayed in the Audit Trail Window can be
exported to a file. To export the events:

1

On the LabChip XT/XTe Main Window, select Security — Audit
Trail Log. The Audit Trail Window opens.

Click the Export button in the Audit Trail Window. The Audit
Trail Export Window opens.

Select the desired export file format.

e Text
« XML
« Excel

Click the Export button. The Save As window opens.

Choose the desired location for the file, type the desired file
name, and click the Save button. By default, the file name is
ATexport_<date>_<time>, where <date> and <time> are the
current date and time.
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Central Data Repository (CDR)

The Central Data Repository (CDR) is a protected folder located on
the local computer. All LabChip XT data files (.xtd) are saved in the
default CDR folder on the local computer. The CDR folder is
protected from changes by unauthorized users. The CDR is only
used when the 21 CFR Part 11 option is installed with the LabChip
XT software.

The CDR Manager Window enables you to organize data files into
virtual folders. The folders are not actually created in the CDR
folder on the local computer, but are displayed in the CDR Manager
Window to organize the data files. The CDR Manager Window
enables you to create new folders, rename existing folder, and
delete empty folders.

The following procedures are included in this section:

*  “CDR Security Suggestions” on page 90

* “Creating New Data Folders” on page 91

*  “Moving Data Files into Folders” on page 91

+ “Deleting Data Folders” on page 91

* “Hiding Data Files in the CDR Manager Window” on page 92

* “Showing Hidden Data Files in the CDR Manager Window” on
page 92

CDR Security Suggestions

To ensure proper security of data files, the LabChip XT
Administrator should:

1 Change the LabChip XT Administrator password. Make sure to
keep a copy of the password in a safe place. This password
cannot be reset if forgotten. To change the administrator
password:

* Log into the LabChip XT software as the administrator.
+ Select Security - Change Password.
» Type the current password.

* Type the new password in both the New Password and
Confirm Password text boxes.

* Click the OK button.

2 To enable remote CDR, install and set up the Remote CDR
Server (see page 93), then start the CDR Utility and enable
remote CDR Backup (see page 95).

V2.1

LabChip XT/XTe User Manual Caliper Life Sciences, Inc.



Software Security 91

Creating New Data Folders

To create a new CDR data folder for LabChip XT data files:

1 Select File —» Import Data File. The CDR Manager Window
opens.

2 Click on the upper-level CDR folder.

3 Click the New Folder button on the left side of the window. A
new folder named New Folder is created and the name is
selected for update.

4 Type the desired name for the folder and then press the Enter
key.

5 Close the CDR Manager Window.
Moving Data Files into Folders

To move a LabChip XT data file into a CDR data folder:

1 Select File > Import Data File. The CDR Manager Window
opens.

2 Click on the name of the data file.
3 Drag and drop the file into the desired folder.
4 Close the CDR Manager Window.

Deleting Data Folders

Only CDR Data folders that are empty can be deleted. Move the
LabChip XT data files out of the folder before deleting the folder.

To delete a CDR data folder:

1 Select File —» Import Data File. The CDR Manager Window
opens.

2 Verify the folder is empty.
3 Click on the folder name.

4 Click the Delete button on the left side of the window or at the
top of the window.

5 Close the CDR Manager Window.
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Hiding Data Files in the CDR Manager Window

The CDR Manager window enables users to hide or show specific
LabChip XT data files or folders in the CDR Manager window. This
functionality can be used to reduce the number of data files
displayed in the CDR Manager window when certain files or folders
are not used. The user must have Hide/Show in CDR rights in the
Define Access tab in the User Administration Window.

Hiding data files or folders does not change the data file or folder,
they are just not displayed in the CDR Manager Window.

To hide data files or folders:

1 Select File —» Import Data File. The CDR Manager Window
opens.

2 Select the name of the data file or folder that you want to hide. If
you select a folder name, all data files and folders in the
selected folder will also be hidden.

3 Click the Hide button on the left side of the CDR Manager
Window.

4 Close the CDR Manager Window.

Showing Hidden Data Files in the CDR Manager Window

To set hidden LabChip XT data files back to unhidden (show):

1 Click the Show Hidden Files button at the top right of the CDR
Manager Window. All hidden files and folders show in the CDR
Manager window. The file or folder icon indicates if the file or
folder is hidden.

2 Click the name of the file or folder that you want to show and
click the Show button on the right side of the CDR Manager
Window.

NOTE
|

-

Files and folders in a hidden folder do not show in the CDR
Manager Window, even if the files are not set to hidden. To show
files, the folder cannot be set to hidden.

3 Click the Hide Hidden Files button at the top right of the CDR
Manager Window.

4 Close the CDR Manager Window.
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Remote CDR Server Backup

The LabChip XT software with the 21 CFR Part 11 option installed
supports backing up data files to a remote server using Subversion
(SVN). Subversion is a third-party database application used to
copy data files to a remote server within the intranet. To use remote
backup, Subversion must be installed on the remote server using
the CDRServerUtilitySetup.exe included on the LabChip XT
Installation CD.

The LabChip XT software can be set up to automatically back up all
new and modified data files to the Remote CDR Server. Automatic
backup ensures that secure versions of all data files are available
and synchronized, even in the event of failure of the instrument
computer.

The following procedures are included in this section:
» “Setting Up the Remote CDR Server” on page 93
+ “Backing Up Data Files to the Remote CDR” on page 95
* “Restoring Data Files from the Remote CDR” on page 96

To back up the Remote CDR Server, either back up the entire C:\
drive on the remote server, or back up the C:\RemoteCDR folder.

The LabChip XT software also contains an option to copy the data
files to an unsecured location on the local hard drive. These data
files do not meet 21 CFR Part 11 security requirements after they
are copied out of the CDR. To copy data files to a non-secure
location, use the Copy button on the CDR Manager Window.

Setting Up the Remote CDR Server

To back up copies of LabChip XT data files on 21 CFR Part 11
compliant systems, and keep the copies of the data files secure,
back up the files to a Remote CDR Server. The Remote CDR
Server must be running Windows 7. To set up the Remote CDR
Server:

1 If the CDR Server Utility is not already installed on the remote
server, see the Readme.htm file on the LabChip XT Installation
CD for instructions on running CDRServerUtilitySetup.exe.

2 On the Remote computer, double-click on the CDR Server Utility
icon on the Windows desktop. The CDR Server Utility Window
opens.
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Setting Up the Remote CDR Server (Continued)

3

If the Server has not been created on the computer yet, click the
Create Server button to create the server. The default folder
name and location (C:\RemoteCDR) cannot be changed. Wait
for the Create Server button to be disabled and the text boxes to
be active.

NOTE

-

Server name, folder name, username, and password are case
sensitive.

4

A folder must be created on the server to store the database. To
create a new folder on the remote server:

Type the desired folder name in the Folder Name text box.

Type a Username for the folder in the Username text box.
(This is a separate username from the user names created
in the LabChip XT software. This username is only used to
access the data folder on the Remote CDR Server.)

Type the desired password in the Password and Confirm
Password text boxes.

If Get Folder Details is checked, a text file specifying the
folder details is created and saved in C:\Program Files\
Caliper Life Sciences\ LabChip XT\ CDRServer\
ServerDetails\.

Click the Apply button to create the folder.

Close the CDR Server Utility Window after the desired folders
have been created.
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Backing Up Data Files to the Remote CDR

Remote CDR Backup copies each data file in the LabChip XT
software to the Remote CDR server and stores a copy of the data
file in a database. Each time a data file is created or modified, the
changes are copied into the remote database.

Remote CDR Backup can only be enabled by the LabChip XT
default Administrator.

To set up Remote CDR Backup:

1 Verify that the Remote CDR Server is set up on an accessible
network server.

2 Log into the LabChip XT software using the default
administrator user name and password.

3 Select Tools —» CDR Utility. The CDR Utility Window opens.

4 Select the Enable Remote CDR Backup check box.

NOTE
!

Server name, folder name, username, and password are case

sensitive.

5 Type the computer name of the Remote CDR server in the

9

Remote Computer Name/IP Address text box. If the remote
computer and the local computer are not in the same Windows
workgroup, type the IP address of the remote computer.

In the Folder text box, type the name of the folder to use in the
remote CDR server to store the LabChip XT data. (The folder
must have already been created using the CDR Server Utility on
the remote computer.)

Type the folder username in the User Name text box. This
username is the same username that was used to create the
CDR Server folder.

Type the folder password in the Password text box. This is the
same password that was used to create the CDR Server folder.

Click the Apply button.

10 Click the Close button to close the CDR Utility Window.
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Restoring Data Files from the Remote CDR

The last backed up copies of LabChip XT data files can be restored
from the backup database on the remote CDR Server if the LabChip
XT computer is replaced.

To restore the data files from the backup database:

1 Verify that the Remote CDR Server is accessible on the
network.
2 Log into the LabChip XT software using the default
administrator user name and password.
3 Select Tools —» CDR Utility. The CDR Utility Window opens.
4 Select the Enable Remote CDR Backup check box.
NOTE
!
Server name, folder name, username, and password are case
sensitive.
5 Type the computer name of the Remote CDR server in the

Remote Computer Name/IP Address text box. If the remote
computer and the local computer are not in the same Windows
workgroup, type the IP address of the remote computer.

In the Folder text box, type the name of the folder in the remote
CDR server that you want to restore the LabChip XT data from.
(Make sure to select the same folder to which the data was
backed up.)

Type the folder username in the User Name text box. This
username is the same username that was used to create the
CDR Server folder.

Type the folder password in the Password text box. This is the
same password that was used to create the CDR Server folder.

Click the Apply button. The progress bar display the status of
the restoration process and a confirmation displays when the
restore is complete.

10 Click the Close button to close the CDR Utility Window.
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Manually Backing Up and Restoring the CFR

Files

The LabChip XT software with the 21 CFR Part 11 option installed
supports backing up data files to a remote server (see “Remote
CDR Server Backup” on page 93). The CDR data files and the Audit
Trail database can also be backed up manually to another secure
location. Manual backup does not update the backup copies with
any changes to the files. The backup copies can be stored on
another computer or on a removable storage drive. The data files
and Audit Trail database can only be restored to the point when the
files were backed up.

Backing Up CFR Files

To manually back up the CFR Files in the LabChip XT software, you
must back up both the CDR data files and the Audit Trail database.

Setting the CDR folder as accessible

1 Log in to the computer with a User Name in the Administrator
group.

2 For Windows 7: Right-click on the LabChip XT icon on the
Windows desktop and select Run as Administrator.

For Windows XP: Double-click on the LabChip XT icon on the
Windows desktop

3 Login to the LabChip XT CFR software as the Administrator
user.

4 On the LabChip XT/XTe Main Window, select Tools —» CDR
Utility. The CDR Utility Window opens.

5 Select the Accessible by Windows Administrator Level
Users check box and then click the Apply button.

6 Click OK in the Confirmation window.
7 Click the Close button on the CDR Utility Window.

8 Close the LabChip XT software.
Copying the CDR Folder

1 In Windows Explorer, navigate to C:\Program Files\Caliper Life
Sciences.

2 Copy the entire \CDR\ folder to the desired location for the
backup files.
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Setting the CDR folder back to not accessible

1

5
6
7

For Windows 7: Right-click on the LabChip XT icon on the
Windows desktop and select Run as Administrator.

For Windows XP: Double-click on the LabChip XT icon on the
Windows desktop

Log in to the LabChip XT CFR software as the Administrator
user.

On the LabChip XT/XTe Main Window, select Tools — CDR
Utility. The CDR Utility Window opens.

Clear the Accessible by Windows Administrator Level Users
check box and then click the Apply button.

Click OK in the Confirmation window.
Click the Close button on the CDR Utility Window.
Close the LabChip XT software.

Backing up the Audit Trail Database

1

In Windows Explorer, navigate to C:\Program Files\Caliper Life
Sciences\ LabChip XT.

Double-click the BackupDB.bat file. A backup copy of the
database, named DBback.bak, is created.

In Windows Explorer, navigate to C:\Program Files\Caliper Life
Sciences\ LabChip XT\Database\.

Copy the DBback.bak file to the desired location for the backup
files.
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Restoring CFR Files

To restore the CFR files from a manual backup point, you must
restore both the CDR data files and the Audit Trail database. If
restoring the files to a new computer, install the LabChip XT
software and then restore the CFR files.

Setting the CDR folder as accessible

1

6
7
8

Log in to the computer with a User Name in the Administrator
group.

For Windows 7: Right-click on the LabChip XT icon on the
Windows desktop and select Run as Administrator.

For Windows XP: Double-click on the LabChip XT icon on the
Windows desktop

Log in to the LabChip XT CFR software as the Administrator
user.

On the LabChip XT main window, select Tools — CDR Utility.
The CDR Utility Window opens.

Select the Accessible by Windows Administrator Level
Users check box and then click the Apply button.

Click OK in the Confirmation window.
Click the Close button on the CDR Utility Window.
Close the LabChip XT software.

Restoring the CDR Folder

1

In Windows Explorer, navigate to C:\Program Files\Caliper Life
Sciences.

Delete the existing \CDR\ folder.

Copy the backed up \CDR\ folder into the folder. (See “Backing
Up CFR Files” on page 97.)
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Setting the CDR folder back to not accessible

1

5
6
7

For Windows 7: Right-click on the LabChip XT icon on the
Windows desktop and select Run as Administrator.

For Windows XP: Double-click on the LabChip XT icon on the
Windows desktop

Log in to the LabChip XT CFR software as the Administrator
user.

On the LabChip XT main window, select Tools — CDR Utility.
The CDR Utility Window opens.

Clear the Accessible by Windows Administrator Level Users
check box and then click the Apply button.

Click OK in the Confirmation window.
Click the Close button on the CDR Utility Window.
Close the LabChip XT software.

Restoring the Audit Trail Database

1

In Windows Explorer, navigate to C:\Program Files\Caliper Life
Sciences\ LabChip XT\Database\.

Copy the backed up database (DBback.bak) into the folder.

In Windows Explorer, navigate to C:\Program Files\Caliper Life
Sciences\ LabChip XT\.

Double-click the RestoreDB.bat file. The Audit Trail database is
restored to the backup point.
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Software Reference

This section describes each of the windows in the LabChip XT and
XTe software. Each window description describes the options and
buttons on the window, and how to open the window. This section
describes the following windows:

*  “LabChip XT/XTe Main Window” on page 102

*  “About LabChip XT/XTe Window” on page 138

*  “Add New Expected Peak Window” on page 139
e “Audit Trail Window” on page 140

*  “Audit Trail Export Window” on page 141

+ “Audit Trail Manage Columns Window” on page 142
* “CDR Manager Window” on page 143

+ “CDR Server Utility Window” on page 145

+ “CDR Utility Window” on page 146

* “Change Password Window” on page 148

+ “Data File Version Window” on page 149

+  “Event Viewer Window” on page 150

*  “Export Window” on page 151

*  “Flush Chip Window” on page 154

+ “Layout Options Window” on page 155

*  “Login Window” on page 156

*  “Method Window” on page 157

*  “Modify Run Settings Window” on page 173

*  “New Collection Window” on page 174

* “Perform Signature Window” on page 175

*  “Print Window” on page 176

*  “Print Validation Reports Window” on page 178
*  “Rename Collection Window” on page 179

*  “Run File Editor Window” on page 180

*  “Run Info Window” on page 181

» “Save Workspace File As Window” on page 183
+ “Select a Data File Window” on page 184

+ “Software Installation Qualification Window” on page 185
» “Start Fractionation Window” on page 186

+ “System Diagnostics Window” on page 199

*  “Unlock Application Window” on page 201

*  “Unlock Data File Window” on page 202

*  “User Administration Window” on page 203
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LabChip XT/XTe Main Window
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Figure 22. LabChip XT Main Window
The main window of the LabChip XT/XTe software includes:
*  “Menu Bar” on page 103
*  “Run Status and Chip Info” on page 109
*  “Error Message Area” on page 110
*  “Run Setup” on page 111
*  “Chip View or List View” on page 113
* “Collection Pane” on page 116
* “Graph View” on page 117
* “Graph View Properties” on page 122
* “Filter View” on page 124 (LabChip XT only)
+ “Gel View” on page 128
* “Gel View Properties” on page 131
* “Channel Table View” on page 133
+  “Peak Table View” on page 135 (LabChip XT only)
* “Peak Table Properties” on page 137 (LabChip XT only)
Clicking and dragging the borders between the views changes the
size of the views in the collection. To change the location of the
views, see “Changing the View of the Results” on page 60.
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Menu Bar

The menu bar is directly below the title bar on the LabChip XT/XTe
Main Window. Clicking a menu name displays a list of commands to
access software functions.

The LabChip XT/XTe software contains the following menus:

*  “File Menu” on page 104

*  “Workspace Menu” on page 104

* “Collection Menu” on page 105 (LabChip XT only.)

*  “Analysis Menu” on page 105 (LabChip XT only.)

*  “Instrument Menu” on page 106 (/Instrument mode only.)

*  “Tools Menu” on page 106

» “Security Menu” on page 107 (Only displays if the 21 CFR Part
11 option is installed with the LabChip XT software.)

«  “View Menu” on page 107

+  “Validation Menu” on page 107
*  “Window Menu” on page 108

*  “Help Menu” on page 108
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File Menu

The File menu contains the following commands:

New Workspace - Creates a new, blank workspace. (LabChip XT
only.)

Open Workspace - Opens a saved workspace. All data files in a
workspace must be the same type. (LabChip XT only.)

Import Data File - Opens a saved LabChip XT/XTe data file for a
specific chip. If the 21 CFR Part 11 option is installed, opens the
CDR Manager Window. A graphical representation of the chip
displays. Data files are file type .xtd (LabChip XT) or .xte (LabChip
XTe).

Export - Opens the Export Window to choose the type of data to
export. Exports a Peak Table, Channel Table, Gel, Single Graph, or
all open graphs in the current Collection to a file, depending on the
options selected. (LabChip XT only.)

Print - Opens the Print Window to choose the data to print.

Save Workspace - Saves the current workspace. (LabChip XT
only.)

Save Workspace As - Saves the current workspace with a new
filename. (LabChip XT only.)

Exit - Closes the LabChip XT/XTe software.

Workspace Menu
The Workspace menu contains the following commands:

Remove Chip - Removes the selected chip data file from the
workspace.

Save Chip - Saves the chip data file (*.xtd for LabChip XT or .xte
for LabChip XTe). Changes to the analysis settings (in the Method
Window) are saved at the end of the chip data file. Previous
analysis settings are not overwritten, enabling you to use the
Restore Chip button on the Method Window to go back to any
previously saved settings. Chip data files are automatically saved
when the Workspace is saved. The LabChip XTe software does not
support changing analysis settings or saving workspaces.
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Collection Menu

Analysis Menu

The Collection menu in the LabChip XT software contains the
following commands:

Undo - Undoes changes to the collection view settings and filter
settings. Changes made in pop-up windows, such as analysis
settings, export settings, etc, are not affected by this Undo.

New Collection - Opens the New Collection Window where you
choose whether to create a new Collection from a saved Collection
Template, a Blank Collection, or the Current Collection.

Rename Collection - Opens the Rename Collection Window to
rename the currently selected Collection.

Delete Collection - Deletes the current Collection.

Save As Template - Opens the Save Template As window to save
the display and filter settings currently displayed in the Collection
tab as a collection template.

Apply Template - Opens the Apply Template window to open a
saved collection template and apply the settings to the current
Collection.

Layout - Opens the Layout Options Window to change where tabs
are displayed by default on the main window.

The Collection menu is not available in the LabChip XTe software.

The Analysis menu in the LabChip XT software contains the
following commands:

Turn On/Off Analysis - Toggles analysis on and off. When analysis
is on, the data displayed in the main window uses the analysis
settings in the Method Window. When analysis is off, the raw
(unanalyzed) data displays.

Scale to All Peaks - Scales the view to the minimum and maximum
X values of the current sample peaks. Marker and/or system peaks
are ignored.

Analysis Settings - Opens the Method Window to choose analysis
parameters for the chip. Use these settings to change the analysis
and peak finding parameters to help resolve hard-to-decipher data.

Standard Curve - Opens the Standard Curve Window to view the
ladder as a curve with a point-to-point fit.

The Analysis menu is not available in the LabChip XTe software.
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Instrument Menu

Tools Menu

The Instrument menu contains the following commands:

Start Run - Opens the Start Fractionation Window to begin running
a sample chip. See the Assay User Guide for chip and sample prep
instructions. Changes to Stop Run while a chip is running.

Stop Run - Displays a Stop Run window to stop the run. Click the
Yes button to stop the run. Click the No button to continue the run.

Flush Chip - Opens the Flush Chip Window to flush the selected
channels on a chip.

NOTE

|

-

The Instrument menu does not display if the software was installed
in Reviewer mode.

The Tools menu contains the following commands:

Run File Editor — Opens the Run File Editor Window to create Run
files. Run files contain all of the settings in the Start Fractionation
Window.

Method Editor - Opens the Select Method To Edit window to select
the name of the method to edit. The selected method opens for
editing in the Method Window. (LabChip XT only.)

CDR Utility - Opens the CDR Utility Window to set or change the
CDR options or Remote CDR Backup options. This command is
only available when the 21 CFR Part 11 option is installed and the
default Administrator is logged into the LabChip XT software.
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Security Menu

View Menu

The Security menu only displays if the 21 CFR Support option is
installed with the LabChip XT software.

User and System Administration - Opens the User Administration
Window to create, edit, and view user login information, activate or
deactivate users, define user access, and set user policies.

Change Password - Opens the Change Password Window to
change the Login Password for the current user.

Perform Signature - Opens the Perform Signature Window to sign
a data file, change the approval state, or lock the data file.

Unlock Data File - Opens the Unlock Data File Window to unlock a
locked data file.

Audit Trail Log - Opens the Audit Trail Window to view, search,
export, and print the audit trail.

Lock Application - Opens the Unlock Application Window to lock
the LabChip XT software and prevent other users from using the
software until the software is unlocked by the current user or an
Administrator.

The View menu contains the following commands:

Event Viewer - Opens the Event Viewer Window to view events
and errors that occur during the current run or during a previous
run.

Run Info - Opens the Run Info Window to view information about
the run.

Version Change Details - Displays the Data File Version Window
to view changed versions of the selected open data file. (LabChip
XT only.)

Validation Menu

The Validation menu contains the following commands:

Software 1Q - Opens the Software Installation Qualification Window
to perform the 1Q.

Diagnostics - Opens the System Diagnostics Window to run
diagnostic tests to verify system operation and performance.

Reports - Opens the Print Validation Reports Window to view or
print IQ/OQ results.
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Window Menu

Help Menu

The Window menu contains the following commands:

Cascade - Displays each Collection in a separate, cascading
window in the Collection Pane.

Tile Vertical - Displays each Collection in separate side by side
windows in the Collection Pane. (LabChip XT only.)

Tile Horizontal - Displays each Collection in separate top to bottom
windows in the Collection Pane. (LabChip XT only.)

Tabbed - Displays each Collection in a separate tab in the
Collection Pane.

The Help menu contains the following commands:

LabChip XT/XTe Help - Opens the Contents/Index page for the
LabChip XT/XTe Help file.

About LabChip XT/XTe - Opens the About LabChip XT/XTe
Window, showing the software and firmware version numbers.
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Run Status and Chip Info

The Run Status and Chip Info areas on the LabChip XT/XTe Main
Window display the instrument status, chip status, chip information,
and information about the current run. If the software was installed
in Reviewer mode, this status area does not display.

Run Status 3

Chip Info

Chip ID: ND160001-00-02
Expiraton Date: Jun 7, 2011
Avaiabie Channels: 4

Tyes:  XT DNA 750
Run Status: e

Run Button - Opens the Start Fractionation Window to begin a run.
The Run button only displays when the cursor is positioned over the
instrument image. See the LabChip XT Assay User Guide for chip
preparation instructions. While an assay is running, the Run button
changes to a Pause/Stop button.

Pause/Stop Button - Opens the Modify Run Settings Window to
edit the method, resume the run, or stop the run. The Pause/Stop
button only displays when the cursor is positioned over the
instrument image while a method is running. The method settings
can be changed before resuming the run. Clicking the Stop Run
button immediately stops the run. Runs that have been stopped
cannot be continued or resumed.

Chip Info

Chip ID - The ID number of the chip, read from the barcode on the
chip.

Expiration Date - Displays the date when the chip will expire. If the
chip is expired, the date displays in red. Starting a run with an
expired chip displays a warning, but allows the run to continue if
desired.

Available Channels- Displays the number of unused channels on
the chip. Used channels are automatically disabled in the software.

Type - Displays the type of assay that the chip will run.

Run Status - Displays the current system activity and the time until
the next collection time. When all collections are complete, displays
the time until the end of the run.
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Error Message Area

‘Run Status. 4

Chip ifo
I Chip ID:  NF152101-21-19
Expiration Date: Dec 28, 2010
Available Channels: 0
Type:  XT DNA 500 HR
Run Status; Run successiully completed.

|
Q Device S5IBarcodeReader is disconnected .

Figure 23. Error Messages Displayed

Chip errors can display on top of the instrument image or in the
Chip Info section. Errors in the Chip Info area are indicated by red
text as shown in Figure 23.

Connectivity and hardware error messages are displayed at the
bottom of the Run Status and Chip Info area on the LabChip XT/XTe
Main Window. Figure 23 shows a barcode reader error at the
bottom of the Run Status area.

See “Error Messages” on page 226 for a list of errors and tips on
preventing or resolving errors.
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Run Setup

The Run Setup area displays information about the run currently in
progress. This section only displays during the run.

Fun Setup

C 5 Mode Size Fange [BF]
1 Lckdr

2 2 XAP 50-1000 [+/-10%] CLICK
3 2 XEP G625 +S4% 600 BP
4 1 X&BC 301 +/-10% DONE

Trigger A

Figure 24. Run Setup

The Run Setup displays the following information:

Column

Description

C

Displays the channel number on the chip.

S

Displays the number of the step currently executing.
Single step extractions display 1 in this column.

Mode

Displays the Extraction Mode for the current step.

See “Setup Tab” on page 188 for descriptions of
each extraction mode.

Lddr = Ladder

Off = Disabled

X&S = eXtract and Stop

X&C = eXtract and Continue
Xld = eXcLuDe region (XT only)
Sep = Separation (XT only)
X&P = eXtract and Pause

Skip = Skip extraction (XT only)

Size Range
(BP)

Displays the Size range or Search region for each
step.
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Column

Description

Trigger At

Displays the trigger point for the current step in
each channel.

For Collect on Click Extraction Mode or Manual
Collection Width, click on the word CLICK to
begin or end the extraction. The sample in the
channel is within the specified search region
when a pink background displays behind the text.

Displays COLLECT on a green background when
the extraction for a channel is complete and the
run is paused, either automatically or manually.
Pausing the run and then opening and closing the
lid to remove the sample from the Collection well
changes the display to the trigger for the next
step in the channel or to DONE if the extraction is
complete in that channel. If the run is paused but
the lid is not opened, the channel continues to
display COLLECT.

Displays DONE when the extraction is complete
in each channel.
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Chip View or List View

The Chip View or List View displays on the lower left side of the
LabChip XT/XTe Main Window in the LabChip XT software. The List
View is not available in the LabChip XTe software.

The Chip View or List View displays the data files in the open
collection and enables you to select specific channels of chip data.
Click the tabs at the bottom of the view to switch between Chip View
and List View.

Chip View
Chip View Right-Click Menu

Right-clicking on the chip name in the Chip view displays the
following options in the shortcut menu:

Save Chip - Saves the current data file.

Copy Chip - Saves a copy of the chip data file (.xtd for LabChip XT,
or .xte for LabChip XTe) to the selected folder.

Rename Chip - Renames the chip in the workspace. If the Rename
File to Match check box is selected, the data file is also renamed. If
the Rename File to Match check box is cleared (not selected) the
data file name remains the same. The data file cannot be renamed
if the 21 CFR Security option is installed.

Remove Chip - Removes the chip data file from the workspace.
The data file is not deleted, only the workspace view changes.

Analysis Settings - Displays the Method Window to change the
analysis settings for the data file. (This option is not available in the
LabChip XTe software.)

Version Change Details - Displays the Data File Version Window
to change the version of the data file displayed in the workspace.
(This option is not available in the LabChip XTe software.)

Run Info - Displays the Run Info Window to view the run
information and Event Log.
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Chip Channel Color Code

Green - Channels are running.

Blue - Channels are included in the open collection (channel 1
above).

Blue with Black Ring - Channels are selected for analysis
(channel 2 above).

White - Channels are not included in the open collection but have
data.

Grey - Channels do not contain any data.

White with Red Ring - An analysis error has occurred in the
channel.

White with Green Ring - The channel is not analyzed.

Any Other Color - Channels are selected by a Filter. See the Filter
View to determine which color represents each filter. If a channel is
selected by multiple filters, the colors are combined in the channel.
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List View
The List View in the LabChip XT software displays a list of all the
channels in the currently open data files. Select the List tab at the
bottom of the Workspace pane to see the List view. (The List View
is not displayed in the LabChip XTe software.)
» Black channels are not included in the open collection.
* Dark Blue channels are included in the open collection.
» Light Blue channels are selected in the Gel View and Channel
Table View.
» Channels outlined in black are selected by a filter.
* Red channels have an analysis error.
] (1] Calptr_04:31-25
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Figure 25. List View
V2.1 LabChip XT/XTe User Manual Caliper Life Sciences, Inc.



Software Reference 116

Collection Pane

The Collection Pane in the LabChip XT/XTe Main Window displays
a tab for each collection in the workspace. Each collection displays
the information from the data files that are open in the Chip View or
List View. (Multiple collections are not supported in the LabChip
XTe software.)

The Collection Tabs each contain the following views:

Graph View

Gel View

Channel Table View
Peak Table View
Filter View

The views in the Collection pane are synchronized with each other.

Selecting a graph on the Graph tab automatically selects the
same channel on the Gel tab.

Selecting a peak in the Peak Table automatically selects the
same peak in the Graph tab and the Gel tab.

Closing a gel on the Gel tab closes the graph for the channel
and removes the channel data from the Peak Table and Channel
Table tabs.
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Graph View

The Graph view in the Collection Pane is a visual representation of
the data from each channel as an electropherogram.

The Graph view contains the Overlay Electropherograms Tab and
the Electropherograms Tab to view data while a run is in progress
or after the run is complete. For information on changing the view in
the Overlay Electropherograms tab, see “Viewing Graphs in the
Overlay Electropherograms Tab” on page 63. For information on
changing the view in the Electropherograms tab, see “Viewing
Graphs in the Electropherograms Tab” on page 64.
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Figure 26. Graph View

If Type is selected as an annotation, the lower markers are
displayed in the graph view with green arrows labeled LM. The
currently selected peak in the Gel view or Peak Table displays a
blue arrow above the peak.

You can zoom in and zoom out the Graph View of the channels.
Zoom in by clicking and dragging over a region of an
electropherogram. Zoom out by right clicking on a graph, and
selecting either Unzoom or Unzoom All from the shortcut menu.
Double-clicking in the graph will zoom out to the previous zoom
level.

Graph data in the LabChip XT software can be exported to a
graphic file by choosing Export on the File menu. (See “Exporting
Data” on page 74 for details.) If the workspace contains multiple
collections, the data exported is from the active/selected collection.
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Graph View (Continued)

To show or change the labels on the peaks in the graph, show the
data points on the graph, show peak baselines, or change the graph
colors, see “Graph View Properties” on page 122.

To select a peak on the graph, move the cursor near the peak. A
blue arrow above the peak shows that the peak is selected, and the
cursor changes to an arrow that points straight up. The Gel View
and Peak Table View also select the corresponding entry.

You can adjust the peak baselines from the graph view after the run
is complete, if desired. Select Show Peak Baselines in the Graph
View Properties to display the baseline for each peak. To change
the baseline, click at either end of the peak baseline and drag to the
desired location. To reset the baseline back to the original position,
right-click near the baseline end point and choose Reset to
Defaults.

While a run is in progress, the graphs initially display the raw
(unanalyzed) data as it is being read from the chip. As data is
acquired, the analysis aligns the baselines and lower markers, and
the aligned data displays in real time.

Graph View Shortcut Menus
Right-Click Menu (not near a peak)

Right-click away from a peak in the graph to display a shortcut
menu containing the following commands:

Synchronize Zoom - If checked, all open graphs will zoom to the
same level when one graph is zoomed.

Unzoom - Zooms out to the previous zoom level.

Unzoom All - Zooms out completely and returns to the standard
view.

Set Scale - Opens the Set Graph Scales window to specify the X
and Y ranges to show on the graph.

Scale to Sample Peaks/Scale to All Peaks - Scales the view to
the minimum and maximum X values of the all peaks, including
marker peaks and system peaks.

Remove - Removes selected graph from the view.
Copy - Copies the selected graph to the clipboard in a .bmp format.

Analysis Settings - Opens the Method Window to change the
analysis settings. (LabChip XT only.)
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Graph View (Continued)

Right-Click Menu (near a peak)

Right-click above or below a peak in the graph to display a shortcut
menu containing the following commands:

Exclude Peak - Excludes the peak from the analysis. (The Peak
Type label displays X.)

Force Lower Marker - Defines the selected peak as the Lower
Marker. (The Peak Type label displays LM*.)

Add Expected Peak - Opens the Add New Expected Peak Window
to add a new Expected Peak to the specified channels. (LabChip
XT only)
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Overlay Electropherograms Tab

Use the Overlay Electropherograms tab on the Graph View to view
a single graph or multiple graphs overlaid on top of each other.
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Figure 27. Overlay Electropherograms Tab

The sample list at the upper right displays the name of each sample
and the color assigned to the graph for each sample. If only one
graph is displayed, the Gel View, Channel Table View, and Chip
View or List View all show the same selected channel.

The gel lanes selected in the Gel View are synchronized with the
graphs displayed in the Overlay Electropherograms tab.

For information on changing the view in the Overlay
Electropherograms tab, see “Viewing Graphs in the Overlay
Electropherograms Tab” on page 63.

See “Graph View Properties” on page 122 for descriptions of the
properties that can be set for the Overlay Electropherograms tab.
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Electropherograms Tab

Use the Electropherograms tab on the Graph View to view a single
graph or multiple graphs in the same tab.
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Figure 28. Electropherograms Tab

Each graph displays the data file name and channel name at the
top of the graph.

For information on changing the view properties in the
Electropherograms tab, see “Viewing Graphs in the
Electropherograms Tab” on page 64.

See “Graph View Properties” on page 122 for descriptions of the
properties that can be set for the Electropherograms tab.
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Graph View Properties

To view the Properties for the Electropherograms Tab or the
Overlay Electropherograms Tab, click the Properties tab on the
right side of the Graph View.
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Figure 29. XT Electropherograms Properties and XT Overlay
Electropherograms Properties

This window contains the following options:

Option

Function

Layout (Rows x
Columns)

Specifies the number of rows and columns of graphs displayed
on the Electropherograms Tab. (Only displayed when the
Electropherograms tab is selected.)

Annotation 1

Labels each peak in the graph with the peak property selected
from the drop down list. Default is Type.
The Annotations available depend on the columns selected in
the Peak Table View. (LabChip XT only)

Text Orientation
(A) button

Specifies the orientation of the text for the annotation: horizontal,
vertical up, or vertical down. (LabChip XT only)
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Option

Function

Set Font button

Opens the Font window to choose the font, style, and size of the
text for all annotations. (LabChip XT only)

Annotation 2

Labels each peak in the graph with a peak property selected
from the drop down list. Default is None. (LabChip XT only)

Peak Annotation
Legend

If selected, the types of the annotations display in the upper left
corner of the graph. (LabChip XT only)

Location Button
(arrow)

Channel Displays the selected channel property outside the graph.
Annotation (LabChip XT only)

Channel The location of the channel annotation. Click the button to
Annotation change to location: upper right, upper left, lower left, or lower

right. (LabChip XT only)

Show Data Points

If selected, displays a dot on the graph at the location of each
data point.

Show Peak
Baselines

If selected, displays the baseline for each peak on the graph.

Show Smears

If selected, displays smears as a colored line on the trace and
displays the smear baseline. This option only displays if smears
are defined in the Method Window.

Only Annotate
Expected Peaks

If selected, only the peaks that are labeled as Expected
Fragments display the annotations. If not selected, all peaks
display the annotations. (LabChip XT only)

Graph Selected

If selected, only the channels selected in the Gel View or

Gels Only Channel Table View are displayed in the Electropherograms tab.
If not selected, all channels in the collection are displayed. (Only
displayed when the Electropherograms tab is selected.)

Sample Displays the names of the samples (channel names) on the

Name/Color graph and the color associated with each sample (channel).

Table Click on the color to choose a different color for a sample.
(LabChip XT only)

X Axis Scale Specifies the units displayed on the X Axis, either Time, Size, or
Log Size. Log Size displays the size on a logaritmic scale.

Grid Style Displays grid lines on the graph: vertical, horizontal, both, or

none. Click the button to cycle through the grid options.

Data Legend

If multiple channels are displayed, specifies the location where

Location the legend displays on the graph. The legend shows the color
used for each channel. (LabChip XT only)

Pin icon In the top right corner, locks in place or unlocks the Properties
tab. If locked, the Graph resizes to fit the tab.
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Filter View

The Filter view in the Collection Pane is used to define criteria to
automatically select the channels to display in the Collection tab.
The filter types available depend on the method type. Each filter
can be assigned a different color to determine which filter applies to
each channel. See Example: Expected Peaks Filter for an example
of a filter.

The Filter tab is only available in the LabChip XT software.
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Figure 30. Filter View

One or more filters can be defined independently by selecting the
appropriate filter type, range mode, and range values, and then
clicking the Add button. The Available Filters list box displays all
of the filters that are part of the current collection. The check box
next to each filter in the list is used to include or exclude that filter
from the analysis.

The Filter Options selection determines how multiple filters are
logically combined. The options available are OR, AND(Peak), and
AND(Channel).

* OR - Selects any channel that contains a peak that matches any
of the filters selected in the Available Filters list.

+ AND(Peak) - Selects any channel that contains a single peak
that matches all of the filters selected in the Available Filters list.

+ AND(Channel) - Selects any channel that contains peaks that
match all of the filters selected in the Available Filters list.
Different peaks in the same channel can match different filters,
as long as all filter conditions are met in the same channel.
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Filter View (Continued)

Example: Expected Peaks Filter

In the example below, the sizes 100 +/- 10%, 300 +/- 10%, and 500
+/- 10% are selected, with each expected peak size identified by a
different color. This filter will select any channels that contain all
three expected peaks: 100, 300, AND 500. Note that the filter is
selected (checked) under Available Filters, indicating that the filter
is being applied to the data.

To select channels that contain any of the three peaks, create a
separate filter for each peak and select OR as shown below.
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Filter View (Continued)

When using multiple filters that include peak properties, if
AND(Peak) is selected, a single peak in the channel must meet all
selected filter properties. See the examples below, which each use
two filters:

* Height > 100 AND(Peak) Conc > 50 selects any channel that
contains a single peak that meets both criteria.

* Height >100 OR Conc > 50 selects any channel that contains a
peak that meets either (or both) criteria.

* Height >100 AND(Peak) Height <50 does not select any
channels because a single peak cannot have a height that is
both less than 50 and greater than 100. Use OR to select
channels that have peaks that match either criteria. Use
AND(Channel) to select channels that contain peaks that match
both criteria.

Expected Peak Filters can contain multiple size peaks in the same
filter as shown above. Expected Peak filters with multiple peak
sizes in the same filter always select only channels that contain all
the peaks listed.
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Figure 31. Filter Applied Example
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Filter View (Continued)

In the chip diagram in Figure 31 on page 126, the orange channels
are the channels that meet the filter criteria. To see the graph for
each channel, click on the channel in the chip diagram and view the
graph in the Graph view.

The gel in Figure 31 on page 126 shows the expected peaks
marked with colored lines on the Gel view. The channel header is
orange if the channel meets the filter criteria. If a channel meets the
criteria of multiple filters, the header color is a combination of the
filter colors.
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Gel View

The Gel view in the Collection Pane is a visual representation of the
data formatted to look like the Gel slabs that were originally used to
provide DNA data. The data is shown in Time vs. Fluorescence (or
digital form).

Click on a gel lane (channel) to select the channel. Ctrl + click to
select multiple channels. Selected channels are outlined with a
dotted gray line. Channels selected in the Gel view are also
selected in the Channel Table View and are displayed in the
Overlay Electropherograms Tab.

Saring Ladder
ExtraciySizn
Trgge: on Peak
Trigged on Peak

Figure 32. Gel View

Moving the cursor over a band in the Gel view displays a tool tip
that includes the same information about the peak as the Peak
Table View. (Changing the columns displayed in the Peak Table will
change the contents of the tool tip in the Gel view.)

Expected Peaks are indicated on the gel by colored horizontal
lines.

Smears (representing the portion of the sample that was routed to
the collection well) are indicated on the gel by colored regions in the

gel.

For DNA assays, the lower markers of all channels are aligned to
the lower marker of the first channel in the gel view.
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Gel View (Continued)

A colored column header indicates that the channel is selected by a
filter. Click the Filter View to view the color of each filter. A red
exclamation point under the header indicates an analysis error
occurred in the channel. A yellow exclamation point under the
header indicates an analysis warning occurred in the channel. A
gray header indicates a normal channel. To change the size of the
gel header, click on the border between the header and the channel
and drag the header to the desired size.

The graphs displayed in the Graph View are synchronized with the
lanes selected in the Gel tab.

You can drag-and-drop the gel lanes to change the order of the
channels for comparing two or more gel channels. To drag-and-drop
a gel lane, click in the header of the lane to be moved and drag the
gel lane to the desired location.

Double-click in the Gel view to zoom out to the previous zoom level.

Gel data in the LabChip XT software can be exported to a graphic
file by choosing Export on the File Menu (see “Exporting Data” on
page 74 for details). If the workspace contains multiple collections,
data is exported from the active/selected collection.

To change the Lane Width or Gel Contrast Range, see Gel View
Properties.

Right-Click Menu

Right-click anywhere in a gel to display a shortcut menu containing
the following commands:

Unzoom - Zooms out to the previous zoom level.

Unzoom All - Zooms out completely and returns to the standard
view.

Scale Gel Contrast to this Lane - If selected for a lane, the
minimum and maximum RFU values for all lanes in the collection
are set to the minimum and maximum RFU values in the selected
lane.

Remove - Removes the sample from the collection.

Copy Gel - Copies all of the open lanes (channels) to the clipboard
in a .bmp format.

Copy Lane - Copies the selected lane (channel) to the clipboard in
a .bmp format.
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Gel View (Continued)

Analysis Settings - Opens the Method Window to change the
analysis settings. ( LabChip XT only.)

Edit Sample Name - Opens the Edit Sample Name window to
change the channel name or add a comment to the channel. The
comment displays in the Channel Table View and in printed reports.

Rename Chip - Opens the Rename Chip window to specify a new
name for the chip. Also enables you to rename the data file to
match the name of the chip by selecting the Rename File to Match
check box. The data file cannot be renamed if the 21 CFR Security
option is installed.
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Gel View Properties

To view the Gel View Properties, click the Properties tab on the
right side of the Gel View.
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Figure 33. Gel View Properties

The following properties can be set for the Gel view:

Option/Button

Function

Lane Width

Sets the width of the Gel column. Select Auto Fit
to have the software automatically fit all the data,
or use the slider to manually set the width.

Gel Contrast
Range

Sets the minimum and maximum Gel Band
Contrast for the bands in each channel. Use the
sliders to change the Min and Max values.

Gel Color

Click on the Foreground color or the Background
color to open the Color window to choose the
desired colors for the gel.

Set Lane Label
Font button

Opens the Font window to change the font or font
size of the labels in the gel headers.

Show Peak
Information

If selected, displays peak information in a tool tip
when the cursor moves over a peak. If not
selected, the tool tip does not display when the
cursor is over a peak.

Show EPs and
Smears

If selected, EPs are indicated by a solid color
triangle above the peak and smears are indicated
by bands of translucent color in the Gel view.
(Expected Peaks are only supported in LabChip
XT.)
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Show Displays a legend of the colors of the Expected
EP/Smear Peaks and Smears in the Gel view. Click and
Legend drag to move the legend. (Expected Peaks are

only supported in LabChip XT.)

Pin icon In the top right corner, this is used to lock in place
or unlock the Properties tab. If locked in place,
the Gel display panel is resized to accommodate
the tab.
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Channel Table View

The Channel Table view in the Collection Pane contains a summary
of analysis results for the channels selected from the chips in the
collection.

L

Figure 34. Channel Table View

In the LabChip XT software, the Total Conc. (ng/uL) reports the
concentration of all DNA as was present in the sample well. The
Conc. of Collections (ng/uL) column reports the total extracted
concentration over all fractionation steps diverted to the Collection
well as was present in the sample well, not the concentration that
will be extracted from the collection well. To compute the mass of
the collected DNA, multiply by the sample volume in uL. For
example, for a typical sample volume of 10 uL, the collected mass
will be 10 times the reported concentration. To estimate the
concentration in the collection well, divide the mass by the buffer
volume in the collection well (20 uL). (The Conc. of Collections
column is not shown by default, but can be viewed by right-clicking
on the column headers in the Channel table and move the column
to the Selected columns list.)

As the run progresses in the LabChip XT software, the
concentration for each extraction is calculated and displays in
columns named Concentration of Collection Region<#> (ng/uL).
These concentrations are reported as was present in the sample
well.

The LabChip XTe software does not display the quantitation values,
Chip ID, Barcode, or Molarity in the Channel Table.

The following values are calculated for each extraction step as the
run progresses: Molarity of Collection Region<#> (nMol/l) (LabChip
XT only), Fractionation Start<#> [min], and Fractionation End<#>
[min].

To view or hide columns in the Channel Table view, right-click on
any column header in the table. The Select Channel Table Columns
window displays all available columns and the currently selected
columns. Show columns in the Channel Table by moving the
column name to the Selected Columns list. Hide columns by moving
the column name to the Available Columns list.
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Channel Table View (Continued)

Change the order of columns in the table by clicking on a column
header and dragging the column to the desired position in the table.
Click a column header to sort the table in ascending/ descending/
original order.

Right-click in the Chip Name column to open the Rename Chip
window to rename the chip. The Data file can also be renamed by
selecting the Rename File to Match check box if the 21 CFR
Security option is not installed.

Right click in the Sample Name column to edit the channel name or
copy the row to the clipboard.

Right click in the User Comment column to add or edit the User
Comment or copy the row to the clipboard.

Analysis error messages display in the Channel Table View. Most
are the result of peaks not being located by the analysis algorithms.
This can be due to a sample or ladder peak not appearing as
expected. In the LabChip XT software, the settings in the Peak Find
Tab can also cause peaks to be undetected. Manually excluding a
peak (see page 55) from analysis in the Peak Table View or
changing the start or end times for a run can also cause errors with
the peak find algorithm in the LabChip XT software.

The Channel table in the LabChip XT software can be exported to a
.csv file by choosing Export on the File Menu (see “Exporting Data”
on page 74 for details). The .csv file includes the columns in the
order displayed in the Channel Table at export time. The .csv file
can be opened in Microsoft Excel. If the workspace contains
multiple collections, the data is exported from the active/selected
collection. (Exporting the Channel table and opening multiple
collections are not supported in the LabChip XTe software.)
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Peak Table View

The Peak Table view in the Collection Pane is a text-based
representation of all the information about each peak.

To view or hide columns in the Peak Table view, right-click on the
column headers in the table. The Select Peak Table Columns
window displays all available columns and the currently selected
channels. Show columns in the Peak Table by moving the column
name to the Selected Columns list. Hide columns by moving the
column name to the Available Columns list.
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Figure 35. Peak Table View

To change the order of columns in the table, click on a column
header and drag the column to the desired position in the table.
Click a column header to sort the table in ascending/ descending/
original order.

The analysis normally labels the lower marker (LM) in each sample
and in the ladder. The labels display in the Type column of the table.
If the analysis has misidentified the markers, the correct marker can
be selected manually by right-clicking on the peak row to open a
shortcut menu of possible peak types for the peak. This can also be
used to label a peak as Excluded (X). The concentration of an
excluded peak is forced to zero so that it does not affect the total
channel concentration and the Percent Purity calculation.

Expected Peaks are indicated by the Expected peak name in the
Type column.

The peak table in the LabChip XT software can be exported to a
.csv file by choosing Export on the File Menu (see “Exporting Data”
on page 74 for details). The .csv file includes the columns in the
order displayed in the Peak Table at export time. the .csv file can be
opened in Microsoft Excel. If the workspace contains multiple
collections, the data is exported from the active/selected collection.
(Multiple collections are not supported in the LabChip XTe
software.)
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Peak Table View (Continued)

To show only filtered peaks, sort within each channel, or hide
excluded peaks, see Peak Table Properties.

The Peak Table displays the following columns by default:
Chip Name - The name of the chip defined in the workspace.

Sample Name - The sample name defined in the Setup Tab on the
Start Fractionation Window. The Sample name can also be
changed in the Channel Table View or the Gel View.

Type - Displays the type of peak for markers or expected peaks.

Migration Time (min) - Center - The time, in minutes, at which the
center of the peak reaches the detector.

Size (BP) - The size of the peak based on the ladder sizes specified
in the assay.

Height - The height of the peak.

Aligned Area - The area of the peak after the data has been
aligned with the ladder. Used to calculate the concentration.

Conc. (ng/uL) - The concentration calculated relative to the ladder
and marker peak concentrations. The ladder concentration is
displayed in the Analysis Tab of the Method Window. This value
represents the concentration of each fragment as was present in
the sample well. To compute the fragment mass, multiply by the
sample volume in uL.

% Purity - The ratio of peak concentration to total concentration
(above the lower marker) in the sample.

Molarity (nmol/l) - Displays the molarity of the peak.

Peak Table View Shortcut Menus

Right-click on a peak in the peak table to display a shortcut menu
containing the following commands:

* Exclude Peak

* Force Lower Marker

* Force Expected Peak

NOTE
|

-

Excluding a peak or manually setting a peak to be a lower marker
can cause errors with analysis.
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Peak Table Properties

To view the Peak Table Properties, click the Properties tab on the
right side of the Peak Table View.
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Figure 36. Peak Table Properties

This window contains the following options:

Option

Function

Sort within
each Channel

If selected (default), sorting occurs only within each channel rather
than across the entire table. Click a column header to sort the
table rows by the column value. If cleared, uses conventional
sorting, which mixes together peaks from all channels. Clicking the
column header sorts in ascending/descending/original order.

Hide excluded
peaks

If selected, excluded peaks and unknown peaks are hidden in the
Peak Table view.

Expected
Peaks only

If selected, only peaks identified as Expected peaks display in the
Peak Table.

Filtered peaks
only

If selected, the Peak Table displays only peaks that match the filter
criteria. Useful when generating a collection based on a filter
whose selection criteria are peak specific, such as Area,
Concentration, %Purity, Expected Peaks, and Size.

Show all Peaks

If selected, all peaks display in the Peak Table.

Selected in Gel

If selected, only the gel lanes selected in the Gel View display. To
select multiple channels, Ctrl + click on the lanes in the Gel view.

Entire If selected, all channels in all chips that are included in the

Collection collection are displayed.

Pin icon In the top right corner, used to lock in place or unlock the
Properties tab. If locked in place, the Peak Table display panel is
resized to accommodate the tab.
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About LabChip XT/XTe Window

The About LabChip XT/XTe window displays the software and
firmware versions. Selecting About LabChip XT or About LabChip

XTe on the Help Menu opens this window.

About LabChip XT a
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Soltware Verson 20.1006.0
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Figure 37. About LabChip XT Window
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Add New Expected Peak Window

Use the Add New Expected Peak Window to add an expected peak
to specific channels. To open this window, right-click near a peak in
the Graph View and select Add Expected Peak. (Expected Peaks
are only supported in the LabChip XT software.)
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Figure 38. Add New Expected Peak Window

Size (BP) Specifies the expected size of the peak in BP. The default size is the
size of the peak that was selected.

Window (%) | Specifies the tolerance window as a percent of the expected size for
the fragment to allow for small variations in expected peak size.

Color Displays the color to use to mark the peak in the Graph View or the
Gel View.

Name Specifies a name to display in the Type description for the peak.

Property Specifies the content of a column added to the channel table for each

Displayed in | expected peak.

Channel

Table

Apply to Specifies the channels that the expected peak is applied to. <All>

Channels specifies that the expected peak applies to all channels. Clicking on
the column opens the Select Channels window to choose the specific
channels to apply the expected peak to.
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Audit Trail Window

The Audit Trail Window enables you to search the Audit Trail Log
for specific events, to export the events, or to print events. (Only
available if the 21 CFR Security option is installed with the LabChip
XT software.)

To open the Audit Trail window, select Security - Audit Trail Log
on the LabChip XT/XTe Main Window.
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Figure 39. Audit Trail Window

At

The Audit Trail Window contains the following options:

Search most
recent entries

If selected, the specified most recent number of entries is
searched for entries matching the selected criteria.

Number of
entries

Specifies the number of most recent entries to search.

Search by dates

If selected, entries between the specified dates are searched for
entries matching the selected criteria.

From and To
text boxes

Select the dates that contain the events that you want to view.

Search entire
database

If selected, all entries in the database are searched.

Username text
box

Select a specific user name to view only events performed under
the specified user name. Select All Users to view events
performed by any user.

Filename text
box

Clicking the Browse (...) button opens the Audit Trail CDR
Browser window to open the audit trail for a different data file.
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Event Category

Specifies the Event Category of events to search for. Default
selects all event categories.

Green Arrow
button

Displays the Audit Trail Manage Columns Window to select the
columns to view in the Audit Trail window.

Search button

Searches for events matching the search criteria specified.

Export button

Opens the Audit Trail Export Window to export a copy of the
selected events out of the audit trail log.

Print View
button

Displays a preview for printing the Audit Trail Report.

Close button

Closes the Audit Trail Window.

Audit Trail Export Window

Use the Audit Trail Export Window to export the contents of the
Audit Trail Window to either an ASCII text file, and XML file, or a
Microsoft Excel file. Only the events displayed in the Audit Trail
Window are exported. Events filtered out of the view are not
exported. (Only available if the 21 CFR Security option is installed
with the LabChip XT software.)

To open the Audit Trail Export Window, click the Export button in
the Audit Trail Window.
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Figure 40. Audit Trail Export Window
The Audit Trail Export Window contains the following options:

File Formats - Select the desired format for the exported file:
« ASCII Text File - If selected, the file is saved as a .txt file.
XML File - If selected, the file is saved as an .xml file.
 MS Excel - If selected, the file is saved as an .xls file.

Number of Events Included - Displays the number of events that
will be exported.
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Audit Trail Manage Columns Window

Use the Audit Trail Manage Columns Window to select the columns
to view at the bottom of the Audit Trail Window. (Only available if
the 21 CFR Security option is installed with the LabChip XT
software.)

To open the Audit Trail Manage Columns Window, click the Green
Arrow button next to the Event Category text box in the Audit Trail
Window.
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Figure 41. Audit Trail Manage Columns Window

4 Save

The Audit Trail Manage Columns window contains the following
parts:

Show All check
box

Selecting the check box selects all of the listed columns to display
at the bottom of the Audit Trail window. Clearing the check box
clears all of the column check boxes.

Column list

Only the selected columns display at the bottom of the Audit Trail
window. Cleared (unselected) columns are hidden.

Green Up and
Down Arrows

Moves the selected column up or down in the list. The columns
display in the Audit Trail window in order from the top column on
the left to the bottom column on the right.

Save button

Saves the selections and applies the current column view to the
Audit Trails window.

Close button

Closes the window without saving changes to the selections.
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CDR Manager Window

Use the CDR Manager Window to select a data file to open, to
create, rename, or delete CDR data folders, and to show or hide
data files from view in the CDR Manager Window.

To open the CDR Manager Window, select File > Import Data File
on the LabChip XT/XTe Main Window. The CDR Manager window
only opens if the 21 CFR Part 11 Security option is installed with the
LabChip XT software. If the 21 CFR Part 11 Security option is not
installed, see “Select a Data File Window” on page 184.
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Figure 42. CDR Manager Window

The CDR Manager Window contains the following options

Left Side Buttons

Import Imports a CDR data file into the open workspace.
Button

Copy Button | Copies the selected data file to another location.
The copy of the data file will not be part of the CDR
and will not be change-controlled.

New Button | Creates a new folder in the CDR.

Rename Renames the selected folder in the CDR. (Data files
Button in the CDR cannot be renamed.
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Delete Deletes an empty folder in the CDR. If the folder is

Button not empty, you cannot delete the folder.

Hide Button | Hides the selected folder or data files from view in
the CDR Manager window. If a folder is selected, all
files and subfolders in the selected folder are
hidden.

Show Displays all hidden data files and folders in the

Button selected folder.

Top Right Buttons

New Button | Creates a new folder in the CDR.

Delete Deletes an empty folder in the CDR. If the folder is
Button not empty, you cannot delete the folder.

Show/Hide | Shows or hides the filenames of all files that have
Hidden Files | been hidden in the CDR Manager window.

Button

Expand All | Expands all folders in the CDR to show all data files
Button and folders.

Collapse All | Closes all folders in the CDR folder.

Button
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CDR Server Utility Window

Use the CDR Server Utility Window to create a repository (the
Remote CDR Server Folder) on a remote computer to back up the
CDR. The repository stores secure backup copies of data files. The
CDR Server Utility Window is only available if the CDR Server
Utility is installed on the remote computer. (Only used if the 21 CFR
Security option is installed with the LabChip XT software.)

To open the CDR Server Utility Window, double-click the CDR
Server Utility icon on the remote computer desktop.

<01 e iy - Venon 2015101 -~
e whos i = Ty e
I B

et neww COR server
Create hew' Seroer Folder

Server Fokler C FlemelelTH
Criade P Tiliches i ths B Exiting lokier kel i T v
Fosder Name oo}
CA-LabTnioGaTE

Lhamame

Poapwond

Canfrn Pasgacr]

o1 (et Foicder et iy Sy
! Uaeer st ackdd port 3530 i tha plira liaf in coso of wsing non-Wirdows trewall

e ':I:l.l.-'l.'l (w2

e —

Figure 43. CDR Server Utility Window
The CDR Server Utility Window contains the following options:

Server Folder

The name of the repository that will contain the data folders.

Create Server

Creates the repository for backup data in C:\RemoteCDR.

Folder Name

Specifies the name of the data folder to create in the repository.

Username Specifies the user name to use when accessing the data folder.
Password Specifies the password to use when accessing the data folder.
Confirm The same password as typed in the Password text box.
Password

Get Folder If selected, creates a text file containing the URL, Folder Name,
Details Username, and Password for the new data folder.

View Contents

Opens the CDR Server Viewer window to view the data files and
folders in the remote CDR server. Click a folder and enter the user
name and password that was used to create the folder to view the
contents of the CDR server folders.

Apply button

Creates the specified data folder.
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CDR Utility Window

Use the CDR Utility Window to view the location of the local CDR
folder, specify whether the CDR folder is accessible by Windows

Administrators

, and to enable Remote CDR Backup. Before

enabling remote CDR Backup, the remote CDR server and folder
must be set up (see page 93).

To open the CDR Utility Window, select Tools > CDR Utility on the
LabChip XT/XTe Main Window. The CDR Utility command is only
available if the 21 CFR Part 11 Security option is installed with the
LabChip XT software.
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Figure 44. CDR Utility Window

The CDR Window contains the following options:

CDR Folder

Displays the location of the CDR folder where the
LabChip XT data files will be saved. This location
cannot be changed.

Accessible by
Windows
Administrator

To access the check box, right-click on the
LabChip XT icon on the Windows desktop and
select Run as Administrator. If selected,
Windows Administrators who are logged into the
computer can access the CDR folder. If not
selected, Windows Administrators are prompted to
set full permission when opening the folder.
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Enable
Remote CDR
Backup

If selected, all new or edited data files are
automatically copied to the specified remote
database.

Remote CDR
Database

Specifies the path to the remote database.

Folder Name

Specifies the name of the folder in the database in
which to save copies of the data files.

User Name Specifies the user name assigned to the folder
when the folder was created.
Password Specifies the password assigned to the folder

when the folder was created.

Apply button

Applies the changes and closes the window.

Cancel
button

Closes the window without saving any changes.
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Change Password Window

Use the Change Password Window to change the password for the
current user. (To change passwords for other users, see User
Administration Window.) This window is only available if the 21 CFR
Security option is installed with the LabChip XT software.

To open the Change Password Window, select Security > Change
Password on the LabChip XT/XTe Main Window.
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Figure 45. Change Password Window

The Change Password Window contains the following options:

Username Displays the user name for the current user.

Current Type the current password for the current user.
Password

New Type the new password for the current user.
Password

Confirm Retype the new password for the current user.
Password

OK button Saves the new password and closes the window.

Cancel Closes the window without saving changes to the
button password.
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Data File Version Window

Use the Data File Version Window to view the saved versions of the
data file in the LabChip XT software. Also displays when the data
file was signed, whether the file was locked, and the current
approval state if the 21 CFR Part 11 Security option is installed.

To open the Data File Version Window, select View - Version
Change Details on the main menu.
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Figure 46. Data File Version Window

The Data File Version Window contains the following options:

List of Displays the list of all saved data file versions and
Versions electronic signatures. (To open a different version of
the data file, click the Restore Chip button in the
Method Window.)

Details Displays the details of the changes or signature.
Signature details include approving and
locking/unlocking the data file.

Print All Versions: If selected, version information and
Options details for all data versions is printed.

Selected Version: If selected, version information
and details for only the selected version is printed.

Print Opens the Print Preview window to preview the
Preview printed version information.
button

Print button | Opens the Print window to print the data file version
information.

Close button | Closes the Data File Version window.
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Event Viewer Window

Use the Event Viewer window to view events and errors that occur
during the current run or during a previous run.

To open the Event Viewer window, select View - Event Viewer on
the LabChip XT/XTe Main Window.
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Figure 47. Event Viewer Window
The Event Viewer window contains the following tabs:

Current Events tab - Displays the events that occurred during the
current session.

Past Events tab - Displays all events from previous sessions.

Search Results tab - Enables you to search for specified text in
past events, current events, or all events.

The tabs on the Event Viewer window contain the following
columns:

Column Title |Description
Time The data and time the event or error occurred.
Source The system component that generated the event or error.
Event Code The event/error ID number used by Caliper to troubleshoot errors.
Description Text describing the event or error.
Click the OK button to close the Event Viewer window.
V2.1

LabChip XT/XTe User Manual Caliper Life Sciences, Inc.



Software Reference 151

Export Window

Use the Export window to export data manually. To open the Export
window, select File > Export on the main Menu Bar.

The Auto Export window contains the same options and is used to
automatically export data at the end of each run. To automatically
export data, click the Settings button next to Automatic Export in

the Output Tab on the Start Fractionation Window.

Manual and Auto Export are only available in the LabChip XT
software.

Peak Tables and Channel Tables are exported to .CSV files, which
can be imported into a spreadsheet program such as Microsoft
Excel. Raw Data can be exported to either a .CSV file or to a
Chromatography Data Interchange Format file (formerly AlA), which
is used by some graphical analysis software tools.
Electropherogram and Gel data are exported to the selected image
format. See “Exporting Data” on page 74 for instructions.
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Figure 48. Export Window

Peak Table

If selected, the data in the Peak Table View is exported to a .CSV
file. Click the Browse (...) button to specify the desired path and file
name for the .CSV file.

V2.1
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Export Window (Continued)

Channel Table

If selected, the data in the Channel Table View is exported to a
.CSV file. Click the Browse (...) button to specify the desired path
and file name for the .CSV file.

Raw Data
If selected, the raw (unanalyzed) data from the run is exported.

« If the AIA Format check box is selected, the raw data is
exported to a file in the Chromatography Data Interchange
Format (formerly AlA). (Include Size Data and Export Single
Table are not available.)

« If the AIA Format check box is NOT selected, the raw data is
exported to a .CSV file. Click the Browse (...) button to specify
the desired path and file name for the .CSV file. The following
options are available:

— Include Size Data: If selected, the data is aligned to the
channel's ladder (for one file per channel) or to the first
channel (for a single data file) and the size data is
included in the exported data. If not selected, the data is
not aligned to a ladder.

— Export Single Table: If selected, the data for all
channels in the chip is exported to one .CSV file. If not
selected, the data from each channel is exported to a
separate .CSV file.

Electropherogram

If selected, the graph displayed in the Graph View is exported to the
specified folder in the selected image format. Click the Browse (...)
button to specify the desired path for the image file. The file name
format is <sample name>_<chip name>_Egram_<channel
number>. The following options are available on the Export window.
(These options are not available on the Auto Export window.)

+ Entire Collection: If selected, a separate graph is exported for
each channel in the collection.

+ Selected Channels: If selected, a separate graph is exported
for each of the channels selected in the Gel View or Chip View
or List View.

V2.1 LabChip XT/XTe User Manual Caliper Life Sciences, Inc.



Software Reference 153

Export Window (Continued)

Gel

If selected, the gels selected in the Gel View are exported to the
specified folder in the selected image format. Click the Browse (...)
button to specify the desired path for the image file. The file name
format is <sample name>_<chip name>_Gel_<channel number>.
The following options are available on the Export window.

Entire Collection: If selected, a gel is exported for each
channel in the collection. (This option is not available on the
Auto Export window.)

Selected Channels: If selected, a gel is exported for each of
the channels selected in the Gel View or Chip View or List View.
(This option is not available on the Auto Export window.)

Single File: If selected, the selected gels are all included in the
same image file.

Separate Files: If selected, the selected gels are each exported
to a separate image file.

Height: Specifies the desired height, in pixels, of the gel
graphic.

Image Format for Gel and Electropherogram
Select the desired format for the exported image files.

V2.1
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Flush Chip Window

Use the Flush Chip window to flush used channels on a chip for the
specified times. Individual times can be specified for each channel
on a chip.

To open the Flush Chip Window, insert the chip in the instrument
and then select Instrument > Flush Chip.
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Figure 49. Flush Chip Window

Channel Flush Time - Specifies the desired time (in minutes) to
flush each channel. Unused channels should not normally be
flushed, but can be flushed if necessary.

All Used Channels Time - Sets the Flush time for all used
channels to the specified time. If the time for any channel is
changed, the time specified in the Channel Flush Time text box is
used.

Flush button - Starts flushing the channels using the times
specified.

Stop button - Stops a flush that is in progress. Only displays when
a Flush operation is in progress.

Done button - Closes the window without starting the Flush
operation.

V2.1 LabChip XT/XTe User Manual Caliper Life Sciences, Inc.



Software Reference 155

Layout Options Window

Use the Layout Options window to change the location of the views
in a collection. To open the Layout Options window, select
Collection > Layout on the LabChip XT/XTe Main Window.
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Figure 50. Layout Options Window

Viewer - Lists the viewers available to display in the Collection
Pane.

Left - If selected, the view displays on the right side of the
Collection pane. (The view displays at the top if any view is selected
to display at the bottom of the pane.)

Right - If selected, the view displays on the left side of the
Collection pane. (The view displays at the top if any view is selected
to display at the bottom of the pane.)

Bottom - If selected, the view displays at the bottom of the
Collection pane. (The view displays at the top if there are no views
displayed at the top left or right in the pane.)

Apply button - Applies the selections to the active collection and
closes the Layout Options window.

Reset to Factory Defaults button - Restores the active collection
to the default Layout options.

Cancel button - Closes the Layout Properties window without
changing the collection layout.
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Layout Options Window (Continued)

NOTES
|

-

* A view can only be displayed in one location. Selecting a
location automatically clears any other selected location.

« To hide a view, click on the selected location to clear the
selection.

* A location is hidden if it contains no views.
* The Gel View is always displayed and cannot be hidden.

Login Window

Use the Login Window to log into the LabChip XT software when
the 21 CFR Part 11 option is installed. The LabChip XT software will
not start until a valid user name and password are entered.

The Login Window opens when you start the LabChip XT software
with the 21 CFR Part 11 option is installed.

LabChip XT - Lp?:n !

Enter usemame and password:
Username:  admnistraior

| Password: |

QK Cancel

Figure 51. Login Window

The Login Window contains the following options:

Username Type the username to log into the LabChip XT

text box software. Each user should have a unique user
name.

Password Type the password assigned to the Username. All

text box passwords must be at least 5 characters long and

must contain at least one uppercase letter and at
least one number. The User Account Policies
specify additional password requirements.
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Method Window

The Method window specifies the analysis parameters for the
channels in the collection. Use the analysis settings to analyze the
data after the fractionation is complete. To view the method for the
selected data file, select Analysis > Analysis Settings. Methods
cannot be edited in the LabChip XTe software.

The Method Editor window contains the same options as the
Method window. To open the Method Editor window to view or edit a
saved method file, select Tools 2 Method Editor on the main
menu. The Method window contains the following tabs:

* Method Info Tab

* Analysis Tab

* Peak Find Tab

» Expected Fragments Tab
* Excluded Fragments Tab
* Smear Analysis Tab

* Advanced Tab

The following buttons at the bottom of the Method window are used
to save, apply, or cancel changes:

Buttons Function

Apply Applies setting changes and re-analyzes the chip, but keeps the Method
window open.

Apply Applies the selected analysis settings to all chips in the open

Global workspace.

Restore Restores the analysis settings for the chip to the version of the data file

Chip selected in the Restore Chip Settings to Version window. If the 21 CFR
Security option is installed, opens the Restore Chip Settings To Version
window to choose which version of a data file to restore.

OK Applies the changes in the Method window and re-analyzes the chip
with the new settings.

Print Opens the Print Preview window to view the analysis settings before

Preview printing.

Print Opens the Print window to print the default ladder, Analysis and Chip
Peak Find Settings, Analysis Parameters, Expected Fragments,
Excluded Fragments, and Smear Analysis.

Cancel Restores the settings that were selected when the window was opened
or when the last Apply was performed. No re-analysis is performed
because the settings were used for the last analysis performed.
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Method Window (Continued)

The following buttons at the bottom of the Method Editor window
are used to save or cancel changes:

Buttons Function
Save Opens the Save Method to File window to specify a name for the
Method modified method. If the specified name is the same as an existing

method, you are prompted to overwrite the existing method.

Restore Restores the analysis settings to the last saved settings. All changes are
Method discarded.

Close Closes the Method Editor window. If the method contains unsaved
analysis changes, you are prompted to discard the changes.
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Method Info Tab

The Method Info tab on the Method Window displays the header
information for the current method.

Figure 52. Method Window - Method Info Tab

The following information is displayed:

Method Class - All methods on the LabChip XT/XTe are XT DNA
750, XT DNA 750 Ver2, or XT DNA 300, method class DNA1.

Name - The name of the method.

Title - The title of the method. (This field can be changed in the
Method Editor window.)

Comments - An optional comment that can be used to identify the
method.

Version - The current version of the method that was run.

Format - The format of the data file.
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Analysis Tab

Use the Analysis tab on the Method Window to view the Lower
Marker peak designation, Ladder Sizes, Ladder Concentration,
Standard Curve, Data Range, and Marker Concentration.
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Figure 53. Method Window - Analysis Tab

Default Ladder - A table showing the sizes (in base-pairs) of the
ladder peaks.

Ladder Concentration - The concentration (in ng/uL) for the ladder
peaks.

Standard Curve - Determines whether the fit for the standard curve
used to calibrate migration time to size will be done on a point-to-
point, or Polynomial fit of the ladder. DNA methods are set to point-
to-point curve fits but can be changed to Polynomial.

Lower Marker

Conc. ng/uL - The concentration of the lower marker in ng/uL.
Size [BP] - The size of the lower marker.

Time (min) - The expected time when the lower marker will be
detected in the sample.

Height - The expected height of the lower marker.
Area - The expected area of the lower marker in a sample.

Data Range

Baseline - Specifies the time in minutes after the start of the run
when the first peak can appear (any peaks appearing before this
time are ignored).

Channel End - Specifies the time when peak detection stops.
The graph ends at this time.
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Peak Find Tab

Use the Peak Find tab on the Method Window to adjust parameters
to detect peaks for individual channels, or the entire chip specified
in the Chip field.
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Figure 54. Method Window - Peak Find Tab

To change the options for all channels on the chip, change the
options in the Chip Peak Find Settings at the top of the window (see
Table 1 on page 162).

To select a single channel, right-click on a channel in the Gel View
or a graph in the Graph View and select the Analysis Settings
option. The settings for the single channel are displayed in the
Channel Peak Find Settings fields at the bottom of the window (see
Table 2 on page 163). Select other individual channels in the chip
by selecting the channel name in the Channel drop-down list. The
channel list includes all the channels on the currently selected chip.
The Channel Name field is read only, and cannot be changed from
the Peak Find Tab.
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Peak Find Tab (Continued)

This window contains the following options:
Table 1. Chip Peak Find Settings

Chip

Settings Function

Minimum Specifies the height limit below which a peak is not detected. For

Peak Height | each peak, the difference between the peak start time and the peak
apex must be greater than the Min Peak Height value.

Minimum Specifies the limit (in minutes) for the peak width. Peaks narrower in

Peak Width |time than this value are not detected.

Slope Represents the amount of change in absorbance units over time

Threshold required to indicate that a peak has occurred. This setting is used to
detect the leading and trailing edges of a peak. Increasing this setting
may cause broad rolling bumps to be ignored or merge multiple
bumps into a single peak. Decreasing this setting will broaden the
peaks’ width and potentially pick up broad bumps as peaks. See
“Peak Identification” on page 250 for more information.

Inflection Represents the value that the slope minimum must be below to

Threshold trigger a splitting of the peak. As the threshold is increased, more
peak splitting occurs. See “Inflection Threshold Example” on
page 244 for more information.

Start Time Specifies the time after the start of a run when the first peak will be
detected (any peaks appearing before this time are ignored). The Gel
and Graph views will not plot data earlier than this time.

End Time Specifies the time after which peak detection stops. The Gel and
Graph views will not plot data beyond this time.

Filter Width | Specifies the width, in minutes, of the low pass filter to be convolved
with the data. The width of this filter should be about 6 samples wide.
If this setting is too large, peaks will develop spurious side lodes
(ringing) due to over-filtering.

Baseline Specifies a baseline selection parameter for peak finding. The signal

Plateau is at baseline whenever the slope of the data is less than the slope
threshold setting (positive or negative) for longer than the Baseline
Plateau. This rejects brief, low slope areas such as in between non-
baseline-resolved peaks.

Polynomial | A filter algorithm is used to filter the data, increasing the signal-to-

Order noise ratio. The data is convolved with a polynomial of this order to
produce filter data and a filter slope and decrease the background or
baseline noise and/or spikes in the signal. This value is read only.
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Table 1. Chip Peak Find Settings

Chip
Settings

Function

Baseline
Algorithm

* None - No correction.

» Zero Baseline - Offsets all graphs to zero baseline but does not
affect analysis.

* Baseline Subtraction - A dynamic subtraction of the baseline that
corrects for drifting Baseline.

» Spline - This algorithm creates a smooth line fit to the baseline
data points and subtracts this smooth fit from the data. The
threshold specifies how much the baseline fit tries to follow
changes in the data. Lowering the Threshold below the default
value of 20 allows the baseline fit to ignore regions that are slow
changes of real signal peaks and not baseline drift.

* Rolling Ball - This algorithm simulates rolling a ball under the
valleys of the signal. The ball size determines how closely the
baseline follows the signal. A larger ball size creates a smoother
baseline. Time Diameter specifies the size of the ball in the X
direction. Signal Diameter specifies the size of the ball in the Y
direction.

High Size
Filtering

If selected, a second, larger filter is applied to the data after the
specified time. This is useful for assays where the peaks are narrow
at the start of the assay and become broad and noisy for larger sizes
of DNA. If not selected, the same size filter is used for all data.

+ Filter Width (min) - The width of the second filter to be applied
after the specified transition time. Filter Width must be greater than
the Sample Channel Filter width and less than or equal to 3.0
minutes.

* Transition Time (min) - The time at which to transition to the
larger filter size. Transition time must be greater than the Baseline
Time on the Analysis tab and less than the Channel End time.

Table 2. Channel Peak Find Settings

Channel
Settings

Function

Channel

Displays the channel being edited. Select any channel or ladder on
the chip.

Ladder

Read only. Displays the ladder used for aligning this channel.

Minimum
Peak Height

Specifies an override to the Peak Find Settings for Minimum Peak
Height for the entire chip. Specify a valid numeric value to override,
or clear the field to reset to the Global setting.
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Table 2. Channel Peak Find Settings

Channel
Settings Function
Minimum Specifies an override to the Peak Find Setting for Minimum Peak
Peak Width | Width for the entire chip. Specify a valid numeric value to override, or
clear the field to reset to the Global setting.
Slope Specifies an override to the Peak Find Setting for Slope threshold for
Threshold the entire chip. Specify a valid numeric value to override, or clear the
field to reset to the Global setting.
Use Chip Sets Min Peak Height, Min Peak Width, and Slope Threshold text
Value button | boxes to <Uses chip value> settings.
Apply Apply channel-specific peak find settings only to the channel or
Channel/ ladder showing in the Channel field.
Ladder
button
Apply Chip | Apply channel-specific peak find settings to all channels on the same
button chip.
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Expected Fragments Tab

Use the Expected Fragments tab on the Method Window to enter
Expected Fragments for DNA assays. (See “Using Expected
Fragments” on page 48 for more information.) After the data is
analyzed, any peaks matching the expected fragments are shown in
the Peak Table View, Channel Table View, Gel View, and Graph
View (if Type is selected as an Annotation in the Graph View
Properties).

Figure 55. Method Window - Expected Fragments Tab

The Expected Fragments tab contains the following options and
buttons:

Expected Fragments Table - Lists the expected fragments for the
method.
+ Size - Specifies the expected size of the fragment in BP.

*  Window (%) - Specifies the tolerance window as a percent of
the expected size for the fragment to allow for small variations in
expected fragment size.

+ Color - Displays the color to use to mark the fragment in the
Graph View or the Gel View.
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Expected Fragments Tab (Continued)

* Name - Specifies a name to display in the Type description for
the fragment.

* Property Displayed in Channel Table - Specifies the content
of a column added to the channel table for each expected
fragment.

* Apply to Channels - Specifies the channels that the expected
fragment is applied to. <All> specifies that the expected
fragment applies to all channels. Clicking on the column opens
the Select Channels window to choose the specific Channels to
apply the expected fragment to.

Export button - Opens the Export Expected Fragments window to
create an Expected Fragments File (.gep) from the current settings
in the tab. Import the .gep file into another method to use the same
expected fragments in another method.

Restore button - Restores the settings to the last saved settings
for expected peaks.

Import button - Opens the Import Expected Fragments Table
window to select an Expected Fragments File (.gep) to import. The
.gep file is created by exporting expected fragments from another
method.

Clear button - Deletes all Expected Fragments from the table.
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Excluded Fragments Tab

Use the Excluded Fragments tab on the Method Window to enter
Excluded Fragments for DNA assays. After the data is analyzed,
any peaks matching the excluded fragments are excluded from the
analysis.

s o» am =
Figure 56. Method Window - Excluded Peaks Tab

The Excluded Fragments tab contains the following options and
buttons:

Excluded Fragments Table - Lists the excluded fragments for the
method.

+ Size - Specifies the size of the excluded fragments in BP.

*  Window (%) - Specifies the tolerance window as a percent of
the size of the fragment to allow for small variations in fragment
size.

+ Color - Displays the color to use to mark the fragment in the
Graph View or the Gel View.

+ Name - Specifies a name to display in the Type description for
the fragment.

+ Exclude All - If selected, all fragments in the specified range
are excluded from analysis.

+ Apply to Channels- Specifies the channels that the excluded
fragment is applied to. <All> specifies that the excluded
fragment applies to all channels. Clicking on the column opens
the Select Channels window to choose the specific channels to
apply the excluded fragment to.
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Excluded Fragments Tab (Continued)

Export button - Opens the Export Excluded Fragments window to
create an Expected Fragments File (.gep) from the current settings
in the tab. Import the .gep file into another method to use the same
excluded fragments in another method.

Restore button - Restores the settings to the last saved settings
for excluded fragments.

Import button - Opens the Import Excluded Peaks window to
select an Expected Fragments File (.gep) to import. The .gep file is
created by exporting excluded fragments from another method.

Clear button - Deletes all Excluded Fragments from the table.
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Smear Analysis Tab

Use the Smear Analysis tab on the Method Window to view the
portion of the sample that was routed to the collection well on the
chip as a Smear. Use the Smear Analysis tab on the Method Editor
window to define smears before the method runs. (Defining a smear
does not cause the region to be extracted, it is only marked on the
display.) After the run, the area matching the smear is shown in the
Channel Table View, Gel View (if Show EPs and Smears is selected
in the Gel View Properties), and Graph View (if Show Smears is
selected in the Graph View Properties). To view the smears for the
open chip data file, select Analysis > Analysis Settings on the
main menu.
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Figure 57. Method Window - Smear Tab
The Smear Analysis tab contains the following options and buttons:

Smear Table - Lists the smears for the chip.

» Start Size - Specifies the starting size of the area to be included
in the smear.

* End Size - Specifies the ending size of the area to be included
in the smear.

» Color - Displays the color to use to mark the smear in the Graph
View or the Gel View.

* Name - Specifies a name to display in the Channel Table View.
The smear name corresponds to the smear range and channel
number.

* Property Displayed in Channel Table - Specifies the content
of a column added to the Channel Table for each smear.
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Smear Analysis Tab (Continued)

* Apply to Channels - In the Method window, specifies the
channel in which the extraction took place. In the Method Editor
window, specifies the channels that the smear is applied to.
<All> specifies that the smear applies to all channels. Clicking
on the column opens the Select Channels window to choose the
specific channels to apply the smear to.

Export button - Opens the Export Smear Analysis Table window to
create a Smear Analysis Export File (.sma) from the current settings
in the tab. Import the .sma file into another assay to use the same
smear in another assay.

Restore button - Restores the settings to the last saved settings
for smears.

Import button - Opens the Import Smear Analysis Table window to
select an Smear Analysis Import File (.sma) to import. The .sma file
is created by exporting smears from another assay.

Clear button - Deletes all smears from the table.
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Advanced Tab

Use the Advanced tab on the Method Window to view the
quantification marker settings or change the Peak Size Calibration
point.
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Figure 58. Method Window - Advanced Tab

Quantification

Determines whether the lower marker or a sample peak is used for
quantitation. Selecting Sample Peak uses the peak size and
concentration of the User Standard instead of the default ladder
settings.

Peak Integration Mode
Specifies the mode for determining the baseline.

* Peak Baseline - A global peak baseline is used as the baseline
for all peaks. This baseline is determined by stitching together
regions of low variance across the data signal.

* Valley to Valley - Each peak is assigned a baseline by drawing
a line that joins the start and end of the peak at the data signal
values.

Smear Baseline Mode

Specifies the Smear Baseline option to use for all smears. See
“Smear Baseline” on page 255 for more details on each option. This
option only displays if smears are defined in the Smear Analysis
Tab.

« Two Point - If selected, a Two Point baseline from the start of
the trace to the end of the trace is used as the baseline.

+ Peak Baseline - If selected, the local peak baseline is used as
the start and end of the smear baseline.
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Advanced Tab (Continued)

Marker Find

» Marker Drift Tolerance - Specifies the time within which to find
the marker peak, specified as a percent of the marker migration
time. Range is 1 to 100%. Peaks within the range are weighted
based on the difference from the ladder time. The weight of
peaks farther from the marker migration time decreases faster
as the marker drift tolerance is made smaller.

Enable Saturation Detection - If selected (default), the software
detects if the optics are saturated with a signal that is too high and
approximates the signal with a flat straight line connecting the start
of the saturated region to the end the saturated region.

High Concentration Size Correction

A correction factor that can be applied if the sample concentration
is higher than the ladder concentration. This correction adjusts for
higher mobility of sample fragments when the sample concentration
is higher than the ladder concentration. If selected, the correction
value is used when computing the collection start and end times.
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Modify Run Settings Window

Use the Modify Run Settings window to change settings for the
method while the run is paused. To open the Run Settings, click the
Pause/Stop button on the instrument icon while a method is running

(see “Run Status and Chip Info” on page 109).
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Figure 59. XT Modify Run Settings Window

Only the settings on the Setup Tab and User Info Tab can be edited
while the run is paused. Some settings cannot be changed while the
run is paused:

The Operation for a channel cannot be changed.
Multistep Cut settings cannot be changed.

Steps can be deleted if they have not been executed yet.
Editing a completed step has no effect and is ignored.

Editing the running step is blocked with a message indicating
that the change was ignored.

Inserting a new Collect on Click step before a running Collect on
Click step does not change running step, but the old step
becomes the next step and executes after the running step.

Deleting the last running step is ignored.

The options available on each tab are the same options available in
the Start Fractionation Window. See page 186 for details.
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New Collection Window

The New Collection window is used to create a new collection using
either a Template, a Blank Collection (default), or the Current
Collection. This option is only available in the LabChip XT software.

To open the New Collection window, select Collection > New
Collection on the LabChip XT/XTe Main Window.
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Figure 60. New Collection Window
The following options are available:

Template - Opens a blank collection and then applies the selected
collection template.

Blank Collection - Opens a blank collection that does not contain
any data. The new collection will use the same settings as the last
saved collection of the same assay type.
The current collection settings are automatically saved in a blank
collection template in the current user’s “Documents and Settings”
folder on the local computer. These preferences are applied when a
blank collection is created.

Current Collection - Opens a blank collection and applies the
settings from the currently open collection as a template.

Assay Type - The LabChip XT/XTe only supports DNA assays.

Name - Specifies the name of the new collection.
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Perform Signature Window

Use the Perform Signature Window to add an electronic signature
to a data file. Signatures can be added as required by the
company’s standard operating procedures. (Data files cannot be
signed while the assay is running.) If multiple data files are open in
the workspace, only one data file can be signed at a time. (Only
available if the 21 CFR Part 11 Security option is installed.)

To open the Perform Signature Window, select Security >
Perform Signature on the LabChip XT/XTe Main Window.
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Figure 61. Perform Signature Window

The Perform Signature Window contains the following options:

Data File Name

Displays the name of the data file being signed.

Username

Select the username of the user that is signing the data file.

Role

Displays the Access Level of the selected LabChip XT user.

Enter Comment

Details on why the signature is being performed and what actions
have taken place. It is the signer’s responsibility to ensure all
details required by the company’s procedures are included in this
comment.

Approval State

Displays the approval state of the data file. Unreviewed data files
cannot be locked.

Lock

Select the check box to prevent any future changes to the data file.
Locked data files cannot be saved. To unlock the data file, a user
with the correct permissions can choose Security - Unlock Data
File.

User Password

The password for the user.

Sign button

Signs the data file and closes the window.

Cancel button

Closes the window without signing the data file.
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Print Window

Use the Print window to print information from the currently open
workspace. If the workspace contains multiple collections,
information from the active (selected) collection is printed. To open
the Print window, select File - Print on the LabChip XT/XTe Main
Window.
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Figure 62. Print Window

The Print window provides the following options for printing:
» Print All - Selects all of the options.

* Gel - Prints a graphic of the gel for either all channels in the
collection or all selected channels.

» Electropherogram - Prints a graph of either all channels in the
collection or all selected channels.

* Overlay Electropherogram - Prints a graphic of all
electropherograms (either all selected or all in the collection)
over-laid onto the same graph.

* Channel Table - Prints the channel table for either all channels
in the collection or all selected channels. The columns selected
for view in the Channel Table are printed. Changing the columns
selected to view in the Channel Table View changes the
columns that are printed.

* Peak Table - Prints the peak table for all channels in the
collection or all selected channels. The columns selected for
view in the peak table are printed. Changing the columns
selected to view in the Peak Table View changes the columns
that are printed.

* Exclude Marker - If selected, markers are not printed.
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Print Window (Continued)

Page Option - Select the page orientation, either Portrait or
Landscape.

Channel Option - Select the channels to be included in the
printout, either Entire Collection or Selected Channels.

Add Border Option - If selected, the Channel Table and Peak
Table will print with a border between each column and a border
below the column header.

Add Channel Name as Header - If selected, a channel header,
containing the chip name, channel name, and sample name is
printed before each set of peaks in a channel. (This option is only
available if Peak Table is selected.)

Column Header - Specifies where to print the column headers,
which identify each column in the Peak Table. (This option is only
available if Peak Table is selected and Channel Table and
Electropherogram are not selected.)

+ Per Page - the column header is printed only at the top of each
page.

* Per Channel - the column header is printed at the top of each
page and at the start of each new channel.

Run Report - Generates a one page report of the selected data file.
The report includes gel and graph views of the data, Method Info,
and the contents of the Channel Table. This option is only available
in the LabChip XT software.

+ Add Border- If selected, borders are printed for the tables in
the Method Info and Channel Table sections.

Preview button - Displays a preview of the selected options.

Print to PDF button - Prints the selected information from the
active collection to a pdf file.

Print button - Prints the selected information from the active
collection to the default Windows printer.

Cancel button - Closes the Print window without printing.
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Print Validation Reports Window

Use the Print Validation Reports Window to print the results after
performing Installation Qualification (1Q) or Operational
Qualification (0OQ). OQ is performed in the System Diagnostics
Window.

To open the Print Validation Reports Window, select Validation >
Reports on the LabChip XT/XTe Main Window.
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Figure 63. Print Validation Reports Window

The Print Validation Reports Window contains:

Option/Button

Function

Diagnostics Report

If selected, the results of Hardware OQ tests are printed.

Software 1Q Report

If selected, the results of Software IQ tests are printed.

Failed Tests Only

If selected, only tests that have failed are printed. If not
selected, both passed and failed tests are printed.

Report Period

Specifies the dates when the tests were run. Tests performed
between the From and To dates (inclusive) are printed.

Print Preview
button

Displays a preview of the report and enables you to print or
export the results.

Print button

Opens the Print window to print the report.

Close button

Closes the window.
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Rename Collection Window

Use the Rename Collection window in the LabChip XT software to
rename the currently selected collection. The collection name
displays on the Collection tab at the top of the LabChip XT/XTe
Main Window. To open the Rename Collection window, select
Collection > Rename Collection on the LabChip XT/XTe Main
Window.
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Figure 64. Rename Collection Window

Name - Type the desired name for the selected collection.
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Run File Editor Window

Use the Run File Editor window to create run files (*.xml) to import
run settings into the Start Fractionation Window. The run file
contains all of the run settings that would be specified in the Start
Fractionation Window. Using a run file enables you to quickly
specify the settings for the run after the chip has been prepared. To
open the Run File Editor window, choose Tools - Run File Editor
on the LabChip XT/XTe Main Window.
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Figure 65. XTe Run File Editor Window

The tabs on the Run File Editor contain the same options as the
tabs on the Start Fractionation window. See Start Fractionation
Window for definitions of specific options or settings. The following
buttons are located at the bottom of the Run File Editor window:

Button |Description
Save Saves the selected settings in a run file with the specified name (*.xml).
Review | Opens the Fractionation Setup Review window to view the settings for the
Setup current run.
Import Opens the Import Sample Names window to select the desired Sample
Names | Name File (.csv). (LabChip XT only.)
Import Imports the settings from an existing run file (*.xml) into the Run File
Setup Editor window.
Close Closes the Run File Editor window without saving the settings.
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Run Info Window

Use the Run Info window to view information about the run options
for the selected chip data file.

To open the Run Info window, select View = Run Info on the
LabChip XT/XTe Main Window, or right-click on the name of the
data file above the chip diagram and select Run Info.
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Figure 66. Run Info Window
The information in this window is view-only and cannot be changed.
The Run Info Tab displays method and run information.

The Event Log tab displays the events that occurred during the
run.

The Run Info window contains the following buttons:

Print Opens the Print Preview window to view the run information before
Preview printing.

Print Opens the Print window to print the run information.

Close Closes the Run Info window.
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Run Info Tab

The Run Info tab on the Run Info Window displays information
about the method and the run.

The Channel Info table at the bottom of the window contains the

following information:

Column

Description

Ch

The number of the channel.

Sample Name

The name of the channel/sample.

St

The step number of the channel. Each step
creates one row in the table.

Operation

The Operation mode selected for the step.

Extraction Mode

The Extraction mode selected for the step.

Start

The start of the Size Range or Search
Region set in the method.

End The end of the Size Range or Search Region
set in the method.

Size The actual center size of the extracted or
excluded region. Displays O until the step is
complete.

Range The actual range of the extracted or
excluded region. Displays 0 until the step is
complete.

Threshold The Threshold set in the method (for
Fluorescence, Peak Start, Peak Max, and
Smear Max).

Width The collection width set in the method (for

Fluorescence, Peak Start, Peak Max, Collect
on Click, and Smear Max).
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Save Workspace File As Window

The Save Workspace File As window saves the currently open
workspace with the specified name in the specified location. This
window is only available in the LabChip XT software. The LabChip
XTe software does not support saving workspace files.

To open this window, choose File > Save Workspace As. This
window also opens the first time you save a new workspace.

fave Workngace Fis Ay "

[ = LabCugaT + DemeData s [ = B! 5]

vy iztim * W

p H Sy v

Figure 67. Save Workspace As Window

Tip: You may want to save the workspace file in the same location
as the chip data files to prevent missing chip data files when moving
workspace files.
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Select a Data File Window

When you choose Import Data File from the File Menu, the Select
a Data File window opens as shown in Figure 68. (If the 21 CFR
Part 11 option is installed, the CDR Manager Window opens.) Data
files generated by the LabChip XT software have an .xtd file
extension. Data files generated by the LabChip XTe software have
an .xte file extension. The LabChip XT software can only open XT
data files, and LabChip XTe software can only open XTe data files.
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Figure 68. Select A Data File Window

Select a data file name in the list box and click the Open button or
double-click a file name to open the data file.

To select multiple files, press and hold CTRL then click each file
name. To select a continuous block of files, click the first file, press
and hold SHIFT, and then click the last file. To select all files, press
CTRL+A.
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Software Installation Qualification Window

Use the Software Installation Qualification Window to perform the
IQ test. The IQ test verifies proper installation of the LabChip
XT/XTe software and verifies no unauthorized changes have been
made to the software. To open the Installation Qualification Window,
select Validation > Software 1Q on the LabChip XT/XTe Main
Window.
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Figure 69. Software Installation Qualification Window

The Software Installation Qualification Window contains the
following information:

Application Verifies that the LabChip XT/XTe Registry Entries exist. If all

Information expected registry entries are found, displays Passed. If any
problems are found, displays Failed.

Directory Verifies that all folders exist. If all expected folders exist, displays

Structure Passed. If any folders are not found, displays Failed.

Files Verifies that all files that were installed by the LabChip XT/XTe
software still exist. If all files exist, displays Passed. If any files are
not found, displays Failed.

Summary Displays Passed if all tests passed. Displays Failed if any of the
1Q tests failed.

Progress Displays a progress bar while the 1Q test is running.

Previous Result
button

Displays the results of the last 1Q that was completed. (Only
available before another 1Q test is run.)

Save As button

Saves the results of the IQ in an .xml file.

Start 1Q button

Begins running the 1Q.

Close button

Closes the Installation Qualification Window.
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Start Fractionation Window

The Start Fractionation window specifies the method to run, the
collection settings for each channel, the user name, auto export
settings, and import options for sample names and expected peaks.
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Figure 70. XTe Start Fractionation Window

The Start Fractionation window opens when you click the Run
button on the LabChip XT instrument graphic. (If a workspace is
open in the LabChip XT software, you are prompted to save the
workspace before the Start Fractionation window opens.) To begin
the run, select the desired settings on each tab and then click the
Start button.

The Start Fractionation Window contains the following tabs:

Setup Tab

Buffer Utilization Tab
User Info Tab

Sizing Table Tab
Output Tab
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Start Fractionation Window (Continued)

The following buttons are located at the bottom of the Start
Fractionation window:

Button |Description

Start Starts the run using the options specified in the tabs on the Start
Fractionation window.

Test Performs the same chip test that automatically runs at the beginning of

Chip every run. The chip must be properly filled with buffer, but do not load
any sample DNA prior to running the test. Only run the chip test
separately if directed by Caliper Technical Support.

Review | Opens the Fractionation Setup Review window to view the settings for

Setup the current run.

Import Opens the Import Sample Names window to select the desired Sample

Names | Name File (.csv). (LabChip XT only.)

Import Imports the settings from a run file (*.xml) into the Start Fractionation

Setup window. (Use the Run File Editor Window or export the desired settings
to create a run file.)

Export Exports the settings from the Start Fractionation window into a Run file

Setup (*.xml).

Cancel |Closes the Start Fractionation window without saving any changes and
without starting the run.

V2.1 LabChip XT/XTe User Manual Caliper Life Sciences, Inc.



Software Reference 188

Setup Tab

The Setup Tab in the Start Fractionation Window specifies the
operation, the extraction mode, the extraction or search region, the
threshold, and/or the collection width for each channel. Some
Operations allow additional extraction steps to be added to the
same channel to support extracting multiple ranges of material from

the same channel.

For Extraction Modes that are centered on the trigger point (% for
any mode except Size Range, or Manual Width for Peak Max and
Smear Max), the distance on the chip between the detection point
and the switch point provides time to divert the sample to the
collection well, as long as the collection width is not too large.
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Figure 71. Setup Tab

The Setup tab contains the following options and settings for each

of the four channels

on the chip:

Sample name - Displays the name of the sample in the channel. To
change the name, type the desired name in the text box.

Channel Number - Displays the number of the channel on the chip.
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Setup Tab (Continued)

New Step button - Adds another step to the channel to create a
multistep extraction. Use the up and down arrow buttons to display
each step. If you want the run to pause after an extraction to enable
you to remove the extracted sample from the collection well, select
the eXtract and Pause operation. Click the small gray X button
above the step number to delete that step from the channel.

Step - Displays the selected step in a multi-step extraction. Click
the up or down arrows to display the settings for the desired step.
Use the New Step button to add steps.

Buffer Utilization - Displays an icon that represents the buffer use
for the currently selected channel options.

Operation - Specifies the action for each channel as described
below. Click on the channel icon to choose the desired operation for
each channel.

+ Disabled - The channel is not used in the run. Any channel that
has already been used is automatically set to Disabled and
cannot be reused.

* Ladder - The channel contains a sizing ladder that is used to
calculate the sizes in the samples in the remaining three
channels during the run. Only one channel in the chip can be
designated as a ladder channel.

» eXtract and Stop - The sample in the channel runs until the
extraction is complete and then the voltage to the channel turns
off. After the extraction, the run ends if no other channels are
busy. If channels are busy, the run ends as soon as all channels
are complete. The extracted material is located in the Collection
well. (Only the Flush Sample step can follow this step.)

+ eXtract and Continue - The sample in the channel runs until
the end of the chip range. The sample specified by the
Extraction Mode is collected in the Collection well. In a multistep
extraction, the next step begins after the extracted region is
removed from the collection well (the instrument lid must be
opened).

+ eXcLuDe Region - The sample in the channel is collected in the
Waste well except for the sample specified by the Extraction
Mode, which moves into the Collection well. The sample minus
the excluded region is located in the Waste well. The sample in
the channel runs until the end of the chip range. In a multistep
extraction, the next step begins immediately after the excluded
region is complete. Only available in the LabChip XT software.
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Setup Tab (Continued)

Separation - The entire sample in the channel moves into the
Waste well. The channel runs until the end of the chip range.
Only available in the LabChip XT software.

eXtract and Pause - The sample in the channel runs until the
extraction is complete. When the extraction is complete, the run
immediately pauses so the desired extracted sample can be
removed from the Collection well. The method can also be
edited while the run is paused. In a multistep extraction, the next
step begins when the run is resumed.

Skip Extraction - Skips over a known region in the sample
without extracting any sample to the Collection well.
Automatically moves to the next step in a multistep extraction
immediately after the skipped region is complete. Only available
in the LabChip XT software.

Flush Sample - The remaining sample in the channel moves
into the waste well. If preceded by an extraction step, execution
of this step only begins after the run has been paused and the
instrument lid has been opened to remove the extracted
material from the Collection well. Using a Collect and Stop step
ensures that the collected material is not drawn out of the
collection well while other channels are completing their
extractions. The Flush Sample step after a Collect and Stop step
moves the remaining sample to the waste well. Flush Sample
must be the last step in the channel and can be preceded by
any of the Extraction operations except the Ladder, Separation,
or Exclude Region steps.

Extraction Mode - Specifies how the range of material to be
collected is selected. The range of material extracted depends on
both the Extraction Mode and the Collection Width.

L]

Size: The size range specified in the Extraction Region text
boxes is diverted to the Collection well. Size range can be
specified as a Size +/- a percent of the size, or as a specific
start and end size in the Extraction Region text boxes.

Trigger - The software searches for the specified trigger point
within the specified Search Region.

Auto MultiStep Cut - If selected, an extraction range larger than
the assay Maximum Extraction Width can be entered for an
extraction. The extraction is automatically split into multiple eXtract
and Pause steps. To view the MultiStep Cut steps, click the Review
Setup button on the bottom of the Start Fractionation window. Only
available if Extraction Mode is Size and Operation is eXtract and
Stop, eXtract and Continue, or eXtract and Pause.
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Setup Tab (Continued)

Trigger Extraction Modes:

Peak Start: Specifies a slope Threshold, in RFU/minute, to use
to detect the start of a peak within the specified Search Region.
The trigger point for collection is the point where the slope is
greater than the specified threshold. Collection ends when the
sample specified by the Collection Width has been collected.

Collect on Click: Collects the region displayed in green on the
Graph View when you click the Start Now button. To start the
extraction, click on the word CLICK next to the channel number
in the LabChip XT/XTe Main Window. The Fractionation
Pending Window opens. Click the Start Now button when the
desired region is displayed in green. (Clicking the Cancel button
closes the window and allows you to choose a region later in the
run.) The collection region displays in red as the collection is
occurring. Note that for some width settings, the target region
may extend beyond the last visible data point on the graph. In
this case, the highlighted region ends at the last visible data
point and the dialog box indicates the time when the target
region ends. When manual mode is selected in the width
setting, click on the word STOP in the Run Setup section to end
the collection or exclusion.

Fluorescence: Specifies an RFU Threshold which must be
exceeded within the specified Search Region. The trigger point
for collection is the point where the RFU value exceeds the
specified threshold. Collection ends when the sample specified
by the Collection Width has been collected. This option is only
available in the LabChip XT software.

Peak Max: Specifies that the trigger point for the extraction is
the first point found within the specified Search Region where
the signal slope is at or above the specified threshold (RFU/min)
and the signal has switched to a negative slope that is above
the specified threshold. If no local maximum is found by the end
of the specified search region and the signal is increasing, the
extraction trigger point is at the end of the search region. If the
signal has a large negative slope at the beginning of the search
region, the extraction will not trigger until after the slope has
again turned positive and exceeded the slope threshold. When
the software detects the peak maximum in the search region,
the collection start size is calculated based on the collection
width. The actual collection range achieved is reported in the
Channel Table. This option is only available in the LabChip XT
software.
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Setup Tab (Continued)

+ Smear Max: Specifies that the trigger point for the extraction is
the first point found in the specified Search Region where the
signal is at or above the specified Threshold (RFU) and the
signal decreases after averaging over three consecutive data
points. Collection will trigger at the end of the search region if
the signal threshold value has been exceeded but the signal has
yet to start decreasing. Collection ends when the sample
specified by the Collection Width has been collected.This option
is only available in the LabChip XT software.

Collection Width - Specifies the range that will be collected based
on the trigger point specified by the Extraction Mode.

* % - Specifies the Collection Width as a percent of the size at
which the extraction is triggered. The extracted range is
centered at the trigger point, and the collection width is from
(size - %) to (size + %). Half of the collection range occurs
before the trigger point, so depending upon the migration time of
the fragment, it is possible that the specified start of the
collection range may have already passed the point at which the
sample is diverted into the collection well. If this occurs, the
extraction is started immediately and the extraction range shifts
forward to meet the specified collection width.

* BP - Specifies the number of base pairs (BP) to collect. For
Fluorescence, Peak Start, and Collect on Click, the collection
starts at the specified trigger point in the Extraction Mode and
collects the specified number of base pairs from the trigger point
forward. For Peak Max and Smear Max, the collection range
collects the specified number of base pairs centered on the
trigger point.

* Manual - For Peak Start, Collect on Click, and Fluorescence,
the collection begins at the trigger point and ends when the user
clicks STOP in the Run Setup. For Peak Max and Smear Max,
collection begins at the specified percent before the trigger point
(size - %) and immediately ends when the user clicks STOP in
the Run Setup. (The collection stops at the end of the red smear
region on the Graph View, not where the graph ends.) If the
user has not stopped the extraction when the end of the search
region has been reached, the extraction will end automatically
there.

The size collected is displayed in the Run Setup area, Channel
Table View, and the red smear region on the Graph View.
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Setup Tab (Continued)

Slider - If the Extraction Mode is Size, the blue marker indicates
the size of DNA to collect in the collection well of the chip. Move the
slider left or right to select the desired size to collect. The setting in
the Size text box changes to reflect the position of the slider.

Copy button - Copies the current settings of a channel so the
settings can be pasted into another channel.

Paste button - Pastes the last copied channel settings to a
channel.
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Buffer Utilization Tab

Use the Buffer Utilization tab on the Start Fractionation Window to
view estimates of the buffer use for each channel during the run.
The buffer use is estimated based on the current selections in the
Start Fractionation window. The run can be started even if the run is
over the buffer limit, but be aware that if the buffer capacity runs
out, the current will drop and the DNA will not continue to migrate
into the collection well.
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Figure 72. Start Fractionation Window - Buffer Utilization Tab
The Buffer Utilization tab displays the following information:
Channel - Displays channel numbers 1 through 4.

Estimated Extraction Time - Displays an estimated range of time
required to perform the extraction in each channel.

Status - Displays an icon indicating whether the buffer is estimated
to be exhausted during the run:

Icon | Type Description
@ OK Buffer is estimated to be sufficient for the
channel.

Warning | Buffer may be exhausted if the extraction occurs
A\ at the end of the run.
p Error Extraction may occur after the buffer has been
Qo exhausted.

Unknown | An estimate cannot be made whether the buffer
@ is sufficient. Usually occurs with a Collect on

Click extraction or a manual endpoint.
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User Info Tab

The User Info Tab in the Start Fractionation Window specifies the
operator name and any comments added to the run.
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Figure 73. User Info Tab
The User Info tab contains the following settings:

Operator - Type the name of the operator performing the run. If the
21 CFR Security option is installed, the user name of the logged in
user is automatically entered and cannot be edited.

Comment - Type comments that are saved in the data file for the
run.
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Sizing Table Tab

The Sizing Table Tab in the Start Fractionation Window, specifies
the ladder to use when aligning all the sample channels on the chip.
This tab is not available in the LabChip XTe software.

[Setup | Buffer Wiizptior | User o [ Sising Table | Output
——  Ladder Sizes Table

¥ you choose to run a ladder and i uae & lndder sther
than the standard ladider suppled by Caliper, you must
chacss the Custom laddar oplion and supgly the sres
of your laddar paals hem

|

%4 Method Ladder

EERHdEEEEEE N

=4

Figure 74. Sizing Table Tab
The Sizing Table Tab contains the following settings:

Method Ladder - If selected, the default Caliper-supplied ladder is
used to align the samples during the run.

Custom Ladder - If selected, the custom ladder sizes in the Size
Table are used to align the samples with a custom ladder during the
run instead of the ladder supplied by Caliper. This option can be
used to improve sizing in the fragment size range of interest. Select
the Custom Ladder option and specify the fragment sizes for the
custom ladder in the Size Table. Since the custom ladder fragments
will also be used to establish the relationship between area and
concentration, each fragment should be supplied at the same
concentration, nominally 2 ng/ul, to match the Caliper ladder. If an
alternate concentration is used, enter the concentration in the
Ladder Concentration parameter in the Analysis properties of the
method. Using custom ladder fragments of unequal concentration is
not currently supported. A ladder with unequal concentrations can
be used but the displayed sample concentrations will be inaccurate.

Copy Table from Method - Imports the ladder from the selected
method in the currently open workspace.
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Output Tab

The Output tab on the Start Fractionation Window specifies the
location, name, and export settings for chip data files created during
the run. LabChip XT software data files are *.xtd. LabChip XTe data
files are *.xte. LabChip XTe software does not support exporting
analyzed data.

The data file name can include a specific prefix, the computer
name, a project name, the Chip ID (LabChip XT only), the date, and
the time. For example, including the prefix LabChip_XT, the date,
and the time would create file names such as LabChip_XT_2011-
04-24_10-23-48.

If you choose not to use the time of the run as part of the data file
name, the LabChip XT and XTe software automatically appends _1,
_2, etc., for each subsequent run on the same day.
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Figure 75. Start Fractionation W.indow - Output Tab

Data Path - Specifies the location where the data files will be
saved. Click the Default button to reset the text box to the default
directory.

21 CFR Part 11 option not installed: The default location is
C:\Program Files\Caliper Life Sciences\LabChip XT\Data\. Click the
Browse button to choose a different location.

21 CFR Part 11 option installed: The default location is
C:\Program Files\Caliper Life Sciences\CDR\. Click the Browse
button to choose a folder in the CDR.
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Output Tab (Continued)

NOTE
|

-

Data files should be saved to a local folder on the computer's hard
drive. Saving data files to a network drive may cause loss of data if
the network connection is slow or interrupted.

Create Daily Sub-Directory check box - If selected, a new
directory is created each day in the specified Data Path, and all of
the data files from that day are saved in the directory. The directory
name is the current date, and the format is YYYY-MM-DD, where
YYYY is the year, MM is the month, and DD is the day.

Copy To - If selected, the data file is copied to the specified folder
after the run is complete.

File Prefix - Specifies the text for the first characters of the data file
name.

Computer Name - If selected, adds the name of the LabChip XT
computer to the data file names.

Project Name - The text is added to the data file names.

Chip ID - If selected, adds the Chip ID to the data file names. The
Chip ID is read from the barcode on the chip. (LabChip XT only.)

Date check box - If selected, the current date is included in the
data file name. The date format is YYYY-MM-DD, where YYYY is
the year, MM is the month, and DD is the day. The date is
automatically added to the data file name when the 21 CFR Part 11
option is installed.

Time check box - If selected, the time that the run was started is
included in the data file name. The time format is HH-MM-SS,
where HH is the hour (0 to 24), MM is the minutes, and SS is the
seconds. The time is automatically added to the data file name
when the 21 CFR Part 11 option is installed.

File Name Example text box - Read-Only text box that displays
the selected format for the data file name.

Automatic Export - If selected, data is automatically exported at
the end of each run. Select the type of data to export by clicking the
Settings button and choosing the desired settings in the Export
Window. For more information, see Exporting Data. (This option is
not available in the LabChip XTe software.)
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System Diagnostics Window

Use the System Diagnostics window to run the diagnostics tests on
the LabChip XT/XTe instrument. All tests should be run periodically
to verify proper operation of the instrument. To verify proper
operation of a particular function, you can select specific tests to
run. To open the System Diagnostics window, select Validation >
Diagnostics.
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Figure 76. System Diagnostics Window
(The Barcode Reader test is not shown in Figure 76.)

The left side of the window displays the tests to run on the
instrument. Expand each section to view all of the tests in each
section. Tests selected with a check mark will run. To skip a test,
click on the check box to clear the selection. Click on a section
check box to select or clear all of the tests in the section. See
“Description of Diagnostic Tests” on page 230 for a description of
each test.

V2.1

LabChip XT/XTe User Manual Caliper Life Sciences, Inc.



Software Reference 200

System Di

agnostics Window (Continued)

The right side of the window displays the results of the tests. The
icon color indicates the status of each test:

* Blue - The test is in progress.

* Yellow - The test was skipped.

* Green - The test passed.

* Red - The test failed or was aborted.

The bottom of the window displays a progress bar for the entire set

of selected tests and a separate progress bar for the test that is
currently running.

After all tests are complete, the Test Report Generation section at
the bottom of the right side of the window displays the date and time
when the test report was created, the name of the test report (*.l0g),
and the location where the test report was saved. Test report files
can be opened with a text editor such as Windows Notepad.

Option/Button

Function

Run Tests button

Runs the selected tests. The Test Report Generation section
displays.

Abort button

Stops running the diagnostic tests.

Limits Report
button

Generates a report that contains the limits (upper and lower)
for each selected test. Displays date/time, File name (*.Imt)
and location of report file.

Print Summary
button

Prints the summary of the report to the default Windows
printer. This button is disabled after running the Limits Report.

Print button

Prints the details of the tests to the default Windows printer.

Close button

Closes the System Diagnostics window.
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Unlock Application Window

For LabChip XT software with the 21 CFR Part 11 Security option
installed, use the Unlock Application Window to access the LabChip
XT software after it automatically locks. This window displays on top
of the LabChip XT software when the software is locked. The
automatic lock option is set in the Set Policies tab on the User
Administration Window. This window only displays if the 21 CFR
Part 11 option is installed.

The 21 CFR Part 11 Security option is not available for the LabChip
XTe software.
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Figure 77. Unlock Application Window

The Unlock Application Window contains:

Option/Button Function

Username Type the user name of the current user or a LabChip XT
administrator’s user name.

Password Type the password for the specified user name.

OK button Verifies the username and password and opens the LabChip
XT software if the username and password are correct.
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Unlock Data File Window

For LabChip XT software with the 21 CFR Part 11 Security option
installed, use the Unlock Data File window to unlock a data file. The
user name must have the appropriate permissions.

The 21 CFR Part 11 Security option is not available for the LabChip
XTe software.
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Figure 78. Unlock Application Window

The Unlock Data File Window contains:

Option/Button

Function

Username Select the username of the user that is unlocking the data file.

Reason Type the reason that the data file is being unlocked. Follow
laboratory procedures for required information.

Password Type the password for the selected user name.

Unlock button

Verifies the username and password and unlocks the data file.
Locked data files cannot be saved.

Cancel button

Closes the Unlock Data File window without unlocking the
data file.
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User Administration Window

For LabChip XT software with the 21 CFR Part 11 Security option
installed, use the User Administration window to create new
LabChip XT users, to edit existing users, to view user information,
to activate or deactivate users, to set rights for each access level,
and to set LabChip XT software policies.

The 21 CFR Part 11 Security option is not available for the LabChip
XTe software.

To open the User Administration window, choose Security > User
and System Administration.

! Latilhap KT - Usan Admenaransn ﬁ

Sl 8 i

Olafros: Aocess + g S P Soraman o
Booect Pt -Lock data e

Sl Foiows Uridcach: St il

Figure 79. User Administration window

The User Administration window contains the following tabs:

* “Create New User” on page 204

+ “Edit Users” on page 205

*  “Show User Info” on page 206

*  “De/Activate User” on page 207

* “Define Access” on page 208

» “Set Policies” on page 209

Close button - Closes the User Administration window without

saving changes. Save the changes on each tab before closing the
window.
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Create New User

Use the Create New User tab on the User Administration Window to
add a new user name to the LabChip XT software. This window
creates the LabChip XT user account, it does not create a Windows
user account to log into the computer.
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Figure 80. User Administration Window - Create New User

The Create New User tab contains:

Option/Button Function

Username Type the user name that the new user will use to log into the
LabChip XT software.

First Name Type the first name of the user.

Middle Name Type the middle name or initial of the user.

Last Name Type the last name of the user.

Position If desired, type the job title of the user.

Access Level Choose the access level for the user. The access level

controls the user’s rights in the LabChip XT software (see
“Define Access” on page 208 to view the rights for each
access level). The following access levels are available:

* Restricted User
» Operator

« Supervisor

* Administrator
* Service

Password Type the desired password for the user. The password must
meet the password policies selected on the Set Policies tab.

Confirm Password | Repeat the desired password for the user.
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User Can Perform

If selected, the user can sign data files using the Perform

Signature Signature Window.
Accept/Reject/Lock | If selected, the user can accept, reject, and lock data files
Data File using the Perform Signature Window.

Unlock Data File

If selected, the user can unlock data files.

Edit Users

Use the Edit Users tab on the User Administration Window to edit
an existing LabChip XT user account.
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Figure 81. User Administration Window - Edit Users

The Edit Users tab contains:

Option/Button

Function

Select User to Edit

Select the Username for the account to edit.

First Name The first name of the user.

Middle Name The middle name or initial of the user.
Last Name The last name of the user.

Position If desired, the job title of the user.

Access Level

The Access Level of the user.

User Can Perform

If selected, the user can sign data files using the Perform

Signature Signature Window.

Accept/Reject/Lock | If selected, the user can accept, reject, and lock data files
Data File using the Perform Signature Window.
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Unlock Data File

If selected, the user can unlock data files.

Edit User Password

If selected, the user’s password can be changed.

Password

Type the desired password for the user. The password must
meet the password policies selected on the Set Policies tab.

Confirm Password

Repeat the desired password for the user.

Show User Info

Use the Show User Information tab on the User Administration
Window to view the account information for an existing username.
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Figure 82. User Administration Window - Show User Info

The Show User Info tab contains:

Option/Button

Function

Username Select the Username for the account to view.
Full Name The first, middle, and last name of the user.
Position The job title of the user.

Access Level

Displays the Access Level of the user.

Can Perform

Displays Yes if the user has rights to perform signatures using

Signature the Perform Signature Window. Displays No if the user does
not have rights.

Can Displays Yes if the user has rights to accept, reject, and lock

Accept/Reject/Lock | data files in the Perform Signature Window. Displays No if the

Data File user does not have rights.

Can Unlock Data
File

Displays Yes if the user has rights to unlock data files.
Displays No if the user does not have rights.

Account Created
On

Displays the date and time when the account was created.
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Account Last
Changed On

Displays the date and time when the account was last
changed.

Status

Displays Active if the user account is activated. Displays
Deactivated if the account has been deactivated.

Print All Users
check box

If selected, information for all user accounts will be printed.

Print Preview
button

Displays a preview of the printed report. The report can be
exported to a .rpt file from the Print Preview window.

Print button

Opens the Print window to print the report.

De/Activate User

Use the De/Activate User tab on the User Administration Window to
Deactivate an active user or to Activate a deactivated user. Users
cannot be deleted from the database. User names that will not be
used should be deactivated to prevent unauthorized access to the
LabChip XT software.
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Figure 83. User Administration Window - De/Activate User

The De/Activate User Info tab contains:

Option/Button

Function

Select User

Select the username to be activated or deactivated.

User Info

Displays the information associated with the selected
username.

Activate button

Click to activate a deactivated username.

Deactivate button Click to deactivate an active username.
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Define Access

Use the Define Access Tab on the User Administration Window to
assign the desired rights to each access level. These rights control
the actions each user is permitted to perform in the LabChip XT
software. The Define Access tab is not available while an assay is
running.
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Figure 84. User Administration Window - Define Access

The Define Access tab displays a column for each access level
(Administrator, Supervisor, Operator, Restricted User, and Service).
Select Enabled for each right to be allowed for an access level, or
select Disabled for each right not allowed for an access level.

The table below describes the function of each Access Right.

Access Right

Function

User Administration |If enabled, allows access to the User Administration Window

to add and edit users, set access rights, and set policies.

Run Method

If enabled, allows users to run methods and save the new
data files that are created by the run. Users are not permitted
to save changes to existing data files.

File

Save Existing Data | If enabled, allows users to save changes to existing data

files.

Save Workspace If enabled, allows users to save new and existing

workspaces. If Save Existing Data Files is not selected,
users can only save workspaces where the data files have
not changed.

Hide/Show in CDR If enabled, allows users to hide and show data files in the

CDR Manager Window.
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Manage CDR If enabled, allows users to create, rename, and delete folders
Folders in the CDR Manager window.This permission is not required
for automatically creating daily subdirectories or to move
data files in the CDR.

Perform Validation If enabled, allows users to perform 1Q (Installation
Qualifications) and OQ (Operation Qualifications).

Print/Export Analysis | If enabled, allows users to print or export analysis results.
Results

Audit Trail Access If enabled, allows users to view the Audit Trail in the Audit
Trail Window.

Method Editor If enabled, allows users to edit and save methods.

Save button Saves the current settings.

Print Preview button | Displays a preview for printing the access levels.

Print button Prints a report of the access rights for each access level.

Set Policies

Use the Set Policies tab on the User Administration Window to
specify password, login, automatic lock, and signature policies for
the LabChip XT software.
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Figure 85. User Administration Window - Set Policies

The Set Policies tab contains:

Access Right Function

Password Expires After | Specifies the number of days until each password
expires. Range is 1 to 1000 days.

Number of Retired User cannot reuse the specified number of old
Passwords to Remember | passwords.
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Minimum Password Specifies the minimum length of each password.
Length

Maximum Login Attempts | Specifies the maximum number of times the user can
attempt to log in before being locked out of the LabChip
XT software. Range is from 3 to 20. This option can be
disabled to allow unlimited retries without locking the
user out.

This setting does not apply to Administrator level users.

Minutes to Automatic Specifies the number of minutes that the software is
Lock inactive until the LabChip XT software locks
automatically. Range is from 5 to 4320 minutes (3 days).
To disable this option, clear the check box.

Require Signature on File | If selected, an electronic signature is required to save
Update modified data files. Signatures can be performed by any
user who has the Perform Signature option selected in
the Create New User or Edit Users tab.

Save button Saves the settings on the Set Policies tab.
Print Preview button Displays a preview for printing the policies.
Print button Prints a report of the policies.
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LabChip XT/XTe Instrument
Description

This section identifies and describes the hardware components of
the LabChip XT and XTe instruments.

This section includes the following topics:

“Front View” on page 212

“Rear Connectors” on page 213

“Lid” on page 214

“Optics” on page 215

“Barcode Reader” on page 215

“XT Chips” on page 216

“USB Key for 21 CFR Part 11 Option” on page 217
“Specifications” on page 218
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Front View

Figure 86 shows the front view of the LabChip XT/XTe and identifies
the parts on the front of the instrument.

Status Light

Lid

Lid Latch

Figure 86. Front View

Status Light

Indicates the state of the instrument:

Dark (not lit) - Power is off.

Solid green - Power is on and instrument is idle.
Flashing green - Running a chip.

Yellow - Power is on, cannot communicate with
software.

Lid

Provides access to the chip and electrodes.

Lid Latch

Lift latch to open the lid.
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Rear Connectors

The rear connectors are used to connect the LabChip XT/XTe
instrument to the computer and power supply.

-F

Power Switch Power

Connector

I

L]

Figure 87. Rear Connectors

The following connectors are located on the back of the instrument:

Power Plug the power supply into this connector and a power outlet.
Connector
WARNING
Appliance inlet is disconnecting device. Place device or equipment in
a manner so that disconnecting device is accessible at all times.
USB Connects the LabChip XT/XTe instrument to the computer.
Connector
Power Turns the LabChip XT/XTe instrument On (Run) or Off (Standby).
Switch Turning the instrument on reads the barcode on the chip if there is a
chip in the instrument.
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Lid
The lid holds the chip in the instrument and provides the voltage to

the chip channels to separate the sample and move the sample in
the channels.

Electrodes

Barcode Reader
Mirror

Barcode Reader
Window

Chip Locator

W Optical Windows

Figure 88. Lid

Electrodes Apply voltage to the chip to move fluid through the chip and
drive electrophoretic separations in the chip channels.

Barcode Reader Reflects the barcode label on the chip so it can be read by the
Mirror barcode reader inside the instrument.
Barcode Reader Window for barcode reader to read the 2D matrix barcode on
Window the chip.
Chip Locator Recessed area to hold the chip in the correct position for the

electrodes to contact the electrode pads on the chip and to
align the chip with the optical windows.

Optical Windows Windows for laser to illuminate channels and detector to read
fluorescence.

High Voltage Interface

Supplies DC voltage to the separation channels in the chip via pins
on the lid that contact electrode pads on the chip. HV channels run
in constant voltage mode.
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Optics

The LabChip XT and XTe optics provide fluorescence detection
(532nm green excitation and 547-750nm green to red emission) for
DNA chips and methods.

Green Laser

The LabChip XT and XTe instruments include high intensity 532nm
green lasers to excite fluorescence in microfluidic chips.

Focusing, Alignment, and Calibration

The LabChip XT and XTe instruments are optically focused,
aligned, and calibrated at the factory. The optics does not require
alignment or focusing. An optical test chip is available for
instrument performance verification by the customer.

Photodiode Detector

The LabChip XT and XTe use a silicon photodiode detector for
fluorescence detection. Fluorescence signal from each channel is
acquired at a rate of 80Hz.

Optical Train

The fluorescence excitation and detection optical trains contain
lenses, fiber optics, and a high efficiency interference filter.

Barcode Reader

The LabChip XT and XTe instruments are equipped with an internal
Barcode Reader. The Barcode Reader reads the Caliper-applied
barcode on the edge of the chip.

The barcode reader is internal to the system and cannot be viewed
from the outside.
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XT Chips

The figure below show the parts of the microfluidic chips used in the
LabChip XT and XTe instruments to perform DNA collection, sizing,
and quantitation.

Sample Waste Collection
Wells Wells Wells

Figure 89. Top of Chip

Sample Well - Add the sample to this well using the instructions in
the LabChip XT Assay User Guide. The Assay User Guide is
included with the assay Kkit.

Waste Well - After the run, contains the part of the sample that was
not extracted during the run. For Separation channels, contains the
entire sample up to the assay kit range.

Collection Well - After the run, contains the portion of the sample
that was extracted.

Detection Point - The location on the chip where the fluorescence
excitation and detection optics align with the channels on the chip.

Switch Point - The location on the chip where the sample is
diverted to either the waste or collection well.

Barcode Label - The 2D Matrix barcode used to identify the chip in
the LabChip XT or XTe instrument.
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USB Key for 21 CFR Part 11 Option

If the 21 CFR Part 11 option is installed in the LabChip XT software,
the USB Key must be plugged into a USB port on the LabChip XT
computer. If the USB key is not plugged in, the LabChip XT
software displays an error message when starting and then shuts

down.

The 21 CFR Part 11 Security option is not available for the LabChip
XTe software.

Figure 90. USB Key for 21 CFR Part 11 Option
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Specifications

This section lists the technical specifications for the LabChip XT
and XTe instruments. Technical specifications are subject to change
without notice.

General

Size 7.09”H (180mm) H-lid closed x 7.09” (180mm)W x 12.99”
(330mm)D, additional 7” (178mm) required above instrument to
open lid.

Weight 10 Ibs. (4.6 kg)

Chip Capacity |one 4-channel chip

Ventilation/ 3” (77 mm) minimum space required around instrument for proper

Cooling air flow.

Environmental

Operating Temperature

65° to 82°F (18° to 28°C)

Operating Humidity

10% to 70% relative humidity, noncondensing

Storage Temperature

50° to 104°F (10° to 40°C)

Storage Humidity

20% to 70% relative humidity, noncondensing

Transient Overvoltages

Installation Category Il Overvoltage

Pollution

Pollution Degree 2

Altitude

Up to 2000m

Indoor Use Only

Electrical

Power Input 1.0Arms max at 90Vac, 47-63Hz
0.6Arms max at 264Vac, 47-63Hz

Input Voltage 100-127/200-240V~ nominal

90-264V~ maximum operating range

Power Consumption

24VDC, 1.2A max

Fuses No customer-replaceable fuses in system. Contact Caliper
Technical Support (see page 2) if blown fuses are
suspected

Grounding Through the power cord

Computer Interface

USB 2.0
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Assay Voltage

Minimum Voltage/Current | 50V (limited by current)

Maximum Voltage/Current | 600V (limited by current)

Fluorescence Detection

Detection Wavelength Bandpass 547-750nm
Data rates 80Hz

Light Source (Green laser diode)

Warmup Time 30 seconds

Excitation/Emission 532 nm
Wavelengths

Power output 5 mW maximum continuous (CW)

Barcode Reader

Barcode Engine Motorola
Supported Barcode 2D Matrix
Types
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Maintenance and Service

Cleaning the electrodes and chip interface prevents current leaks.
The electrodes should be cleaned daily, or more often if dyes or
reagents contact the electrodes or the chip locator. See Cleaning
the LabChip XT/XTe.

The test chip should be cleaned as needed before testing the
instrument. See Cleaning the Test Chip.

If the instrument will not be used for an extended period of time, see
Long Term Shutdown.

The LabChip XT Assay User Guides contain LabChip Kit Essential
Practices and instructions for preparing samples and chips. Make

sure to follow the instructions to ensure the optimum performance
of your instrument.

The current version of the Assay User Guides can be accessed on
the Caliper web site at:
http://www.caliperls.com/support/reference-library/data-
sheets/labchip_systems_data_sheets.htm.

If you have any questions concerning maintenance or require
additional assistance, please contact Caliper Technical Support
(see page 2).

WARNING

JA\N

Laser maintenance and service should be performed only by a
qualified Caliper representative.

WARNING

MDA AL\ A\

Some chemicals or samples used with the LabChip XT/XTe are
potentially hazardous and can cause illness. Follow the precautions
in “Chemical Safety” on page 8.
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Cleaning the LabChip XT/XTe

Make sure the chip locator and inside of the lid are clean before
beginning a run. Leave the instrument lid closed when not using the
instrument to prevent dust or fibers from settling in the chip locator.
Any potentially fluorescent material, such as lint, paper dust, dyes,
or reagents, or materials that may block the light in the optical
windows must be removed before starting a run.

1 Inspect the chip locator, especially the optical windows, and the
inside of the lid for debris or fibers that may scatter light or
fluoresce during the run.

2 Dust can be removed with pressurized and filtered air.

3 Toremove liquid spills from the lid and chip locator, soak up the
spilled liquids with a lint free wipe. Remove any liquid on the
optical windows only with the swabs provided. Lightly press the
swab on the optical window to or remove the liquid.

NOTE
|

-

Do not apply pressure to the optical windows when using the
swabs. Lightly press the swab on the windows to prevent scratching
or damaging the optical fiber tips.

4 After the spilled liquid is removed, use a lint free wipe
dampened with DI water to rinse the lid and chip locator.

5 After the spilled liquid is removed, clean the optical windows
with DI water, using ONLY the swabs provided. Lightly press the
swab on the optical window to apply or remove the DI water.

6 Use alint free swab dampened with 70%-isopropanol solution in
DI water to clean the electrodes.

7 Use alint free swab dampened with DI water to rinse the
electrodes.

8 Let all parts air dry.

Do not use detergents or other cleaners, as they may contain
fluorescent dyes that interfere with the run.
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Cleaning the Test Chip

Optical Windows

1 Inspect the chip for debris or fibers that may scatter light,
fluoresce, or block light during the run.

2 Dust can be removed with pressurized and filtered air.

3 To clean dyes or reagents from the chip, use a lint free wipe
dampened with 70%-isopropanol solution in DI water.

4 To clean dyes or reagents from the optical windows, use only
the provided swabs dampened with 70% isopropanol solution in
DI water. Rinse with swab dampened with DI water.

NOTE
|

-

* Do not apply pressure to the optical windows when using the
swabs. Lightly press the swab on the windows to prevent
scratching or damaging the optical fiber tips.

* Do not touch the optical windows when handling the test chip.

5 If necessary, the PCB on the Test Chip can be cleaned with a
swab dampened with 70% isopropanol solution in DI water.
Rinse with swab dampened with DI water.

6 Let all parts air dry.

7 Run the High Voltage Diagnostics after cleaning the system to
verify cleaning is successful. If the High Voltage Diagnostic fails,
repeat the cleaning procedure. If a second cleaning does not
resolve the error, contact Caliper (see page 2).
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Long Term Shutdown

If the LabChip XT/XTe will not be used for an extended time (more
than 10 days) the instrument should be shut down as follows:

1
2

Remove the chip from the instrument.

Turn off the power switch on the back of the instrument and
unplug the power cord from the wall outlet.

Clean the inside of the lid and the chip locator if any reagents or
dyes are present. Follow the instructions in “Cleaning the
LabChip XT/XTe” on page 221.

Allow to air dry.

Close the lid and cover the instrument with a light cloth or dust
cover.

Store the instrument in a location that meets the storage
requirements in “Specifications” on page 218.
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Troubleshooting and Diagnostics

This section contains the following topics to help troubleshoot
problems with the LabChip XT/XTe software:

» “Searching for Events in the Events Tab” on page 224
*  “Viewing Current Events in the Events Tab” on page 225
*  “Error Messages” on page 226
+ “Diagnostics” on page 229
*  “Troubleshooting Assay Problems” on page 232
» “Software Problems” on page 233
— “Cannot Save a File” on page 233
— “Computer Software Lock-Ups” on page 233
« “Zipping the Log Files” on page 235

Searching for Events in the Events Tab

Events and errors that occurred during the screening of previous
jobs are displayed in the Past Events tab in the Event Viewer
Window.

To search for a specific event:
1 On the Event Viewer window, click the Search Result tab.
2 In the Events list, select Current, Past, or All.

3 Inthe Search Text box, type a search query and click the
Search button. The Source, Event Code, and Description fields
are searched. The search results appear in the Search Result
fields.

The Search Result tab contains the following fields:
Time - The time the event or error occurred.
Source - The source of the event or error.

Event Code - The event/error ID number used by Caliper to
troubleshoot problems.

Description - A detailed description of the event or error that
occurred.
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Viewing Current Events in the Events Tab

While a job or batch is running, the events and errors that occur
during the screening display in the Current Events tab in the Event
Viewer Window.

* On the Event Viewer window, click the Current Events tab. The
Current Events fields display. (These fields are read only.)

The Current Events tab contains the following fields:
Time - the time the event or error occurred.
Source - The source of the event or error.

Event Code - The event/error ID number used by Caliper to
troubleshoot problems.

Description - A detailed description of the event or error that
occurred.

Viewing Past Events in the Events Tab

All events and errors that have occurred during the screening of
previous jobs or batches display in fields on the Past Events tab in
the Event Viewer Window.

« On the Event Viewer window, click the Past Events tab. The
Past Events fields display. (These fields are read only.)

The Past Events tab contains the following fields:
Time - The time the event or error occurred.
Source - The source of the event or error.

Event Code - The event/error ID number used by Caliper to
troubleshoot problems.

Description - A detailed description of the event or error that
occurred.
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Error Messages

Before a run is started and while an assay is running, the
instrument firmware and software checks for errors (e.g.,
disconnected devices, bad parameters, bad data, etc.). If an error is
detected, an error or warning message displays on the LabChip
XT/XTe Main Window. Depending on the error, the run may
continue or be aborted. The error or warning message describes
the problem and either contains information on how to resolve the
problem or directs you to call Caliper Technical Support (see

page 2).

For specific information about an error or warning message, click
one of the links below.

General Errors
< Device <Name> is Disconnected
LabChip XT/XTe Warnings

* Pin Test Failed
* Current Leakage Check Failed

Device <Name> is Disconnected

This error message indicates that there is no communication
between the software and the specified device.

Possible Causes Recommended Actions

1. Cable between computer | Verify that the USB communication cable is secure.

d inst t I d.
and InsTUment UNPHI9eY: | Verify the power cord is plugged in.

Switch the Power switch on the LabChip XT/XTe to the
ON position. See page 213.

Restart the LabChip XT/XTe software.

2. Instrument power loss.

3. Computer went into
hibernation.

If the problem is not resolved, contact Caliper
Technical Support (see page 2).
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Pin Test Failed

Warning Message: “Pin test failed.”

Possible Causes Recommended Actions

1. Not enough liquid in the | 1. Prepare the chip as described in the LabChip XT
chip wells. Assay User Guide.

2. If the problem is not resolved, contact Caliper
Technical Support (see page 2).

Current Leakage Check Failed

Warning Message: “Current leakage check failed.”

Possible Causes Recommended Actions

Dirty electrode block. Clean the electrodes (see page 221).
Run the Current Leak Diagnostic Test (see page 229).

If the problem is not resolved, contact Caliper Technical
Support (see page 2).
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Running Installation Qualification (1Q)

The Installation Qualification (1Q) verifies proper installation of the
LabChip XT/XTe software and verifies no unauthorized changes
have been made to the software. The 1Q can be run whenever
required by your laboratory procedures.

The Installation Qualification can be used to check software
installation qualification after routine computer maintenance, such
as disk cleanup, after installing antivirus software, or after installing
Microsoft service packs. The Installation Qualification checks
LabChip XT/XTe software registry settings, the directory structure,
and the integrity of each file specified for the software application.

To run the 1Q:

1 On the LabChip XT/XTe Main Window, select Validation —
Software 1Q. The Software Installation Qualification Window
opens.

2 To view the results of the previous 1Q before running a new IQ,
click the Previous Result button. The View Installation
Qualification Results Window displays the results of the last 1Q
that was run.

3 To start the IQ, click the Start 1Q button. The Installation
Qualification window displays the tests that are run for the 1Q,
the progress of each test, and the Pass/Fail status of each test
as it is completed.

4 To save the results of the 1Q, click the Save As button, specify
the desired location and name of the file, and click the Save
button. 1Q results are saved as .xml files.

Running Operational Qualification (0OQ)

The System Diagnostics window performs an automated
Operational Qualification whenever required by your laboratory
procedures.

The System Diagnostics Window displays the tests that are
performed on the left side of the window. The test results are
displayed on the right side of the window. After all tests are
complete, the test report is generated and saved to a file for review,
printing, and documentation purposes.

See “Diagnostics” on page 229 for details on running the
Diagnostics.
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Diagnostics

The LabChip XT/XTe software contains a set of diagnostic tests to
verify proper operation of the LabChip XT/XTe instrument. These
tests are not dependant on assay chemistry. All tests must pass to
ensure the instrument is functioning properly. To open the System
Diagnostics Window, select Validation - Diagnostics.

The following procedures are included in this section:

* Running the Diagnostics Tests
+ “Description of Diagnostic Tests” on page 230

Running the Diagnostics Tests

Before running the Diagnostics tests, turn on the instrument and
allow the instrument to run for at least 30 minutes before starting
the Diagnostics tests.

To begin running the Diagnostics tests, click the Run Tests button
on the System Diagnostics Window. The tests run from top to
bottom, displaying prompts for any actions necessary during the
tests. Follow the prompts. As each test is completed, the results
display on the right side of the window.

Supplies required to run diagnostics tests:
+ XT Test Chip (Caliper P/N 127872)

To order the XT Test Chip, contact Caliper Technical Support (see
page 2).
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Description of Diagnostic Tests

The table below lists the test names, descriptions, potential failures,
and the chip required to run the test.

Test Name

Chip
required

Description

Potential Failures

Computer
Resources

Any

Check for CFR
database connection

SQL server not started. Start
SQL Server Express.

Database has not been
installed properly. Contact
Caliper Technical Support
(see page 2).

Check for CDR
Service

Service exited unexpectedly
or not started.

Check for Remote
CDR Connection
(Run only if Remote
CDRis set up.)

Remote server is down.
Network is down.

Memory Check

Available memory below 500
MB. System may function
with lower memory but there
is risk of failure if analyzing
many chips.

Disk Space Check

Available disk space below 4
GB. Risk of losing data as
disk space is used. Free
space on local hard drive.

System
Components

XT Test
Chip

Verify Fan operation

Damaged fan. Contact
Caliper Technical Support
(see page 2).

Board Temperature

Board temperature is not
between 18 and 39°C. Verify
room temperature is between
65° to 78°F (18° to 26°C).
Contact Caliper Technical
Support (see page 2).

Low Voltage Supply

Low voltage supplies are not
delivering 3.3+0.15V,
5.0+£0.25V. and 3.4+0.15V.
Contact Caliper Technical
Support (see page 2).
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Chip
Test Name required Description Potential Failures
System XT Test Check Instrument Lid | Lid is open. Close lid.
C t Chi Interlock
omponents, P nierioc Interlock Switch is defective.
continued _ ,
Contact Caliper Technical
Support (see page 2).
Barcode XT Test Verify barcode Barcode reader hardware or
Chip reader software not functioning.
Contact Caliper Technical
Support (see page 2).
Laser XT Test Channel (1 -4) Laser | Laser power read back is not
Chip Power Readback within 0.2mW of tested power
levels: 3.0, 4.0, and 5.0 mW.
Contact Caliper Technical
Support (see page 2).
Optics XT Test Channel (1 - 4) A channel’s gain is not
Chip Detector Response | adequate or background is
too high. Contact Caliper
Technical Support (see
page 2).
HV Voltage XT Test HV Supply at Voltage out of calibration.
Calibration Chip (-450V)/(-250V) Contact Caliper Technical
Support (see page 2).
Channel (1 - 4) Hi/Lo | Pin not connected to power
Voltage supply. Contact Caliper
Technical Support (see
page 2).
HV Current XT Test Channel (1 -4) Current out of calibration. Pin
Calibration Chip Hi/Lo/Zero Currents | not connected to power
supply. Contact Caliper
Technical Support (see
page 2).
HV Kelvin Mode | XT Test Channel (1 -4) Contact Caliper Technical
Chip Kelvin Mode Hi/Lo Support (see page 2).
Voltages
HV lIsolation XT Test Channel (1 -4) Faulty isolation relay. Contact
Relay Chip Isolation Relay Caliper Technical Support
(see page 2).
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Troubleshooting Assay Problems

For problems with assays, see the Assay User Guide for the
specific assay you are running. The Assay User Guides contain
common problems that may occur for each type of assay, and
suggested solutions to resolve the problems.

The current version of the Assay User Guides can be accessed on
the Caliper web site at:
http://www.caliperls.com/support/reference-library/data-
sheets/labchip_systems_data_sheets.htm.

If the problem is not resolved by following the suggestions in the
Assay User Guide, contact Caliper Technical Support (see page 2).
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Software Problems

If any of the following software problems occur, follow the
suggestions to correct the problem:

+ Cannot Save a File
» Computer Software Lock-Ups
» Software Display Flashes

Cannot Save a File

File has been saved as a Read Only file.

If you editing an existing file, verify the file is not Read Only. If it is,
the title bar shows Read Only after the file name. Read-only files
can be edited and saved with a new name or in a new location with
the same name, but cannot be saved over the original file.

Hard drive is full.

Verify there is sufficient free space on the drive to save the file. If
not, clear some space on the hard drive. On non-21 CFR Part 11
systems, you can archive files that you are not using to another
location.

If you do have sufficient space, try closing all open applications and
then turning off the power to the computer. After a few seconds,
restart the computer, open another file, and try resaving it to verify
the Save function is working properly.

LabChip XT/XTe software is corrupted.

Reinstall the software. If the problem persists, contact Caliper
Technical Support (see page 2).

Computer Software Lock-Ups

If a computer or software lock-up occurs:
1 Try to exit and then re-launch the LabChip XT/XTe software.

2 If this is not successful, exit the application using the Task
Manager:

a Right-click in the desktop menu bar and select Task
Manager.

b Click on the Applications tab.

¢ While holding down the Shift key, select all running
applications.
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Computer Software Lock-Ups (Continued)

d Hold the Ctrl key and click End Task.

3 If the Task Manager cannot be accessed, try one or all of the
following:

* Press the Ctrl, Alt, and Delete keys on the keyboard
simultaneously.

* Perform a hard reboot by turning off the computer and then
restarting it.

* Power cycle the LabChip XT/XTe instrument.

4 If problems persist, contact Caliper Technical Support (see
page 2).

Software Display Flashes

During a run, the views in the LabChip XT/XTe software may flash
occasionally as the new data is displayed.

Do not run any other software applications while running the
LabChip XT/XTe software, especially while a run is in progress. The
LabChip XT/XTe Controller should only be used to run the
instrument and should not be used for general computing tasks.
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Zipping the Log Files

The Caliper Log Zipper is a small software utility that zips the
LabChip XT log files and system info files and places the resulting
DiagnosticsLog.zip file on the computer desktop. This utility can be
used to package all of the log and diagnostic files together if the
files need to be emailed to Caliper Technical Support.

To zip the LabChip XT diagnostics logs:

1

On the Windows desktop, select Start — All Programs —
Caliper Life Sciences — LabChip XT — Caliper Log Zipper.
The Caliper Log Zipper window opens.

([ cotver tog Zipper DM (e
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Figure 91. Caliper Log Zipper Window

Click the Zip button. The DiagnosticsLog.zip file is saved to the
computer desktop. Any existing older file with the same name is
over-written.

To save a copy of the file, either rename the file or move the file
to a different location.
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Tips and Shortcuts

This section describes the shortcuts and actions that can be
performed in the LabChip XT/XTe software by clicking, right-
clicking, etc.

Single Click

In Chip View - Selects a channel.

In Gel View - Selects a channel and displays the graph in the
Graph view.

In Channel Table View - Selects a channel, displays the graph
in the Graph view, and selects the channel in the Gel view.

In Peak Table View - Selects a peak, displays the graph in the
Graph view, and selects the channel in the Gel view.

Ctrl + Click

In Gel View - Overlays second and subsequent channel data
over original channel data in the Graph view (for each Ctrl +
click on a channel in the gel). Each channel in the graph is
shown in a different color.

In Channel Table view - Overlays second and subsequent
channel data over original channel data in the Graph view (for
each Ctrl + click on a row in the Channel Table). Each channel
in the graph is shown in a different color.

Ctrl + Shift + Click

In Gel View - Highlights corresponding channel data trace in
Overlay Electropherogram view (adds trace to overlay if not
already included). This trace becomes the foreground trace for
peak selection. Repeat click to undo highlighting.

Right-Click

Right-click in any view to display a shortcut menu with available
options. In the Graph View, different shortcut menus display
depending on whether the cursor is near a peak or not near a
peak.
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Apex

Minimum Peak Width
Molarity

Molecular Separation Techniques
Peak Baseline

Peak Height

Peak Identification
Point-to-Point Fit
Polynomial Filter
Polynomial Order
Run Button

Sample Name File
Saturation Detection
Slope Threshold
Smear

Smear Baseline
Standard Curve Window
Start Point

Start Time

Tool Tip

Workspace

XTD Files

Zero Baseline

After locating a start point, the peak find algorithm looks for the first
negative slope value and saves the previous point as the apex. If
the value of the apex is less than the minimum peak height limit, the

algorithm starts looking for a new peak.
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Baseline

A baseline is established just after the start time setting. (The
Baseline Start time can be changed on the Analysis Tab in the
LabChip XT software.) After the overall baseline is established, a
local Peak Baseline is calculated for each peak to compensate for
baseline drift.

For isolated peaks, the local peak baseline is a straight line
connecting the start point of the peak with the end point. For peaks
that are very close together, an average baseline is used when the
value between the peaks does not drop to the actual baseline.

In the LabChip XT software, you can select the desired baseline
algorithm for all of the samples in the chip. Choose the desired
option on the Peak Find Tab: No baseline, Zero Baseline, or
Baseline Subtraction.

* For the “Zero Baseline” option, a single value of baseline
shift is determined by averaging over a 1 second region just
before the Data Range Baseline time. This shift is subtracted
from all of the data.

* The “Baseline Subtraction” option uses a spline fit or rolling
ball fit to the data to determine a smooth baseline that is
subtracted from the data. The percentage of data points
used in the spline fit is specified by the Threshold value in
the Method window. The collection of points with the lowest
variance up to this percentage is used for the spline fit. The
Rolling Ball algorithm uses the Time Diameter to specify the
size of the ball in the X direction and the Signal Diameter to
specify the size of the ball in the Y direction.

Figure 92 shows baselines established for DNA assay peaks
(based on the settings in the Peak Find Tab). DNA peak baselines
are determined on a peak-by-peak basis.
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Bubble

Clipboard

Collection

If the tip of a pipette is not positioned below the liquid level in the
chip well, bubbles can result. If a large bubble forms at the bottom
of a chip well, remove the sample from the well, pipette the sample
back into the chip well, and continue with the loading procedure.

A temporary storage area that contains information you have cut or
copied. You can paste the contents of the clipboard into other
programs (provided that program supports that type of information).
Information remains on the clipboard until you replace it with the
information from another cut or copy command.

Use a collection to view the chip data. In the LabChip XT software,
a workspace can contain multiple collections to supply different
views of the same data.

Each collection specifies:

» the channels selected for view in each chip data file,

» the layout of each Collection tab, and

» the display properties for each view in each collection.

Collection Template

In the LabChip XT software, a collection template saves the display
options for a collection and any defined filters in the collection.
Collection templates are used to create new collections using the
saved display settings and filters. Collection templates do not save
the list of chips or the channels selected in the chips.

To save a collection template based on the settings in the open
collection, select Collection > Save Template on the main Menu
Bar.

To apply a collection template to a new collection, select the
Template option in the New Collection Window.

To apply a collection template to an existing collection, select the
tab for the desired collection and then select Collection > Apply
Template on the main Menu Bar.

Collection Templates are not supported in the LabChip XTe
software.
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Collection Well

Data Files

The wells on the chip that will contain the fractionated samples at
the end of the run. There is one waste well and one collection well
per channel. There are four channels on each LabChip XT chip.

While running an assay, the raw data received from the instrument
is automatically saved to the chip data file (*.xtd or .xte). As the data
is received, it is saved to the data file. The name of the data file is

specified in the Start Fractionation Window.

After a run is complete, the data is analyzed using the analysis
settings in the method. The analysis settings are saved in the data
file (.xtd or .xte).

After the run in the LabChip XT software, you can change the
analysis settings using the Method Window. When the new settings
are applied, the data is reanalyzed and the updated results are
displayed. Changes to the analysis settings are not saved until the
workspace is saved. To save analysis settings without saving the
workspace, select Workspace — Save Chip or right-click on the
chip name above the chip diagram on the left side of the window
and choose Save Chip.

In the LabChip XT software, changes to the analysis settings are
saved at the end of the chip data file without overwriting previous
settings in the file. The Restore Chip button can be used to return to
previous analysis settings.

Data Points

Data points are determined by the data collection rate set in the
method properties.

Show Data Points is an option in the Graph View Properties that
displays the data points used to generate the graph.
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Data Filtering

Before identification of peaks in the fluorescence data can proceed,
the raw data must be smoothed to prevent the detection of signal
noise as peaks.

To smooth the data, the LabChip XT/XTe software:

1 Eliminates any narrow spikes from the data and replaces the
spike with a local average of surrounding points.

2 Applies Baseline correction (if selected in the Method Window)
to the data.

3 Smooths the data using a Savitzky-Golay filter using the Filter
Width and Transition Time specified in the Peak Find Tab of the
Method Window.

DNA Assay Analysis

DNA samples contain a lower marker peak below the limit of the
DNA fragment sizes the method is designed to detect. The ladder
contains the same lower marker peak. The sample data is aligned
to the ladder data by matching the peak time of the marker in the
sample data with the same marker in the ladder data. The size of
each sample peak is calculated by linear interpolation between the
known ladder peak migration time and size using the peak aligned
migration time. In the LabChip XT software, the analysis settings
can be changed to perform the interpolation using a local third order
polynomial fit to the time instead of the size relationship provided by
the ladder.

The concentration of the sample peaks is calculated using the
known area and concentration of the ladder peaks. The molarity of
each sample peak is calculated using the sample concentration, the
DNA fragment size (in base pairs) attributed to the peak, and the
known molecular weight of the DNA base pair.

Electrode Cleaner

The electrode cleaner looks like a chip except that it is clear. Use
the electrode cleaner in place of a chip when cleaning electrodes.
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Electrokinetic Forces

Electrokinetic forces are used to move, switch, mix, and separate
the nucleic acid samples. Active control over voltage gradients
directs the movement of materials using the phenomenon of
electroosmotic flow or electromigration.

Electroosmotic Flow

A phenomenon that results from an electrical double layer formed
by ions in the fluid and surface electrical charges immobilized on
the capillary walls. When an electric field is applied, the bulk
solution moves towards one of the electrodes. This phenomenon
can be used to move fluids through microfabricated channels

Electrophoresis

A technique of separating molecules on the basis of their mobility.
An electrical potential is applied across a capillary containing a
sample in a fluid medium. Positive molecules migrate towards the
cathode and negative molecules migrate towards the anode at
different speeds depending on their electrophoretic mobility.

End Point

The peak find algorithm looks for a leveling off when the value of
the slope is less than the value set for the slope threshold. This is
marked as the end point of the peak.

End Time

This setting determines the time after the start of a run before which
the last peak or fragment will be located (any peaks appearing after
this time are ignored).

Filter Width

This setting on the Peak Find Tab determines the width of the
polynomial (in minutes) to be applied to the data for filtering (noise
reduction). The default depends on the method selected.
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Hardware Diagnostics

Whenever a run begins, the instrument checks for errors (e.qg.,
defective high-voltage supplies, missing conductivity between
channels, etc.). If an error is detected, a message box displays and
the run stops. The message box describes the problem and either
contains information on how to resolve the problem or directs you to
call Caliper Technical Support (see page 2).

Inflection Threshold Example
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Peaks that are very close together will be identified as a single peak
if the peaks do not have a clear valley between them. The Inflection
threshold property in the LabChip XT software allows splitting of
peaks evidenced by a region of lower slope. The figures below
illustrate the operation of the Inflection threshold.

The green line in the figures below shows the signal slope. The
shoulder peaks have a slope minuma (inflection point) but the slope
doesn't change sign so they are not split into multiple peaks via the
slope threshold.
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Figure 93. Slope Threshold 0

The inflection threshold defines the value that the slope minimum
must be below to trigger a splitting of the peak. As the threshold is
increased, more peak splitting occurs. The figures below show the
same data with the slope threshold set to 80 and 200.
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Lab-on-a-Chip

The generic term for a microfluidic product, signifying a chemical
process or material movement taking place on a microchip. In
contrast to analysis in a standard laboratory that relies on human
intervention at several stages to manipulate or observe samples
and record results, the self-contained lab-on-a-chip represents an
almost hands-free technology.

Ladder

A channel on the chip can be designated as a Ladder channel if it is
running a Real Time Ladder at the same time the samples are
running. A default Caliper Ladder is provided if all four channels of
the chip are used to run samples. The ladder is used to calculate
sample sizes and migration times of the sample to accurately
determine the collection start time and collection end time for each
sample.

In the LabChip XT software, the Peak Table View for the ladder
channel shows the peak size and concentration set in the Method

Window.
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Figure 96. Ladder Graph
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Ladder Analysis

A ladder is a mix of compounds of known sizes that is used to
create a size ruler for the samples. Ladder data is used to convert
the migration time of each sample peak into a size for the
compound responsible for that peak. The known sizes of the ladder
compounds are supplied in the method file. In the LabChip XT
software, the ladder sizes can be viewed in the Analysis Tab on the
Method Window.

The ladder analysis identifies the most prominent peaks in the
ladder channel and associates each peak with the known ladder
sizes. The ladders provide a table of values relating size to
migration time. Typically the migration time uses the center of the
peak in the ladder and the sample.

Lower Marker

Log Files

An internal standard that is added to a sample in a channel to assist
in determining size and concentration of the sample. The marker is
the same as the first peak in the ladder.

The LabChip XT/XTe software log file displays in the Event Viewer
Window. The log file maintains a running record of all events that
occur with the instrument while it is online with the software and
records all events that occur in the software. Each event specifies
the date and time of the event, source of the event, the event code,
and a description of the event.

Method File

File created in the LabChip XT software to specify assay and
analysis settings, such as Ladder and marker sizes and
concentrations, peak find settings, expected peaks, and smears.

Editing method files and changing analysis settings are only
supported in LabChip XT software.

Microfluidics

The miniaturization of chemical processes generally pertaining to
systems involved in the control of fluid flow. This includes pumps,
valves, jets, and microchannels.
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Minimum Peak Height

The Minimum Peak Height value determines the height limit below
which a peak will not be detected. For each peak, the difference
between the peak start time and the peak apex must be greater
than the Minimum Peak Height value.

The Minimum Peak Height is specified on the Peak Find Tab on the
Method Window in the LabChip XT software. The Minimum Peak
Height cannot be changed in the LabChip XTe software.

Minimum Peak Width

The Min Peak Width value determines the width (in minutes) under
which a peak will not be detected. For each peak, the difference
between the peak start time and the peak end time must be greater
than the Minimum Peak Width value.

The Minimum Peak Width is specified on the Peak Find Tab on the
Method Window in the LabChip XT software. The Minimum Peak
Height cannot be changed in the LabChip XTe software.

Molarity

Molarity = (Concentration * 106)/(660 * Size)[nmol/l]

where molarity is measured in nanomoles per liter (nmol/l).

Concentration is measured in nanograms per microliter (ng/uL).

Size is measured in base pairs (bp).

660 * [g/(mol * bp)] is the molecular weight of a single base pair.
Molecular Separation Techniques

Processes such as gel electrophoresis, liquid chromatography, and

capillary electrophoresis, which can separate biomolecular organic
substances from other compounds.
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Peak Baseline

A local peak baseline is calculated for each peak. For isolated
peaks, the local peak baseline is a straight line connecting the start
point with the end point. For peaks that are very close together, an
average baseline is used when the value between the peaks does
not drop to the actual baseline. The peak baseline for each peak in
Figure 97 is shown in a different color.
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Figure 97. Peak Baselines

The baseline algorithm starts at the earliest peak and checks
whether the end point is within a certain distance from the start of
the next peak. When a cluster of peaks is detected, the baseline is
the line joining the first peak's start to the last peak's end. The start
and end points of adjacent peaks in the cluster are averaged to the
same point so that no gaps exist between peaks.

The peak baseline Start Point and End Point can be moved in the
Overlay Electropherograms Tab if Show Peak Baselines is
selected in the Graph View Properties.

Peak Height

The value at the apex of the peak minus the local baseline start
value.
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Peak Identification

From the smoothed data, peaks are identified using a hill-climbing
algorithm running along the smoothed data and its first derivative.

The slope threshold determines peak start point and end point:

» The first point with local derivative above the slope threshold
indicates the peak start point.

* The first point where the negative slope on the falling edge of
the peak drops below the slope threshold indicates the peak end
point.

The peak baseline is stitched across the peak bottom by taking
local averages just outside the peak start and end points. The peak
height, measured from the apex down to the peak baseline, must
exceed the minimum peak height specified in the Method Window
to have a bump tagged as a peak.

The peak start, end, and baseline can be viewed in the Graph View
by selecting the Show Peak Baselines option in the Graph View
Properties. The area of each peak is determined by trapezoidal
integration of the peak signal between peak boundaries and above
the peak baseline.

Point-to-Point Fit

This curve fit is composed of line segments between each pair of
data points that are used to interpolate data between the points.

Polynomial Filter

The first step the software takes in analyzing the raw data is to
apply Data Filtering. Data filtering is performed by means of a
polynomial “filter” that is applied to the raw data. The figure below
approximates the shape of the filter and shows what peaks may
resemble if the filter application is too strong.
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Polynomial Order

This setting on the Peak Find Tab in the LabChip XT software
determines the order of the polynomial filter used to convolve with
the data. A polynomial filter is used to filter the data to increase the
signal-to-noise ratio and calculate filter slope information for peak
detection. The default setting is 6 (for 6th order).

Run Button

To begin running an assay, click the Run button located on the
graphic of the LabChip XT/XTe instrument at the top left of the
LabChip XT/XTe Main Window:

The Start Fractionation Window opens to select the method,
channels, data file name, etc.

After the run has begun, this button changes to Pause/Stop. See
“Stop a Run” on page 38.

NOTE

|

-

The Run button does not display if the software was installed in
Reviewer mode.
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Sample Name File

Use a Sample Name file to import the desired sample names into
the Run File Editor Window or the Start Fractionation Window.
(LabChip XT only.)

The entries in the Sample Name file must be formatted as shown
below, with one pair on each line.

<Channel, Sample name >
Example:

CH2, 1ug of 2.5k gDNA Smear 1k extraction
CH3, 2ul library
CH4, "HL60 500 ng, starting 4microl"

Sample names containing commas must be enclosed in double
quotes.

The Sample Name file can be created in Microsoft Excel or a similar
spreadsheet program, and must be saved as a .csv file.
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Saturation Detection

The LabChip XT software can be set to compensate for optics
detector saturation on the Advanced Tab on the Method Window.

The instrument electronics saturate at approximately 3200 RFU
(optics detector voltage of approximately 3.2 volts). When the
analog amplifier saturates, it switches rapidly to 0 volts output. The
detection is based on the very high negative slope of the signal as it
transits into saturation and very high positive slope when it comes
out of saturation.

The corrected signal is flat over the saturated region with a value
equal to the maximum of the largest RFU value detected just before
entering saturation and just leaving saturation. The well is
annotated in the Analysis Error column with the message: Signal
Saturation Detected.

Figure 98 shows a signal that saturated the electronics. The left
graph with the Saturation Detection option disabled shows the true
signal with a saturation artifact which would seriously compromise
the quantization accuracy. The right graph shows the same signal
with the Saturation Detection option enabled. The saturation is
corrected so the signal appears as expected and will quantized
fairly closely to a value that would have been attained if no
saturation had occurred.

Figure 98. Correction by Saturation Detection
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Slope Threshold

Smear

The Slope Threshold setting represents the amount of change in
response over time required to differentiate between an eluting
peak and baseline noise. Changing this setting may cause certain
peaks that were previously detected to be ignored or to interpret
noise as peaks.

The Slope Threshold setting is one of the user-definable
parameters in the Peak Find Tab. in the LabChip XT software.

Specifies a size range in which to detect the region of the
fluorescence signal instead of specifying a specific size for a peak.
Use a smear to detect a broad mix of molecules of similar but
distinct sizes in a sample. The concentration or fractional presence
within a specified range of molecule sizes is measured. Specify the
Start Size and End Size of a smear in the Method Window on the
Smear Analysis Tab.

Smears are also used to display the region of extraction. The
extraction smears are created automatically during an extraction
run.

The Smear Properties can be viewed in table form in the Channel
Table View. To view the Smear Properties in the table, add the
desired property to the Channel Table View. The properties
extracted from the smear match those of a peak, having extends,
area, concentration, etc. % Purity is the ratio of smear
concentration to total sample peak concentration, exclusive of
markers, system peaks, and excluded peaks. Excluded peaks are
not excluded from analysis calculations such as concentration or
area within the smear region, so the limits must avoid excluded
peaks. An additional Peak Count property is available for smears.
Peak Count is the number of non-excluded sample peaks in the
region, where the center of the peak is inside the smear limits.

In the Graph View, the smear regions display with the integration
extends drawn at the base of the smear in the chosen color and the
trace highlighted with the smear color. Override the smear base by
dragging with the mouse in the Graph view. Only the vertical
position of the base corners can be adjusted in the graph, since the
size limits are specified and should not be altered.

In the Gel View, the smear region is shown on the gel as a colorized
region. The color is a transparent version of the color selected for
the region, so the fluorescence intensity still shows through.
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Smear Baseline

A Smear baseline is calculated for each smear. Choose the desired
Smear Baseline option on the Advanced Tab on the Method
Window in the LabChip XT software.The following options are
available to calculate the smear baseline:

* Two Point - The baseline is a single straight line between the flat
baseline regions at the beginning and end of the trace. During
extraction, when the end of the signal has not yet been reached,
the baseline uses a single value averaged over the Baseline
region at the beginning of the trace. Two Point is the default
selection.

* Peak Baseline - The local baseline computed for peaks is used
as the smear baseline. The baseline is a straight line from the
beginning of the smear region to the end of the smear region
and follows the local peak baseline.

The Two Point baseline option is best for traces where both ends of
the signal return cleanly to background levels. If there are local
artifacts before the lower marker, after the upper marker (when
used), or at the end of the trace, the Two Point baseline may shift
above the smear trace, resulting in poor quantization of the smear.
Figure 99 shows a trace with a large sample artifact after the upper
marker which elevates the two point baseline.

Figure 99. Smear with Poor Two Point Baseline

Figure 100 shows the same smear using the Peak Baseline option.
Note that the smear baseline drops to the local baseline at the end
of the smear.

Figure 100. Peak Baseline Option for Smear

The Peak Baseline option is not a good choice for very shallow
smears which do not rise above the Peak slope threshold. The peak
baseline will follow up into the smear and the smear baseline will
depend strongly on where the smear extends are set.

V2.1

LabChip XT/XTe User Manual Caliper Life Sciences, Inc.



Glossary of Terms 256

Standard Curve Window

Only the LabChip XT software supports viewing or changing the
Standard Curve.

The Standard Curve window shows the standard curve used for the
selected chip data.

When you choose Standard Curve from the Analysis menu for a
DNA assay, a window similar to Figure 101 opens. The standard
curve is drawn from the values obtained for the DNA ladder. It is a
plot of the size of the ladder peaks vs. time with a point-to-point fit.
For each sample peak, the apex is interpolated from the Standard
Curve to determine the peak size in base pairs (BP).
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Figure 101. DNA Assay Standard Curve

For more information about the use of the standard curve during
analysis, see “How the Software Analyzes DNA Data” on page 44.

Start Point

The peak find algorithm analyzes the data from time zero looking
for a slope greater than the Slope Threshold. The point where the
slope is greater than the slope threshold specified in the Peak Find
Tab is marked as the start point of a peak.

Start Time

This setting determines the time after the start of a run when peaks
will be detected. Any peaks appearing before this time are ignored.
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Tool Tip

A small box containing text that describes the item indicated by the
mouse pointer. To view a Tool Tip, position the cursor over an item
on the window. Leave the cursor stationary for a moment and a
Tool Tip (if one exists for that item) displays.

Workspace

XTD Files

Use a workspace file to view the chip data from a run. In the
LabChip XT software, workspace files can be saved and opened. In
the LabChip XTe software, a new workspace opens automatically
when importing a data file. Multiple chip data files can be opened in
the same workspace to enable comparison between data from
different chips or different runs.

In the LabChip XT software, each workspace can contain multiple
Collections for viewing the same data in different layouts. The
LabChip XTe software only supports one collection in each
workspace.

A Workspace file includes:

» the links to the chip data files in each collection,

» the selected channels and arrangement of the channels in the
views, and

» the layout selected for each collection.

The file extension for data files created in the LabChip XT software.
The data file contains the data from the read, method information,
analysis settings, and Run Information for the run.

Data is saved to the file during the run. If a run is stopped before the
run is complete, the collected data for all channels is saved in the
data file.

The file name is specified in the Start Fractionation Window.
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XTE Files

The file extension for data files created in the LabChip XTe
software. The data file contains the data from the read, method
information, and Run Information for the run.

Data is saved to the file during the run. If a run is stopped before the
run is complete, the collected data for all channels is saved in the
data file.

The file name is specified in the Start Fractionation Window.

Zero Baseline

Changes to Analysis Settings are only supported for LabChip XT.

Selecting this setting in the Peak Find Tab offsets the graphs shown
for the individual channels but does not affect analysis. The mean
of 100 points before the baseline time (derived when calculating
channel noise) is used as the zero baseline value.

All electropherograms produced with the instrument show some
amount of background fluorescence. By default, the LabChip XT
software enables the Zero Baseline function. To change the
Baseline Algorithm, select None, Zero Baseline, or Baseline
Subtraction on the Peak Find Tab.
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Caliper Life Sciences, Inc. Product Warranty

l. INSTRUMENTS

Caliper® Life Sciences, Inc. (“Caliper”) warrants your Caliper-manufactured instrument’s hardware and firmware against defects in material
and workmanship for a period of one (1) year from the date of installation, but not later than 14 months from shipment, subject to the
exclusions set forth below and: (i) the warranty for Limited-Life Parts (as defined below) shall be thirty (30) days from the date of installation,
and (ii) the warranty for cosmetic surfaces shall be thirty (30) days from the date of installation (each, a “Warranty Period”). Ongoing service
support after the Warranty Period may be available at an additional expense.

A. What is Included during the Warranty Period

« unlimited emergency on-site repair services', parts and software updates that affect original functional design specifications, their
associated labor and travel expenses.

» unlimited access to Caliper’s Technical Support Center, which provides troubleshooting, repair instruction, service dispatching (other than
for LabChip XT and Twister |), replacement part information and shipment.

* A completed Caliper Field Service Report provides thorough documentation of all maintenance and service work performed by the Caliper
Field Service Engineer during an on-site visit. Documentation is not provided when Caliper provides service via telephone, fax or email.

Any failure of a product to conform to this Warranty shall be corrected by replacing or repairing the affected product or refunding the purchase
price (as described below), in each case at Caliper’s option. Parts replaced during the Warranty Period will be covered for the remaining term
of the original Warranty Period, or for thirty (30) days from time of replacement, whichever is longer. Such replacement parts may, at Caliper’s
option, be new or remanufactured. All parts removed from warranted equipment become the property of Caliper. Caliper reserves the right to
satisfy its warranty obligations in full by refunding the purchase price of any non-conforming product, minus any service, validation, or travel
charges.

B. Customer Responsibilities

In order for a product to be covered under this Warranty, Customer must comply with the following terms:

* The equipment must be used under normal installation and application conditions as described in the product’s User Manual.

* The equipment must be maintained as described in the User Manual.

* Only water or DMSO at a maximum concentration of 65% may be used as a system fluid in the Sciclone inL10. Any other system fluid must
be approved by Caliper before use in the inL10.

» When Caliper provides telephone, fax, or email support, Customer is responsible for completing any necessary documentation of the
service.

+ If Customer maintains a change control/validation logbook as a permanent record, then Customer is responsible for entering all service
documentation into such logbook.

» Customer must perform the appropriate level of revalidation required as a result of the maintenance or service provided.

C. Exclusions

» Failure to comply with any of the Customer Responsibilities listed above will void this Warranty.

* Any alteration of hardware or software on products covered under this Warranty that are not performed by Caliper or an approved Caliper
vendor will void this Warranty.

+ A product that has been subject to misuse, accident, negligence or improper transportation, handling, installation, storage, use, or
maintenance is not covered under this Warranty.

» Many Caliper products require the use of Caliper Automation Certified Disposables for proper operation. These may include, but are not
limited to: pipet tips, seals, labels and filters. Use of a Caliper product with any disposables other than the specified Caliper Automation
Certified Disposables will void this Warranty.

» This Warranty covers equipment manufactured by Caliper. Equipment purchased from other vendors is not covered by this Warranty.

+ Damage to Limited-Life Parts caused by insufficient maintenance or cleaning practices or unauthorized applications are not covered under
this Warranty.

» This Warranty applies only to the original buyer and delivery location. It is not transferable to other buyers or locations without Caliper’s prior
written approval.

» The Sciclone 384-channel low-volume head is warranted for one (1) year or 750,000 aspirate or dispense movements, whichever comes
first.

» The Sciclone 100nL head is warranted for one (1) year or 600,000 aspirate or dispense movements, whichever comes first.

» The laser component of the LabChip 3000 is warranted for the earlier of one (1) year from the date of installation or 8,000 hours of use.

* The use in a Sciclone inL10 of DMSO above 65% concentration, or any other system fluid not sanctioned for use by Caliper, will invalidate
this warranty as it relates to the pipetting head assembly.

1. LabChip XT and Twister | are not eligible for on-site service, and must be returned to Caliper’s Repair Depot for warranty service
pursuant to the process set forth in Section E below.
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If Caliper performs service on equipment and determines that any of the exclusions set forth in this Warranty apply, then Caliper shall charge
Customer its then-current current list prices for parts, labor and travel.

D. Limited-Life Parts

Limited-Life Parts are any parts that are exposed to solvents, reagents, or samples. Such parts include, but are not limited to syringes, valves,
seals and fittings. A pre-defined list of Limited-Life Parts are routinely replaced by Caliper Field Service Engineers during an Extended
Warranty or Service Contract Preventative Maintenance visit or during Caliper Repair Depot servicing. Otherwise, these parts are available
from Caliper at current list prices and are designed for replacement by Customer.

E. Equipment Return Policy

In servicing situations requiring the return of equipment to Caliper, equipment must be returned to Hopkinton, MA, USA, or another facility
designated by Caliper. Customer shall prepay shipping charges for equipment returned to Caliper, and Caliper will pay for return shipment to
Customer.

A Returned Material Authorization (RMA) must be obtained for any equipment being returned to Caliper. Contact the Caliper Technical Support
Center by telephone at (508)-435-9761, or via the Internet at techsupport@caliperls.com or by fax at (508)-435-0950 before returning any
equipment to Caliper. Customer must complete a Caliper Chemical Questionnaire prior to the issuance of an RMA. All equipment returned to
Caliper must first be decontaminated to meet Caliper and United States Department of Transportation procedures and standards for the safety
of Caliper personnel.

F. Hazardous Limitation Statement

At no time will Caliper personnel perform service on unsafe equipment, perform service in unsafe environments or decontaminate
equipment to make it safe.

Prior to performing any service work, Caliper personnel will evaluate the condition of the equipment and the environment in which the
equipment is located. If Caliper determines that the equipment and/or the environment could be hazardous to Caliper personnel, Caliper
reserves the right to refuse to service the equipment.

Il. MICROFLUIDIC CHIPS

Caliper warrants that microfluidic chips (each, a “Chip”) purchased from Caliper by Customer will be free from defects in material and
workmanship for a period of sixty (60) days from the date of shipment (the “Warranty Period”). A “defect” for purposes of this Warranty is
defined as any failure that occurs during analysis of the first one hundred (100) samples being run on a Chip. During the Warranty Period, if
the Chip fails to comply with this Warranty, Caliper will repair or replace the Chip at its option and expense. If a Chip becomes damaged or its
performance otherwise deteriorates due to solvents and or reagents other than those supplied or expressly recommended by Caliper, Caliper
will replace the Chip at Customer’s request and expense. No such replacement will extend the original Warranty Period. This Warranty does
not extend to any Chip which has been (a) the subject of an accident, misuse, or neglect, (b) modified by a party other than Caliper, (c) used in
a manner not in accordance with the instructions contained in the product User’s Manual, or (d) used for an assay or application which has not
been approved by Caliper. All claims under this Warranty must be made within thirty (30) days of the discovery of the defect. Caliper’s
obligations under this Warranty are limited to replacement as Caliper deems necessary to correct those failures of the Chip to comply with this
Warranty of which Caliper is notified prior to expiration of the Warranty Period.

1l. GENERAL

CALIPER SPECIFICALLY DISCLAIMS ANY AND ALL OTHER PROMISES, REPRESENTATIONS, AND WARRANTIES, EXPRESSED OR
IMPLIED. THIS INCLUDES, BUT IS NOT LIMITED TO, THE PRODUCT’'S CONDITION, ITS CONFORMITY TO ANY DESCRIPTION OR
REPRESENTATION, THE EXISTENCE OF ANY LATENT OR PATENT DEFECTS, AND IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL CALIPER BE LIABLE, WHETHER ARISING IN CONTRACT, TORT
(INCLUDING NEGLIGENCE), STRICT LIABILITY OR OTHERWISE, FOR ANY LOSS OF PROFIT OR ANY OTHER COMMERCIAL
DAMAGES, INCLUDING, BUT NOT LIMITED TO, SPECIAL, INCIDENTAL, CONSEQUENTIAL, OR OTHER AND IN NO EVENT SHALL
CALIPER’S LIABILITY EXCEED THE PURCHASE PRICE OF THE PRODUCT. THERE ARE NO ORAL STATEMENTS, PROMISES,
REPRESENTATIONS OR OTHER WARRANTIES COLLATERAL TO OR AFFECTING THIS WARRANTY. THIS WARRANTY EXTENDS TO
BUYER ONLY AND NOT TO PURCHASERS OR USERS OF BUYER’S PRODUCTS.

No agent, employee, or representative of Caliper has any authority to bind Caliper to any affirmation, representation, or warranty concerning a
Caliper product that is not contained in Caliper’s printed product literature or this Warranty. Any such affirmation, representation, or warranty
made by any agent, employee, or representative of Caliper will not be binding on Caliper.
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Caliper Life Sciences, Inc. Software License Agreement

Thank you for purchasing our products. PLEASE READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT CAREFULLY
BEFORE OPENING THE PACKAGE CONTAINING THE SOFTWARE MEDIA, THE COMPUTER SOFTWARE CONTAINED THEREIN, AND
THE ACCOMPANYING USER DOCUMENTATION (COLLECTIVELY REFERRED TO HEREIN AS THE “PROGRAM”). THE PROGRAM IS
COPYRIGHTED AND LICENSED, NOT SOLD. BY OPENING THE PACKAGE CONTAINING THE PROGRAM, YOU ARE ACCEPTING AND
AGREEING TO THE TERMS OF THIS LICENSE AGREEMENT. IF YOU ARE NOT WILLING TO BE BOUND BY THE TERMS OF THIS
LICENSE AGREEMENT, YOU SHOULD PROMPTLY RETURN THE PROGRAM IN UNOPENED FORM, AND YOU WILL RECEIVE A
REFUND. THIS LICENSE AGREEMENT REPRESENTS THE ENTIRE AGREEMENT CONCERNING THE PROGRAM BETWEEN YOU AND
CALIPER® LIFE SCIENCES, INC. (REFERRED TO AS “LICENSOR”), AND IT SUPERSEDES ANY PRIOR PROPOSAL,
REPRESENTATION, OR UNDERSTANDING BETWEEN YOU AND LICENSOR.

1

License Grant.

Licensor hereby grants to you, and you accept, a nonexclusive license to use the Program only as authorized in this License Agreement.
The software included in the Program (the “Software”) may be used only on a single computer owned, leased, or otherwise controlled by
you; or, in the event of the inoperability of that computer, on a backup computer selected by you. If the Software is an applications
package, you may use it on a single, local system controller. Neither concurrent use on two or more computers nor use in a local area
network or other network is permitted without written authorization from licensor and the payment of additional license fees. You agree
that you will not assign, sublicense, transfer, pledge, lease, rent, or share your rights under this License Agreement, except that you may
permanently transfer all of your rights under this License Agreement, provided that you retain no copies, you transfer all of the Program,
and the transferee agrees to the terms of this License Agreement. You agree that you may not reverse assemble, reverse compile, or
otherwise translate the Software.

Upon loading the Software into your computer, you may retain the Software media for backup purposes. In addition, you may make one
copy of the Software on a second medium for the purpose of backup in the event the Software media is damaged or destroyed. Any such
copies of the Software shall include Licensor's copyright and other proprietary notices. Except as authorized under this paragraph, no
copies of the Program or any portions thereof may be made by you or any person under your authority or control.

Licensor’s Rights.

Licensor has invested significant time and money in developing the products purchased with the Program. The Program contains
Licensor's trade secrets, which must be used in confidence. You acknowledge and agree that the program is proprietary to Licensor and
protected under U.S. copyright law. You further acknowledge and agree that all right, title, and interest in and to the Program, including
associated intellectual property rights, are and shall remain with Licensor. This License Agreement does not convey to you an interest in
or to the Program, but only a limited right to use it, revocable in accordance with the terms of this License Agreement. In the event of a
breach, the Licensor reserves the right to seek equitable relief.

License Fees.
The license fees paid by you in connection with the purchase of the associated product(s) are paid in consideration of the licenses
granted under this License Agreement.

Term.

This License Agreement is effective upon your opening of this package and shall continue until terminated. You may terminate this
License Agreement at any time by returning the Program, and all copies thereof and extracts therefrom to Licensor. Licensor may
terminate this License Agreement upon the breach by you of any term hereof. Upon such termination by Licensor, you agree to return to
Licensor the Program and all copies and portions thereof.

Limited Warranty.

Licensor warrants, for your benefit alone, for a period of 90 days from the date of the commencement of this License Agreement (referred
to as the “Warranty Period”) that the Software Media in which the Software is contained are free from defects in material and
workmanship. If, during the Warranty Period, a defect in the Software Media arises, you may return the Program to Licensor for either
replacement or, if so elected by Licensor, refund of amounts paid by you under this License Agreement. You agree that the foregoing
constitutes your sole and exclusive remedy for breach by Licensor of any warranties made under this License Agreement. EXCEPT FOR
THE WARRANTIES SET FORTH ABOVE, THE PROGRAM IS LICENSED “AS IS,” AND THE LICENSOR DISCLAIMS ANY AND ALL
OTHER WARRANTIES, WHETHER EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

Limitation of Liability.

Licensor's cumulative liability to you or any other party for any loss or damages resulting from any claims, demands, or actions arising out
of or relating to this License Agreement shall not exceed the license fee paid to Licensor for the use of the Program. In no event shall
Licensor be liable for any indirect, incidental, consequential, special, or exemplary damages or lost profits, even if Licensor has been
advised of the possibility of such damages. SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.
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7 Software Updates.
Licensor periodically creates Software updates which will be made available to you at no charge. Thereafter, Licensor shall not be
responsible for your use of, and shall not warrant or repair, superseded or outdated versions of Software.

8 Governing Law.
This License Agreement shall be construed and governed in accordance with the laws of the Commonwealth of Massachusetts. Any
dispute will be resolved in the state and federal courts of the Commonwealth of Massachusetts.

9 Severability.
Should any term of this License Agreement be declared void or unenforceable by any court of competent jurisdiction, such declaration
shall have no effect on the remaining terms hereof.

10 No Waiver.
The failure of either party to enforce any rights granted hereunder or to take action against the other party in the event of any breach
hereunder shall not be deemed a waiver by that party as to subsequent enforcement of rights or subsequent actions in the event of future
breaches.
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Index
A
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Auto Export
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Algorithm .. ................ 161
AnalysisTab................ 160
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Baseline Plateau, changing . ....... 54
Bubble....................... 240
C
Cable connectors. . ............. 213
Calibration
optics .. ........ ... .. .. ... 215
Caliper Center for Training and
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Cannotsave afile .............. 233
CDRFolder . .................. 146
CDR Manager Window. . ......... 143
CDR Server Utility Window. . .. .. .. 145
CDR Utility Window ... .......... 146
Centerpoint. . ................. 238
Change Password Window. . . ... .. 148
Changing samplename . ... ....... 33
Changing the View of the Results. . . .60
Channel End Time . ............. 160
Channel Peak Find Settings. . ... .. 161
Channel Table View . . . . ...... ... 133
addingcolumns .............. 65
printing. . ...... .. .. ... ... 71
Chemical Safety. . ................ 8
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Chip View or Chip List. . . .. ....... 113
Chromatography Data Interchange
Format ..................... 75,77
Cleaning the electrodes .. ....... 221
CLICK. . ... 112
Clipboard .. .................. 240
COLLECT..................... 112
Collection . .. ........ 47,105,116, 240
adding to workspace . .. ....... 47
CollectionMenu ............ 105
Collectionpane .. ............ 116
template . ............ .. ... 240
Collectionwell. ... .......... 216, 241
Color,gel ...... ... .. ... ..... 128
Compareresults . . .............. 60
Computer Resources Test. . ... ... 230
Computer Software Lock-Ups . . . .. 233
Concentration. . ............. 20,160
Contrast . .................... 128
Copy. .o 66
CopyGel................... 66
Copy Graph. . ............... 66
CopylLane.................. 66
datafile.................... 30
Create daily subdirectories . . ... ... 45
Create NewUserTab . .......... 204

Current Leakage Check Failed Warning
227

Curvefit ....... ... ... ... ...... 250
Customer Supportplans. .. ........ 3
D
Data Analysis .. .............. 43,44
How the Software Analyzes DNA

Data ...................... 44
DataFile......... 46,60, 241, 257,258
evaluation.................. 60
opening. . .................. 46
reanalyzing . ................ 67
reverting to revision. . . .. ... ... 59
Data Flle Version Window. . ... ... 149
Data file, copying .. ............. 30
Datafiltering. . . . ............ 44,242
Datapoints................... 241
DataRange .................. 160
De/Activate UserTab . .......... 207
Define AccessTab .. ........... 208

Detection Wavelength .. ......... 219
Detector. ... .................. 215
Device Disconnected Error. . . .. ... 226
Diagnostics . .................. 229
runningtests. . .............. 229
Disconnected Device Error. . ... ... 226
Display problems . . .. ........... 234
DNA Assay Analysis. . ........... 242
DONE ...... ... ... ... ... ..... 112
Door....... ... . 212
E
EditUsersTab . ................ 205
Electrical safety . .. .............. 10
Electrode Cleaner . ............. 242
Electrodes ... ................. 214
cleaning . .................. 221
Electrokinetic Forces . ... ........ 243
Electroosmotic Flow. .. .......... 243
Electropherogram
Graph View Properties . . . ... .. 122
printing. .................... 69
Electropherogramstab........ 64,121
Electrophoresis . ............ 20,243
Enable Remote CDR Backup . .. ... 146
EndPoint..................... 243
EndTime.............. 44,161,243
changing................. 54,56
Entire collection . . . ............. 137
Error Messages . . .......... 226,227
Current Leakage Check Failed
Warning . ....... ... ... ... 227
Device Disconnected Error. . . .. 226
Error Message Area . ......... 110
IV Check Failed Warning .. .. .. 227
Event Viewer Window . .......... 150
Searching for Events in the Events
Tab......... ... ... ... 224
Viewing Current Events in the Events
Tab. . ... .. 225
Viewing Past Events in the Events
Tab. . ... ... 225
Excluded fragments . .. .......... 167
Excluded Fragments Tab . . ... .. .. 167
Excludedpeaks ................ 167
Excludingapeak ............. 44,55
Expected fragments . . .. .......... 48
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Expected Fragments Tab . ....... 165 GelColor..................... 131
Expected Peaks Gel ContrastRange . . . .......... 131
creating.................... 48 Gel View Properties . . ........... 131
exporting. . ................. 49  Global Analysis settings. .. ....... 157
forcing. . ...... ... ... .. ... 50 GlobalPeak Find................ 44
importing. . ................. 49 Graph................ 44,60, 66, 256
viewing in Channel Table View .. 51 COPYING. . . oo 66
viewing in Gel View. . ... ...... 51 Electropherogramstab . ... .. .. 121
viewing in Peak Table View . . . .. 52 Graph View Properties . . ... ... 122
Expected Peaksonly ........... 137 maxperpage . .............. 122
Export.......... 74,141,151,165, 169 overlay . ........ .. .. ... ... 63
Audit Trail Export Window . . . . . 141 Overlay Electropherograms Tab . 120
Auto Export window. . .. ... ... 151 printing. .. ....... .. .. .. ... .. 69
Automatically. .. ............. 31 selected gelsonly. . .......... 122
Excluded Fragments button. ... 167 Standard curve . .. ........ 44,256
Expected fragments. . . .. ... .. 165  Graph selected gelsonly . ... ... .. 122
Expected peaks. . ........... 165 GraphView ................... 117
Export window. ............. 151 Greenlaser ................... 215
Manually . . ............... 74,77 Grounding .................... 218
Select the Auto Export Settings. . 31 H
Smearbutton. . . ... .. ... 169
Export As Assay button. . .. ...... 157 Hardware Diagnostics ........... 244
F Heat Emission ... .............. 218
Helpmenu.................... 108
Filemenu.................... 104 Hide excluded peaks ............ 137
Filter View. . .. ............. ... 124  Hidingviews. . .................. 62
Filter Width . . . . ......... 44,161,243 High Concentration Size Correction . 171
Filter Width, changing............ 54  High Size Filtering . .. ........... 161
Filtered Peaksonly............. 137  High Voltage safety . ............. 10
Filtering parameters .. ... ... .. ... 53 How the Software Analyzes DNA Data44
Findingpeaks................. 250  HV Current Calibration Test . . .. . .. 231
First Peak Time. . ... ........... 256 HV lIsolation Relay Test . ......... 231
Flashing software .. ............ 234 HV KelvinMode Test . ........... 231
Focusing..................... 215 HV Voltage Calibration Test . . . . . .. 231
Font . ... ... .. .. .. .. ... ... 122 I
Forcing expected peaks . ......... 50
Frontview.................... 212  ldentifying peaks ............... 250
FUSES . ..o 11,218 Import ............. 46,165,167, 169
G datafile .................... 46
Excluded Fragments button .. .. 167
Gel...... ... ... 66,128 Expected Peaks button. . . ... .. 165
Copying .. ... 66 Smearbutton . ........... ... 169
exporting. . ................. 76  Inflection Threshold . ... ... .. 161,244
Gelcolor................... 60 Inflection Threshold, changing . .. ... 54
GelView . ................. 128 Installation Qualification Window . . . 185
Gel View Properties. . ... ... .. 131 Instrument description . .. ... ..... 211
printing . . ....... ... .. .. ... 69 Instrumentmenu ............... 106
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Instrumentsafety ................ 7 Helpmenu ................. 108
IQ,running . .................. 228 Instrumentmenu. ............ 106
IV Check Failed Warning ........ 227 MenuBar.................. 103
L Securitymenu .............. 107
Toolsmenu................. 106
LabChip Kit assay description. . . . .. 20 Validation menu . ............ 107
LabChip XT main window . . ... ... 102 Viewmenu ................. 107
Lab-on-a-Chip................. 246 Window menu. . ............. 108
Ladder ................ 44,246, 247 Workspace Menu ............ 104
concentration .............. 160  Mergingtwopeaks............... 56
Ladder Analysis. . ........... 247  Method
Lane Width . . ................. 131 Method file . . .. .. .. ... .. ... . 247
Laser ............ ..o 215 Method Window . . .. ............ 157
Laser Safety ................. 9  Microfluidics. . . ................ 247
LaserTest.................... 231  MigrationTime ... ............... 44
LastPeak Time................ 243 Min Peak Height, changing. .. ... ... 54
Layout Options Window . ........ 155 Min Peak Width ... .......... 44,248
Lid ... 214 Min Peak Width, changing . ........ 54
LineVoltage .. ................ 218  Minimum peak height.. ... ... 161,248
Loadingachip ................. 33 Minimum Peak Width . .. ......... 161
Logfile ............... ... ..., 247 Modifying Analysis Parameters . . . . . 53
Log files Molarity .. ................. 44,248
Zipping . ... 235  Molecular Separation Techniques. . . 248
Login Window. . ............... 156 Monitoringthe Run. ... ........... 35
Lower Marker ................. 247 Mouse shortcuts. . .. ............ 236
Quantification .. ............ 171 MSDS .. . ... 8
M N
Main window. . ................ 102 New Collection Window .. ........ 174
Maintenance and Service . . ... ... 220 Newworkspace .. ............... 45
Cleaning the electrodes. . . .. .. 221 0
Manual export. . .. .............. 77
Manualpeak................... 55  Only Annotate Expected Peaks .. ..122
Manually exportingdata . ......... 77 OpeningaDataFile.............. 46
Marker .. .................. 44,160 Opening a New Workspace . ....... 45
aligning . ................... 57  Operating Humidity ............. 218
Assigning . .......... .. .. ... 44  Operating Temperature . ......... 218
concentration .............. 160  Optical window. .. .............. 214
LMforDNA................. 57 Optics ......... ... .. ... ... 215
Not detected . ... ......... ... 44 OpticsTest. . .................. 231
Size..... ... ... 160 OQ,running................... 228
Marker Drift Tolerance. . ... ...... 171 Orientation. .. ................. 122
Maximum Graphs per Page ... ... 122 Output Tab, Start Fractionation Window.
Menu .. ... 103,104,105,106,107,108 197
Analysismenu. ............. 105  Overlay Electropherogram, printing . .70
CollectionMenu . ........... 105  Overlay Electropherograms Tab. ... 120
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